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related documentation and for application of such results.

Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries. IBM is a trademark of International Business
Machines Corporation in the United States, other countries, or both. Pentium is a registered trademark of
Intel Corporation. Adobe, Acrobat, and Postscript are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries. All other trademarks appearing
in this manual are owned by their respective companies.

Copyright © 2008. All rights reserved. No part of this publication may be reproduced, distributed, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
or stored in a database or retrieval system, without the prior written permission of Anthos.
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Warranty and Returned Goods Requirements

All standard Biochrom policies governing returned goods apply to this product. Subject to the exceptions
and upon the conditions stated below, the Company warrants that the products sold under this sales
agreement shall be free from defects in workmanship and materials for one year after delivery of the
products to the original Purchaser by the Company, and if any such product should prove to be defective
within such one year period, the Company agrees, at its option, either (1) to correct by repair or at the
Company’s election by replacement, any such defective product provided that investigation and factory
inspection discloses that such defect developed under normal and proper use, or (2) to refund the
purchase price. The exceptions and conditions mentioned above are as follows:

a. Components or accessories manufactured by the Company which by their nature are not
intended to and will not function for one year are warranted only to reasonable service for a
reasonable time. What constitutes a reasonable time and a reasonable service shall be
determined solely by the Company. A complete list of such components and accessories is
maintained at the factory.

b. The Company makes no warranty with respect to components or accessories not manufactured
by it. In the event of defect in any such component or accessory, the Company will give
reasonable assistance to Purchaser in obtaining from the manufacturer’s own warranty.

c. Any product claimed to be defective must, if required by the Company, be returned to the
factory, transportation charges prepaid, and will be returned to Purchaser with transportation
charges collect unless the product is found to be defective, in which case the product must be
properly decontaminated of any chemical, biological, or radioactive hazardous material.

d. The Company shall be released from all obligations under all warranties, either expressed or
implied, if any product covered hereby is repaired or modified by persons other than its own
authorized service personnel, unless such repair by others is made with the written consent of
the Company.

e. If the product is a reagent or the like, it is warranted only to conform to the quantity and
content and for the period (but not in excess of one year) stated on the label at the time of
delivery.

It is expressly agreed that the above warranty shall be in lieu of all warranties of fitness and of the
warranty of merchantability, and that the company shall have no liability for special or consequential
damages of any kind or from any cause whatsoever arising out of the manufacture, use, sale, handling,
repair, maintenance, or replacement of any of the products sold under the sales agreement.

Representatives and warranties made by any person, including dealers and representatives of the
Company, which are consistent or in conflict with the terms of this warranty, shall not be binding upon
the Company unless reduced in writing and approved by an expressly authorized officer of the Company.

Parts replaced during the warranty period are warranted to the end of the instrument warranty.

= Performance characteristics and specifications are only warranted when Biochrom Instruments
replacement parts are used.
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1. Installing the ADAP Software

1.1. Overview

The ADAP software is a Windows®-based control and analysis program
for Anthos and Biochrom microplate readers. The ADAP software is
capable of performing single or dual wavelength endpoint, kinetic, well
scan and wavescan photometric measurements. It automatically
recognizes whether the connected instrument is a standalone model
(Anthos 2020) or controlled by the computer (for example, the Zenyth
340rt) and enables the appropriate device control and data transfer
functionality.

The ADAP Plus software contains the same functionality as the ADAP
Basic software, as well as these programming and evaluation
capabilities:

¢ Quantitative evaluation, including quantitation, curve fitting, and
standard curves.

¢ Qualitative evaluation, including cutoff formulas and groups.

e Plate layout, including programming of blanks, standards, and
controls.

e Replicate elimination and test validation formulas.

e Detailed graph view of multiwavelength and linear scan
measurement results.

e Detailed curve information for multiwavelength and linear scan
measurement results.

= Refer to Chapter 8, Defining and Running Tests, for more information
about the programming and evaluation capabilities of the ADAP Plus and
ADAP Expert software.
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The ADAP Expert software comprises the ADAP Plus software and adds
the following features:

Reduced data from kinetic assays may be recalculated.

Sample IDs (refer to Chapter 9, Defining and Running Multitest
Assays).

Multitest functions (refer to Chapter 9, Defining and Running
Multitest Assays).

3-D scanning graphs (refer to Section 7.3.6.4, Viewing the
Transmission Profile of a Single Well).

= An instrument-dependent license code is required to access the ADAP
Plus or ADAP Expert software functions. The code is provided when
purchasing an ADAP Plus or ADAP Expert software license. Refer to
Section 1.3, Launching the ADAP Software for more information.

This chapter covers:

Installing the ADAP software (refer to Section 1.2, Installing the
ADAP Software).

Launching the ADAP software (refer to Section 1.3, Launching the
ADAP Software).

ADAP
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1.2. Installing the ADAP Software

Installing the ADAP software requires:

1.2.1.

Meeting the minimum computer system requirements for the ADAP
software (refer to Section 1.2.1, System Requirements).

Installing the ADAP software (refer to Section 1.2.2, Running the Setup
Program).

System Requirements

Before installing the ADAP software, refer to Table 1-1 to ensure the
target computer system meets the minimum requirements. Where
relevant, Table 1-1 also lists recommended requirements.

Component Minimum Requirements

CPU Pentium® 133 Mhz minimum
Pentium® II 500 Mhz recommended
16 MB minimum

RAM 64 MB recommended

Hard Drive 50 MB free space

CD-ROM Drive 4X

Monitor 640x480 resolution

Keyboard 101 key

Mouse IBM® compatible

Serial Port 1 free serial port per instrument connected

Operating Systems

Windows® 95 (Y2K update required)
Windows® 98 (Y2K update 2 required)
Windows® 98 Second Edition

Windows® Millennium Edition

Windows NT® 4 (Service Pack 5 or higher)
Windows® 2000

Windows® XP

Web Browser

Internet Explorer 4.01 (Service Pack 2 or later)

Database

Microsoft Data Access Components (MDAC) 2.6

Table 1-1: ADAP Software System Requirements

ADAP
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1.2.2.

Running the Setup Program

The ADAP software setup program installs all of the components
required for the ADAP software to run.

To install the ADAP software:

= Before installing the ADAP software on a computer equipped with
Windows® NT 4, 2000, or XP set up with multiple user accounts, the
user must log into an account with Administrator access. Users logged
into an account with Limited access are not permitted to install the
software.

1. Exit all open Windows programs before running the ADAP software
setup program.

2. Insert the ADAP software installation CD into the CD-ROM drive.
After a few seconds, the ADAP set up page will open automatically
in your default internet browser (Figure 1-2 ADAP 2.0 Automatic
Start Up Page

Welcome to ADAP 2.0

To install ADAP 2.0 Click here
To install EZ Read USB driver Click here
To check your COM port Click here

To download ADAP User’s Manual Click here

VVvVvVVvVv

To download instruction for COM Port Utility, Click here

Figure 1-2 ADAP 2.0 Automatic Start Up Page

= If the ADAP software setup program does not appear
automatically, use Windows Explorer to locate the CD-ROM drive
and open E:\ADAP_Software\ADAP Setup[V2.0.0].exe

3. Follow the instructions in the setup wizard to install the software.

ADAP
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1.2.3.

When the software installation is complete, choose Finish to exit
the setup program. The ADAP software is ready to use.

OR

If prompted, choose Restart. After the computer restarts, the
ADAP software will be ready to use.

= All existing files created by the ADAP Basic software and the database
that stores measurement results are accessible to the upgraded
software.

Installing USB drivers

The EZ Read 400 uses a USB A to B connector to communicate with the

PC.

To install the USB drivers:

VVVVVVVVYVY

Welcome to ADAP 2.0

To install ADAP 2.0, Click here

To install EZ Read 400 USB driver, Click here

To check your COM port, Click here

To download instruction for COM Port Utility, Click here
To download ADAP User’s Manual, Clicl_g!here

To download EZ Read 400 User’s Manual, Click here

To download Anthos 2010 User’s Manual, Click here

To download Anthos 2020 User’s Manual, Click here

To download Zenyth 200 User’s Manual, Click here

To download Zenyth 340 User’s Manual, Click here

Figure 1-3 Welcome to ADAP 2.0 Start Up Page

ADAP
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1. Click on To install ADAP 2.0 Click here.

2. Either open or save the file: CDM20814_Setup(1).exe and then
select OK to install.

3. Program will close when installation is completed.
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1.3. Launching the ADAP Software

To launch the ADAP software:

1. From the Windows® Start menu, choose
Programs >ADAP>ADAP.

2. The first time the ADAP software is launched; License Code appears
(Figure 1-4). If necessary, enter the 25-digit license code printed
on the cover of the software CD.

= A license code is required only for upgraded versions of the
ADAP software such as ADAP Plus or ADAP Expert.

=>» To access License Code after running the ADAP software for the
first time, from the Windows menu, choose About, and then
choose License Code.

B License Code Ed

Pleaze input Licensze Code

) Lo ol | 0K |

Mo Licenze Code found!

Delete Code

Figure 1-4: License Code

3. Choose Add License Code to verify the License Code entered.

= If the license code cannot be verified, re-enter it and choose Add
License Code again.

OR

Choose OK to close License Code if no License Code was entered.
Login appears (Figure 1-).
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=>» Delete Code is used to delete time-limited promotional License Codes

used to demonstrate advanced software features. Service codes used by
Biochrom service engineers to test instrument functionality may also be
deleted.

4,

Login appears (Figure 1-).

Login
IJzer

Pazzword

|sau:|mir‘|

After the license code is verified, choose OK to close License Code.

X

OF.

Cancel

Figure 1-5: Login

Enter the User Name and Password. Refer to Chapter 2, User Login
and System Administration, for more information on logging into

the ADAP software.

= If a password is forgotten, contact the system administrator or

Biochrom service.

=>The first user who logs into the ADAP software should accept the
role of system administrator. Log in using the generic system
administrator user name and password in Table 1-1. After logging
in the first time, the password must be changed (refer to Section
2.2, Accepting the Role of System Administrator ).

User Name Password User Level
sadmin sadmin System administrator (user level 3)
admin admin Local administrator (user level 2)
user user User level 1

Table 1-2: Generic User Names and Passwords

ADAP

ADAP Software Operating Manual

1-8



1.3.1.

6. Choose OK. The ADAP software main window appears
(Figure 1-).

B ADAP Software

Database Reading Setup Help - | &%

Ly E; t'LE; —| % B s
Al=|rd Instrument @
b =| V| |[EZRead400 - SNi03040 |

nllo]eflale]olel-

Figure 1-6: ADAP software main window
Using the Help Menu

Use the Help menu to access this user’s manual, as well as the user’s
manual for the instrument currently being controlled by the ADAP
software. To view the user’'s manuals, Acrobat® Viewer must be
installed on the computer.

=>The Acrobat® Viewer installer is included on the ADAP software
installation CD, but is not automatically installed with the ADAP
software.

To install the Acrobat® Viewer from the ADAP software installation disc,
open Readme.html, choose the link to Acrobat® Viewer, and follow the
onscreen instructions.

The Help menu also provides a link to the Biochrom website. To use this
link, a default web browser must be installed and configured on the
computer.

ADAP
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2. User Login and System
Administration

2.1. Overview

The ADAP software has the ability to manage up to 50 different users.
Only authorized users are able to operate the system, and are identified
in the user log table and on printed reports generated by the software. A
hierarchy with three different user levels is implemented:

e Level 1 — Users can perform Quick, Test, and Multitest
measurements. However, they cannot create, edit, or delete test
definitions or configure system and instrument parameters.

e Level 2 (local administrator) — Along with performing Quick, Test,
and Multitest measurements, Level 2 users are allowed to create,
edit, and delete test definitions and configure system and instrument
parameters.

e Level 3 (system administrator) — These users have the same
privileges as Level 1 and Level 2 users, and may also add and delete
Level 1 and Level 2 users, edit existing user information for Level 1
and Level 2 users, and provide user passwords. They may add
additional Level 3 users, but may not edit or delete Level 3 accounts
after they are created.

= Test measurements are available in the ADAP Plus and ADAP Expert
software; Multitest measurements in the ADAP Expert software only.

User administration includes:

e Accepting the role of system administrator the first time the software
is run (refer to Section 2.2, Accepting the Role of System
Administrator in ADAP).

e Logging into the ADAP software (refer to Section 2.3, Logging Into
the ADAP Software).

e Changing a password (refer to Section 2.4, Changing a Password).

e Adding and deleting users, as well as editing user information (refer
to Section 2.5, Adding, Deleting, and Editing Users).

e Viewing the user log (refer to Section 2.6, Viewing the User Log
Table).
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2.2. Accepting the Role of System Administrator in
ADAP

The first time the software is run, the person logging in must accept the
role of system administrator (Level 3) and immediately change the
default provided password. Refer to Section 2.4, Changing a Password,
for information on changing a password.

= More than one person may assume the role of a system administrator
since a system administrator may add other system administrators.

A system administrator (Level 3) can:

Add Level 1, Level 2, and Level 3 users.

Delete Level 1 and Level 2 users.

Edit existing user information of Level 1 and Level 2 users.
e Provide user passwords for Level 1, Level 2, and new Level 3 users.

A system administrator (Level 3) cannot:

e Delete other Level 3 users.

o Edit existing user information of other Level 3 users.
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2.3. Logging Into the ADAP Software

Authorized users must log in with their individual user name and
password each time the ADAP software is started.

= After seven minutes of inactivity, users are automatically logged out
and must log in again to continue using the software.

The first time a user logs in, the default user name and password in
Table 2-1 must be used according to the user level. After logging in with
a default user name and password, the password should be changed
(refer to Section 2.4, Changing a Password).

User Name Password User Level
sadmin sadmin System administrator (user level 3)
admin admin Local administrator (user level 2)
user user User level 1

Table 2-1: Default User Names and Passwords
To log in to the ADAP software:

From the Start menu, choose Programs>ADAP>ADAP. The ADAP software
starts up and Login appears (

IJzer |$al:|mir'| oK

Login §|
|
|

Figure Cancel

Passward ||

2-1).

Figure 2-1: Login

7. Enter the User and Password.
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=> If a user forgets their password, contact the system
administrator or Biochrom service.

8. Choose OK.

=> If a Level 1 or Level 2 user attempts to access a software function they
do not have permission to perform, Login appears. To access the
software function, a User and Password for a user with permission to
perform the function must be entered.
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ing a Passwor

The user should change the password after logging in the first time with
a default user name and password (Table 2-1). However, users may
change their password at any time.

To change a password:

1. Start the ADAP software.

2. From the Setup menu, choose Change User.

Or select

Or choose User from the toolbar. Login appears (

Figure 2-1).

Enter a valid User Name and Password. Change Password appears

(
Login g|
Uzer |sa|:|min oK |
LCancel | Figure2-2).
Paszsword ||
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Figure2-2: Login

3. Choose Change Password. Login expands to display password
information.

Login f'5_<|

| oK. |

Uzer

Cancel |

Pazsward |

[Jzer Add Uszer |

Pazzwaord |user Delete zer |

Full Mame |User

Level | 1 ﬂ

D ate 1040542011

Figure 2-3: Login — Change Password options

4. In New Password, enter the new password.

= Passwords are case sensitive, may include spaces, and are
limited to 15 characters.

In Confirm, enter the new password a second time.

6. Choose OK. The user is logged in and the password is changed.
The next time the user logs in, the new password is required.
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2.5. Adding, Deleting, and Editing Users

Only system administrators (Level 3) can add, edit, and delete users. For
Level 1 and Level 2 users, a system administrator can add and delete
users, edit user information, and assign passwords. A system
administrator can create new system administrator (Level 3) accounts,
but cannot edit or delete information for system administrator accounts
after they have been created.

2.5.1. Adding New Users

The system administrator creates a user name and password for a new
user. To add a new user:

1. Start the ADAP software.

OR

From the Setup menu, select Change User.

OR ==&
Choose User from the toolbar. Login appears.

2. Enter a valid system administrator (Level 3) User Name and
Password. A Change Password button appears (Figure 2-4).

oK, |

Ilzer |sau:|min

Cancel |

Password ||

Figure 2-4: Login - system administrator login
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3. Choose Change Password. Login expands to display detailed user
information (Figure 2-5).

Login §|

User | Ll |
LCancel |

Pazsward |

Lszer Add User |

Pazzword |user Delate Uszer |

Full Name User

Level |‘| ﬂ

Date 10/05/2011

Figure 2-5: login - adding a new user
4. In User, enter a user name for the new user.

5. In Password, enter the password the new user will use to log in to
the ADAP software.

= User names and passwords are case sensitive, may include
spaces, and are limited to 15 characters.

6. In Full Name, enter the full name of the new user.

= A user’s Full Name appears in the user log table and on printed
reports generated by the software.

7. Select the desired Level for the new user (refer to Section 2.1,
Overview).

8. Choose OK to add the user and exit Login. The user may now log
on using the new user name and password.

OR —
Choose Add User to add another user.
OR

Choose Cancel to delete the new user from the list and exit Login.
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2.5.2.
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Deleting Users

The system administrator (Level 3) can delete Level 1 and Level 2 users.
To delete a user:

1. Start the ADAP software.

OR &=
From the Setup menu, select Change User.

OR
Choose User from the toolbar. Login appears.

2. Enter a valid system administrator (Level 3) User Name and
Password. Change Password appears (Figure 2-6).

Login b—(|

Izer |sau:|min

Paszword ||

Figure 2-6: Login — system administrator login

3. Choose Change Password. Login expands to display detailed user
information (Figure 2-7).

Login

E, | ak. |

Cancel |

Fazsword |

User AddUser |
Pazsword |user Delete User |
Full M arme |L|ser

Lewvel |‘| ﬂ

Cate 1040572011

Figure 2-7: Login - selecting a User to delete

4, In User, select the user to be deleted.
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5. Choose Delete User. The user is removed from the user list.

6. Choose OK to delete the selected user from the software and exit
Login.

OR

Choose Cancel to prevent deleting the selected user from the
software and exit Login.

= Only one user may be deleted each time Login is open. To delete
additional users, exit Login, then reopen it to delete the next user.

2.5.3. Editing Existing User Information

A system administrator (Level 3) can edit existing user information,
including user name, password, full name, and user level, for Level 1 and
Level 2 users.

To edit user information:
1. Start the ADAP software.

OR

From the Setup menu, select Change User.

OR ==&
Choose User from the toolbar. Login appears.

2. Enter a system administration (Level 3) User Name and Password.
Change Password appears (Figure 2-8).

Login g|

|zer |sadmin o |
LCancel |

Paszword | xxxxxx Change Passward |

Figure 2-8: Login — system administrator login
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3. Choose Change Password. Login expands to display detailed user
information (Figure 2-9).

Login
|lzer

Paszwiard

Uzer

Fazsword
Full M arme

Level

D ate

X

| oK. |
Cancel |

|

D | ddUser |

|zen_l,lth Delete Uszer |

|.J|:uhn Do

=]

1040542011

4. In User, select the desired user to edit.

5. Edit the user information as desired.

Figure 2-9: Login — editing Full Name

6. Choose OK to save changes made to the user information and exit

Login.

OR

Choose Cancel to discard changes made to the user information
and exit Login.
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2.6.

Viewing the User Log Table

The ADAP software maintains a log of many activities performed in
the software. The log may be saved in text format so that it can be
imported into other software applications.

An event is added to the log whenever:

e A user logs into the ADAP software.

only).

A database error is reported.

e The ADAP software is closed.

To view the log table:

A test definition is created or modified (ADAP Plus and Expert

Quick measurements are run and results saved.

Tests are run or reevaluated (ADAP Plus and Expert only).

From the Database menu, choose View Log Table. Log-Table
appears (Figure 2-10).

og-Table
File Edit
1D Date Event Uszer Level

1003 29,/09/2010 15: 241 DRRRTEER NS E bind 3
1004 29/09/201015:24:19 LogOn brnd 3
1005 29/09/2010 15:25:39 | Deleting TestSetupze  bmd 3
1006 29/09/2010 15:25:39 | Testzetup stored sero | bmd 3
1007 29/09/2010 15:25: 48 Deleting TestSetupze | brad 3
1008 29/09/2010 15:25:48 | Testzetup stored zero | brnd 3
1009 29/09/2010 15:26:03 | Measure 2010 SMr.: 31 bmd 3
1010 29/09/2010 15:26:45 Plate stored. 201003z brod 3
1011 29/09/2010 15:34:38 | Unload Program birnd 3
12 29/09/201015:34:53 LagOn brad 3
1013 29/09/201015:35:23 Measure 2010 SMr.: 31 brad 3
1014 29/09/2010 15:36:07 | Plate stored. 207003z bd 3
1015 23/09/201015:37:51  Deleting TestSetupse  brnd 3
1016 29/09/2010 15:37:51 | Testzetup stored sero | bmd 3
1017 29/09/2010 15:38:15 | Deleting TestSetupze  bmd 3
1018 29/09/2010 15%:38:15 | Testzetup stored zero | brad 3
1019 29/09/2010 15:38:31  Deleting TestSetupze | brad 3
1020 29/09/2010 15:38:31 | Testsetup stored zero | brnd 3
1021 29,/09/2010 15:38:36 Unload Program bimd 3
1022 29/09/201015:38:44 LogOn birnd 3
1023 29/09/2010 15:39:06 | Measure 2010 SMr.: 31 brd 3
1024 29/09/201015:39:48 ) Plate stared. 201009z brad 3
1025 29/09/2010 15:45:57  Deleting TestSetupze  bnd 3
1N2R 290952010 15-45-51 1 Testzetun stored zem | hmd A

Figure 2-10: Log-Table
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2.6.1. Saving the Log Table as a Text File
The log table can be saved as a tab-delimited text file which can be
imported into another software application such as a spreadsheet or
database.
To save the data in Log-Table as a text file:
1. From the File menu, choose Save. Save As appears.
2. Browse to the desired folder to save the history log file.
3. In File name, enter a file name for the history log.

4. Choose Save to save the history log to a text file.

2.6.2. Copying the Log Table to the Clipboard

The log table can be copied to the clipboard as tab-delimited text and
pasted into any application using the Paste command.

= The contents of the entire log table will be copied. Portions of the log
table cannot be copied separately.

To copy the data in Log-Table to the clipboard:

1. From the Edit menu, choose Copy. The contents of the Log-Table
are copied to the clipboard.

2. Open or switch to the application where the log contents will be
pasted.

3. Paste the history log into a new or existing file using the Paste
command for the application.

= Most applications have a standard shortcut of CTRL+V assigned
to the Paste command.
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3. Configuring the ADAP Software

3.1. Overview

To perform measurements, the ADAP software must be configured
to the specific microplate reader connected to the computer.

Configuring the ADAP software includes:

e Configuring the microplate reader in the ADAP software (refer to
Section 3.2, Configuring the Microplate Reader).

e Configuring system settings (refer to Section 3.3, Configuring
System Settings).
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3.2. Configuring the Microplate Reader

The ADAP software must be configured for the specific microplate
reader through the reader configuration screen. This configuration
must be done the first time the software is used and when an

additional or different instrument is used.

To access the reader configuration screen: From the Setup

menu, select Instrument. Instrument appears.

& Instrument =13

File
|nstrumenll Functions‘l] Functions 2] Downloada’UpIoad]
Filter Instrument

Pasition - Baudrate 9600

Wavelength |E2D

Send ta Instrument |
Instrument Type

-

COM Part COmM4 A

S

Installed Plates | EZRead4ll j
%6 8xl2 Fead Configuration |
Serial Mumber 3040
Type 42
r

Temperature Firmware Yersion

W20
Service Code

Figure 3-1: Instrument settings - EZ Read 400
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Instrument is divided into five configuration areas:

Instrument — Communication settings and instrument (refer to
Section 3.2.2, Configuring Instrument Settings).

Filter — Lists filters installed in the instrument. Allows users with
Level 3 (system administrator) access to configure filters installed in
the Zenyth 340. (Refer to Section 3.2.3, Viewing and Configuring
Filters).

Installed Plates — Plates that can be used by the instrument (refer to
Section 3.2.4, Viewing Installed Plates).

Temperature — Temperature settings for instruments that support
temperature control (refer to Section 3.2.5, Setting the
Temperature).

Service Code — For Biochrom Service Engineers only.

ADAP
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3.2.1.

3.2.1.1.
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Setting the COM port

The instrument connects to a PC using a COM port either using a RS232
connection (Anthos 2010, Anthos 2020, Zenyth 340 and Zenyth 200)
which can be used in conjunction with the supplied USB adaptor or via a
USB A to B connection (EZ Read 400).

To determine the COM port number for instruments that
use an RS232 or USB to RS2323 adaptor for PC connection
(Anthos 2010, Anthos 2020, Zenyth 340 and Zenyth 200):

1. Open Device Manager

a. In Windows 9x/2000/XP
Select Start > Run, enter the text: ‘devmgmt.msc’ into the
‘Open:’ text box, click OK button

b. In Windows Vista/7

Select Start, in the Search box, type ‘Device Manager’, it should
appear in the results above, click to open).

2. Expand the section marked ‘Ports (COM & LPT)’. This will show a list
of ports on your PC followed by the COM number in brackets. The
standard RS232 serial port (if you have one) on the back of your PC
is normally listed as ‘Communication Port (COM1)’. If you are using
a USB to serial converter, will usually be listed as a virtual com port.

The COM port number must be 1 - 9 in order to work correctly.

If the COM port numberis not1 - 9:
1. Follow steps 1 & 2 above.

2. Right click on the port which the instrument is connected to and
select ‘Properties’

3. Click on the ‘Port Settings’ tab.
4. Click on the ‘Advanced’ button.

5. Change the COM port number to anything between 1 and 9, do not
use number which say (in use).

6. Click OK to save and exit back to the Device Manager window. The
change to COM port number may not show until you close and re-
open Device Manager (step 1).

ADAP
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3.2.1.2. To determine the COM port for instruments that use USB
connections:

1. Insert the ADAP CD that was supplied with the instrument.

2. The page: Welcome to ADAP 2.0 should open automatically in your
default internet browser:

Welcome to ADAP 2.0

To install ADAP 2.0, Click here

To install EZ Read 400 USB driver, Click here

To check your COM port, Click here

To download instruction for COM Port Utility, Click here
To download ADAP User’s Manual, Clicl_g!here

To download EZ Read 400 User’s Manual, Click here

To download Anthos 2010 User’s Manual, Click here

To download Anthos 2020 User’s Manual, Click here

To download Zenyth 200 User’s Manual, Click here

VVVVVVVVYVY

To download Zenyth 340 User’s Manual, Click here

Figure 3-2: Welcome to ADAP 2.0 Page
3. Select To check your COM port Click here.

4. Save the resulting utility ReAssignCOMPortNumb.exe to your PC
and then open from the saved location.

5. The COM port utility will open:
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COMPort Assignment Utility [ ][ [X]

] Show Devices which are Mot Curently Connected

Select Portto Chiange: | USE Senal Fort (COME) v |

Select New COM No:  |COM2 v

Assign ComPort

Frezz F5 to Refresh

Figure 3-3: COMPort Assignment Utility

6. The utility will automatically detect the COM port used by the
instrument.

If the COM port is not 1-9 it must be changed:

1. In the the COMPort Reassignment utility set the new COM port by
selecting Select New COM No.:

COMPort Assignment Utility [ ][0 [X]

[] Show Devices which are Mot Curently Connected

Select Portto Change: | USE Serial Pott (COME) v |

Select New COM No: | COM2 v|

Assign ComPort

Prezz F5 to Refresh

Figure 3-4: COMPort Assignment Utility

2. Set the COM port to any unused COM between COMs 1-9.
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Configuring Instrument Settings

Instrument includes configuring communications settings and selecting
the type of microplate reader connected to the computer.

To configure the instrument settings:

1. In Baud rate, select Auto Sense or the desired baud rate for
communication between the ADAP software and the microplate
reader. Setting a specific Baud rate, such as 9600, requires that the
Baud rate setting on the reader match that in the ADAP software.

= The Zenyth 340 microplate reader supports baud rates of 9600,
19200, and 38400. The EZ Read 400 and Anthos 2010/2020
microplate readers support a baud rate of 9600.

2. In COM Port, select the communications port (COM) that is used to
connect the instrument to a PC. (As determined in the previous
section: 3.2.1.1).

= If more than one instrument is connected to the computer,
select the specific COM Port the reader is connected to.

3. In Instrument Type, select the type of microplate reader to control
using the ADAP software.

= After selecting the Instrument Type, the ADAP software
communicates to the instrument attached to the selected COM Port
and automatically displays the serial number and firmware version
of the instrument. If the Instrument Type selected does not match
the data from the instrument, an Instrument not found error will
occur.

= Selecting Simulator allows simulated measurements to be
created, edited, and run without having an instrument connected to
the computer. Simulator is useful for testing new protocols.

The Simulator emulates a microplate reader but does not provide
the ability to simulate scan measurements.

4. Select Read Configuration. The filter configuration and defined
plates stored in the instrument are read and displayed in Filter and
Installed Plates.

ADAP
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3.2.3. Viewing and Configuring Filters

Filter displays the Position on the filter wheel and Wavelength of each filter
installed in the instrument. Filter information is populated automatically
when Read Configuration is selected in Instrument.

Filters installed in the Zenyth 340 can be changed by the user. After
filters are physically added, removed, or moved to a different location
on the filter wheel, the filter settings must be updated. Only users with
Level 3 (system administrator) access can update filter settings.

To update the filter settings:

1.

2.

In Position, select the filter position which has been changed.
In Wavelength, enter the wavelength of the new filter.

Repeat steps 1 and 2 for each filter position that has changed.
Choose Send to Instrument to send the information to the

instrument and update the instrument settings. Message appears
(Error! Reference source not found.).

=> Send to Instrument appears only when a user with Level 3 (system
administrator) access is logged into the software.

ADAP
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Choose Yes to adjust the lamp.

= The lamp must be adjusted if a filter has been installed or
changed. New filter wavelengths cannot be used in measurements
until the lamp adjustment is made.

= The lamp adjustment process cannot be interrupted.

OR

Choose No to return to Instrument Settings without adjusting the
lamp.

= Choose No only if a filter has been removed from the reader.
Adding or changing filters requires that the lamp be adjusted
before they can be used in measurements.

3.2.4. Viewing Installed Plates

Installed Plates displays all the plate definitions that can be used in
measurements performed by the microplate reader selected in
Instrument Type.

=> Installed Plates is automatically populated when Read Configuration is
selected in Instrument.

=>Refer to Section 5.2.2, Editing and Transferring Plate Formats for
more information about using microplates with the instrument.
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3.2.5. Setting the Temperature

The Zenyth 340rt microplate readers feature the ability to perform
temperature-controlled incubations. For more information, refer to the
user’s manual for the Zenyth 340.

To set the temperature:

1. In Type, select Celsius or Fahrenheit.

= The Fahrenheit scale is only available on readers sold in the
United States.

2. Choose Read Temperature to get current temperature of the
microplate reader.

3. In Set Temperature, enter the desired temperature for incubation.

= The incubation temperature must be a minimum of 4° C (7.2° F)
above ambient. The maximum incubation temperature is 45° C
(113° F).

4. Choose Set Temperature to prepare the microplate reader for
incubation.

5. To determine when the desired incubation temperature has been
reached, choose Read Temperature until the current temperature
of the reader matches the desired incubation temperature.

= The incubation temperature will remain at the current setting
until Set Temperature is changed.

= To turn temperature control off, in Set Temperature, enter 0.
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3.3.

Configuring System Settings

System settings, including data storage path, raw data format, and
printout headers, are configured in Setup-System.

To configure system settings:

1. From the Setup menu, select System. Setup-System appears
Figure 3-

B Setup-System |'__||'g|§|
Fath Raw Data
T
A Program Files Select raw data format
- 14y af kinetic ar scan
readingz
=L -
B =
D atabaze Language
v Arccesz
“wiite additional Text File |English =l
|Te:-:t File b atri j
Ao Logaff
Log off, if pragram iz not uged for 0 minutes

Setting thiz value to 0 dizables auto logaoff

Printout Line 1 + 2

ADAP Software 1.6

|.-’-'-.nth|:|s Labte: [nstruments

Save Cancel

Figure 3-5: Setup-System

2. To create a new database, in Path, select the desired local or
network drive. All folders on the drive are displayed.

ADAP
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3. Browse to the desired location on the selected drive to create the
database by double-clicking on the desired folders.

= A database created before changing the Path will not be
accessible if the Path is changed to a different drive or folder. Plate
layouts, test definitions, and test results stored in the database will
not be available to the ADAP software unless the original Path to
the database is restored.
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4. In Raw data, choose the desired file format for saving raw data:

e TXT — Saves the raw data as a text file readable by most word
processing applications.

e XML — Saves the raw data as an XML file. XML is a format
designed for sharing information over the Web.

5. In Database, select Access to store measurement data in the ADAP
software database.

= Selecting Access ensures that all measurement data is saved and
may be exported to text files for viewing in other software
applications. For example, after a measurement is completed and
saved, exporting the measurement data from the database is the
only method available to create a text file with the data arranged in
an 8 x 12 array.

6. In Database, select a text file format to store measurement data in
text files.

e None — Text files are not saved.

e Text File PLT — Saves measurement results as a *.plt file with
text formatting that can be read by the AD 340S standalone
software.

e Text File Structure, TAB — Saves measurement results in tab-
delimited columns that can be imported into many spreadsheet
and database applications.

e Text File Structure, Semicolon — Saves measurement results in
semicolon-delimited columns that can be imported into many
spreadsheet and database applications.

o Text File Matrix— Saves measurement results in tab-delimited
matrices that can be imported into many spreadsheet and
database applications.

= Measurement data may be saved simultaneously in the ADAP
software database and in text files.

=> If no Database options are selected, manual options for saving
data appear after each measurement. If no save option is selected
at this time, the measurement data is not saved.

7. In Language, select whether to run the ADAP software in English or
German.

8. In Printout Line 1 + 2, enter the header text that will appear on all
printouts of measurement results.

9. Choose Save to save the new settings. Setup-System closes.
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OR

Choose Cancel to close Setup-System without saving changes.
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4. Manually Controlling Readers with
the ADAP Software

4.1. Overview

The ADAP software provides two Functions tabs that permit manually
controlling many instrument operations independently from
measurements. Functions 1 controls operations such as loading and
ejecting microplates and displays instrument information (refer to
Section 4.2, Using Functions 1). Functions 2 adjusts several instrument
parameters and controls operations such as dispensing fluids and
shaking microplates (refer to Section 4.3, Using Functions 2).

To access the Functions tabs:

1. From the Setup menu, choose Instrument. Instrument appears
(Figure 4-1).

2. Choose the desired Functions tab to display: Functions 1 or
Functions 2. The selected tab is displayed (Figure 4-1).
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4.2. Using Functions 1
Functions 1 tab is divided into two sections: Functions and Information
(Figure 4-1). The Functions tabs control several common instrument
operations. Information displays information about the connected
instrument.
= Operations available depend on the instrument being controlled by
the ADAP software and the access level of the user currently logged into
the software. For example, Figure 4-1 shows operations for the Zenyth
340 microplate reader available to a user with User Level 3 (system
administrator) access.
& Instrument =13
File
Functions
Eject Plate | Rezet Airfilker |
Load Plate |
Initialize |
STOP |
ADC/Diode Values |
Senszor State |
Check Plate |
Information
Statuz |
Statuz report |
Light Source Info |
Errorz/wf armings |
Log File |
Figure 4-1: Instrument - Functions 1
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4.2.1. Performing Functions

\

The options in Functions control basic instrument operations as described

in Table 4-1.

Functions Zenyth 340 Operation

Load Plate Moves the plate transport
inside the instrument

Eject Plate Moves the plate transport
outside the instrument.

Initialize Moves all mechanical
components of the instrument
to home positions
STOP Stops all operations in

progress

ADC/Diode Values

Continuously updates and
displays in Information the
ADC value of the instrument
until Information is closed

Sensor State

Continuously updates and
displays in Information the
current state of all instrument
sensors until Information is
closed.

Check Plate

Checks that a microplate is
inserted in the instrument

Reset Air Filter

Resets the air cycle count
after replacing the air filter on
the instrument.

=» This function is available
only to users with User Level
3(system administrators)
access.

Table 4-1: Functions by Instrument Capability
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4.2.2. Viewing Information

The options in Information display instrument setting information as

described in Table 4-2.

Information

Operation

Status

Displays in Information the current
state of the instrument: OK,
Ready, Error, or Standby

Status Report

Displays in Information the current
status of several mechanical
components including the
transports and filter wheel

Light Source Info

Displays the current status of the
light source for each filter in
Information.

Errors/Warnings

Displays current alerts, errors,
and warnings in Information.

Log file

Displays in Information the
instrument log file that records all
commands sent by the software to
the instrument and execution
errors.

= The instrument Log File is
primarily intended for service
technicians.

Table 4-2: Functions 1:

Information Options
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When an option is selected in Information, the specific instrument
information relating to the selected option appears in Information
(Figure 4-2).

& Information M=

File
E.

Figure 4-2: Information displaying Light Source Info
Information can be:

e Copied to the clipboard (refer to Section 4.2.2.1, Copying Instrument
Information to the Clipboard).

e Saved as a text file (refer to Section 4.2.2.2, Saving Instrument
Information in a Text File).

e Printed (refer to Section 4.2.2.3, Printing Instrument Information).

4.2.2.1. Copying Instrument Information to the Clipboard

Information can be copied to the clipboard and then pasted into another
application such as a word processor.

To copy the information to the clipboard:

From the File menu, choose Copy. The information is copied to the
clipboard and can be pasted in any application using the Paste
command.

=>Most applications have a standard shortcut of CTRL+V assigned
to the Paste command.
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4.2.2.2. Saving Instrument Information in a Text File

Information can be saved as a text file (*.txt), a format that can be
opened by most word processors.

To save the information as a text file (*.txt):
1. From the File menu, choose Save. Save As appears.

2. In Save As, browse to the desired directory where the file will be
saved.

3. In File name, enter a name for the text file.

4. Choose Save. The text file is saved in the specified directory
location with the specified File name.
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4.2.2.3. Printing Instrument Information
To print the information in Information:

1.  From the Database menu, choose Print. Print appears (Figure 4-3).

it Print
Prirter
range T
k
& All Tests =
" Single Test .
ingle Tes ~
~
~
~
~
Options
Fonts |@.f-‘-.rial Unicode M5 j
Copiez 1 * | Size a -
0k, Cancel |

Figure 4-3: Print

2. In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

3. In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

4. Choose OK to print the information.

=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears.
The printed file is saved to the ADAP software home directory.
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4.3. Using Functions 2

Functions 2 is divided into two sections: Adjustments and Functions (Figure
4-4). Adjustments calibrate mechanical parameters for the Zenyth 340.
Functions provide manual control of dispensing and shaking operations.

= Adjustments are available only for the Zenyth 340, and may be
accessed only by users with User Level 3 (system administrator) access.

& Instrument IZIIEI@

File

l Do pload ]

Adjustments for Service Perzonnel

Adjust Lamp |

ko Calibration |

Functions

Tl

|
|

Shaking | tode Low - Tirme
|

Figure 4-4: Instrument - Functions 2 (Zenyth 340)
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4.3.1. Adjusting the Zenyth 340 Microplate reader

When the ADAP software controls the Zenyth 340, two adjustment
options, Adjust Lamp and Auto Calibration, are available to users with User
Level 3 (system administrator) access. Select the desired operation to
perform the action described in Table 4-3.

Adjustment Operation

Adjust Lamp Checks the lamp source and filter
and sets new energy and gain
values for each filter.

Displays the status for each filter
position in Information.

Auto Calibration Calibrates the plate and optics
transports.

Displays the name and value of the
calibrated parameters in
Information.

=>Calibration may take a few
minutes.

Table 4-3: Functions 2: Adjustment Options
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4.3.2. Performing Additional Functions

The options in Functions perform operations such as dispensing liquid
and shaking the microplate. Unlike the operations in the other sections
of the Functions tabs, these require further configuration. Select the
desired operation to perform the action described in Table 4-4.

Function Zenyth 340 EZ Read 400
Operation /2010/2020
Operation
Shaking Shakes a N/A

microplate in the
plate carrier.
Refer to Section
4.3.2.1, Shaking
Microplates, for
more information.

Table 4-4: Functions 2: Additional Functions
4.3.2.1. Shaking Microplates

Shaking performs a shaking operation on the Zenyth 340 microplate
reader.

To perform a shaking operation:

1. In Intensity, select the desired shaking intensity: Low, Medium, or
High.

2. In Time, enter the length of time to perform the shaking operation.

3. Choose Shaking to shake at the specified Intensity and Time.
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4.4. Quick Access to Common Operations

Several frequently performed operations can be accessed quickly from

the ADAP software menus and toolbar:

e Set Temperature (refer to Section 4.4.1, Setting Instrument

Temperature).

o Eject Plate (refer to Section 4.4.2, Ejecting Plates).

e Load Plate (refer to Section 4.4.3, Loading Plates).

e Initialize Instrument (refer to Section 4.4.4, Initializing the

Instrument).
= Operations available depend on the instrument connected to the
computer.
4.4.1. Setting Instrument Temperature

The Zenyth 340rt microplate reader is capable of performing

temperature controlled incubations of microplates. Refer to the user’s

manual for Zenyth 340 for more information.

To set the temperature:

1.  From the Reading menu, choose Set Temperature.
OR

d
Choose the Temperature icon. Temperature appears (Figure 4-5).
= The Temperature icon appears only when an instrument with
temperature control is being controlled by the software.
= Actual Temperature displays the current temperature inside the
instrument.
=>The temperature scale used is determined by the setting in
Instrument (refer to Section 3.2, Configuring the Microplate Reader).
The Fahrenheit scale is only available on instruments sold in the
United States.
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Set Temperature FZI

Enter desired Temperature

Actual Temperature: 23.4 °C Cancel

i

Figure 4-5: Temperature

2. In Temperature, enter the desired incubation temperature.

= The incubation temperature must be a minimum of 4° C (7.2° F)
above ambient. The maximum incubation temperature is 45° C
(113° F).

The incubation temperature will remain at the current setting until
a different temperature is entered.

To turn temperature control off, enter 0.

3. Choose OK to set the incubation temperature and close
Temperature.

OR

Choose Cancel to close Temperature without changing the
incubation temperature.

4.4.2. Ejecting Plates
To move the plate carrier and microplate outside the instrument:

From the Reading menu, choose Eject Plate.

OR

Choose the Eject Plate icon.

=> Eject Plate is only available with the Zenyth 340 microplate
reader.

4.4.3. Loading Plates

To move the plate carrier and microplate into the instrument:
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From the Reading menu, choose Load Plate.

OR

AT

Choose the Load Plate icon.

=> Load Plate is only available with the Zenyth 340 microplate
reader.

4.4.4. Initializing the Instrument

To move all mechanical components of the instrument to home
positions:

From the Reading menu, choose Initialize Instrument.

OR

¥

e Choose the Initialize Instrument icon.
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5. Transferring Data between the
Instrument and Computer

5.1. Overview

Test and plate definitions; measurement results; and instrument
EEPROM firmware and software updates can be transferred between the
computer and instrument. Depending on instrument capabilities, data is
transferred by:

e Choosing data transfer options in the Down/Upload tab within the
ADAP software (refer to Section 5.2, Transferring Data Using
Down/Upload).

OR

e Copying files using a Local Area Network, floppy disk, or Microsoft
ActiveSync® outside of the ADAP software

The ADAP software automatically recognizes whether the connected
Biochrom reader is a standalone instrument with onboard software (like
the Anthos 2020) or controlled by a computer (for example, the Zenyth
340r). The appropriate data transfer and device control functionality is
automatically enabled for the instrument. The types of data that can be
transferred vary by instrument:

e Zenyth 340r — Plate definitions, instrument firmware updates, and
EEPROM updates.

e EZ Read 400, Anthos 2010 — Instrument firmware updates and
EEPROM updates.
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e 2020 — Test definitions, measured plate results, and instrument
EEPROM firmware and software updates.

=> Refer to Table 5-1 for more information about which data transfer
functions are available for each instrument.

Function Access Zenyth EzZ 2010 2020
340r Read
400

EEPROM data User Yes Yes Yes Yes
upload
EEPROM data Service Yes Yes Yes Yes
download
Firmware Service Yes Yes Yes Yes
download
Onboard PC User N/A N/A N/A Yes
software
download
Plate definition User Yes N/A N/A N/A
file upload
Plate definition User Yes N/A N/A N/A
file download
Test file upload User N/A N/A N/A Yes
Test file User N/A N/A N/A Yes
download
Measured plate User N/A N/A N/A Yes
upload
Measured plate User N/A N/A N/A Yes
download
Evaluated data User N/A N/A N/A Yes

text file upload

Import test file User N/A N/A N/A No
to database

Export test file User N/A N/A N/A No
from database

Table 5-1: Data transfer functions by instrument
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5.2.

Transferring Data Using Down/Upload

With the 2020, all data is transferred between the computer and
instrument using the data transfer options in the Down/Upload tab in
Instrument. The Zenyth 340 only supports transferring plate definitions
and uploading EEPROM data from the instrument with Down/Upload.

= With the Zenyth 340, data types other than plate definitions and
EEPROM data are transferred outside the ADAP software using a Local
Area Network, floppy disk, or Microsoft ActiveSync®

To access the data transfer options in Down/Upload:

1. From the Setup menu, choose Instrument. Instrument appears

Figure 5-1).

& Instrument
File

Filter

Ingtrurment I Functions 1 ] Functions 2] Downa’Upluad]

Position E

W avelength |I32EI

Send to [nztrument

Inztalled Plates

6. COSTA
6: GEEB

12: COST1z2
12: HUHC1Z2
24 COST24
24: GEEZ24
48 COST48
48: HUHC48g

Temperature

Read Temperature

| 236

Set Temperature

|

Type:

Celsiuz -

DX

Ingtrument

B audrate 9600 -

COM Port COma -

|mstrument Type
|Zenylh ﬂ

Read Configuration |

Serial Mumber 1351
Type 106
[

Firrmware Yergion
W1.001/03/2003

Semvice Code

o

Figure 5-1: Instrument
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Choose Down/Upload (Figure 5-2).

& Instrument
File

Instrument] Funu:tiu:uns1] Functions 2

Firrmwmare
[nztrument -» FC PC -= [nstrument
| Firrmware |
EEPROM Data | EEFROM Data |

| Standalone Saftware |

Test / Plate Data Transfer

Instrurment -> PC PC - Instrument

Test Definition File | Test Definitian File |
Ewaluated Plates File | Evaluated Plates File |
Ewal. Plates, Text File | Ewal. Plates, Text File |
Plate Definiion | Edit Plate Definiion Plate Definifion |

Import ¢ Export Test Files

Impart to [ atabaze Ewport from D atabaze

Figure 5-2: Instrument - DOWN/Upload

=> Data transfer options available in Down/Upload vary depending on the
instrument being controlled by the ADAP software.

The options in Down/Upload can be divided into three categories based
on function (Figure 5-2):

e Upload and download data — Instrument firmware and EEPROM
data can be transferred between any instrument model and
computer. Standalone software can be transferred from the
computer to the Anthos 2020. Test definitions and evaluated plate
measurement data can be exchanged between the computer and the
Anthos 2020.

ADAP

ADAP Software Operating Manual 5-4



\

Transfer options for each type of data are arranged in two columns.
Choosing options in the Instrument->PC column upload data from
the instrument to the computer; options in the PC->Instrument
column download data from the computer to the instrument.
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e Edit and transfer plate formats — The Zenyth 340 microplate
reader supports multiple plate formats. Options in this category
allow plate formats to be edited and transferred between the
instrument and the computer (refer to Section 5.2.2, Editing and
Transferring Plate Formats).

e Import/Export test files — Test definitions created by the ADAP
software and the Zenyth 340s standalone software are compatible
and may be transferred between the computer and instrument.
However, the ADAP software stores them in a database; the Zenyth
340s stores them as individual files.

Test definitions stored in the ADAP software database must be
exported to individual files before being downloaded to the Zenyth
340s. Test definition files uploaded to the computer from the
instrument must be imported to the ADAP software database before
a measurement is performed (refer to Section 5.2.3, Updating
Firmware, EEPROM Data, and Standalone Software).
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5.2.1. Uploading and Downloading Data

The data transfer options in Firmware and Test/Plate Data Transfer allow
data to be updated or transferred between computer and instrument.
Transfer options for each type of data are arranged in two columns.
Options in the Instrument -> PC column upload the desired data from the
instrument to the computer; options in the PC -> Instrument column
download data from the computer to the instrument (Figure 5-2).

Three types of data can be transferred:

e Firmware, EEPROM Data, and Standalone Software — The instrument
firmware and software can be upgraded (refer to Section 5.2.1.1,
Updating Firmware, EEPROM Data, and Standalone Software).

o Test Definition File — Test definitions may be transferred between the
Anthos 2020 and the computer. This allows test definition files to be
stored on the computer and downloaded to other instruments (refer
to Section 5.2.1.2, Transferring Test Definitions).

o Evaluated Plates File — Evaluated Plates File — Measurement results
from the Anthos 2020 standalone software may be exported to text
files with all data organized in columns. Exported measurement
results may be opened for further evaluation in Microsoft Excel or a
similar application, but not within the ADAP software (refer to
Section 5.2.1.3, Transferring Measurement Results From an Anthos
2020 detector).
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5.2.1.1. Updating Firmware, EEPROM Data, and Standalone
Software

Firmware provides options to transfer instrument firmware updates,
EEPROM data, and standalone software updates.

= Most Firmware options are reserved for use by Biochrom Service
Engineers and are accessible only with a valid service code.

e Firmware — Updates the instrument firmware. Only accessible with a
valid service code.

e EEPROM Data — All instruments can upload EEPROM data to the
computer. Downloading updated EEPROM data to an instrument
requires a valid service code.

= EEPROM data should only be uploaded to the computer by a
Biochrom Service Engineer.

e Standalone Software — updates the onboard software on standalone
instruments.

5.2.1.2. Transferring Test Definitions

Test Definition File provides options to transfer test definitions between a
standalone instrument and the computer. To transfer test definitions
between the computer and the Anthos 2020:

=> Test Definition File options are available only with the Anthos 2020.

1. Put the instrument in Data Transfer mode. Refer to the instrument
user’'s manual for more information.

2. In the ADAP software, from the Setup menu, choose Instrument.
Instrument appears (Figure 5-1).

3. Choose Down/Upload (Figure 5-3).
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Figure 5-3: Down/Upload - Test definition transfer options

In Test/Plate Data Transfer, choose the desired Test Definition File

transfer operation to perform. Selection appears (

Figure 5-4)
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Figure 5-4: Selection for test definitions

Select the desired file(s) to transfer. Multiple files can be selected by
holding CTRL and selecting additional files.

= Test definitions transferred to the computer are saved in the
ADAP software home directory selected in Setup-System (refer to
Section 3.3, Configuring System Settings).

4. Choose OK to transfer the selected files from the source to the
destination.
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OR

Choose Cancel to close Selection without transferring any test
definition files.

OR

Choose Delete to delete the selected file(s) from the source.
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5.2.1.3.

Transferring Measurement Results From an Anthos 2020
detector

Evaluated Plates File provides options to transfer measurement results
from evaluated plates between the computer and instrument. On the
Anthos 2020, plate data is stored in non-text (*.res) files. They may be
transferred between the instrument and computer as *.res or *.txt files.

=> Evaluated Plates File options are available only with the Anthos 2020.

Non-text (*.res) files contain the measurement data and original
instructions for evaluation. They can be re-evaluated by the Anthos
2020 standalone software or archived, but are not readable by software
applications other than the standalone software on the instrument.

= Text (*.txt) files may be exported to other applications, such as
spreadsheet, for further evaluation. They cannot be transferred back to
the instrument.

To transfer evaluated plate data between the computer and the Anthos
2020:

1. Put the instrument in Data Transfer mode. Refer to the instrument
user’s manual for more information.

2. In the ADAP software, from the Setup menu, choose Instrument.
Instrument appears (Figure 5-1).

Choose Down/Upload (

M Instrument =]

File
Instrument | Functions 1| Functions 2 Dawn/Uplaad |

Firmusare:
Instrument > PC. PC - Instument

| Firmware \

EEPROM Data | EEPAOM Data \

| Standalone Software ‘

Test / Plate Data Transfer
Instrument > PC PC - Instrument

Test Diefinition File | Test Definition Fils

Evaluated Plates File

Eval. Plates, Text File | Eval. Plates, Text File

Flate Definition ‘ Edit Flate Definition Flate Definition

Import # Export Test Files

Import to Datshase | Export from Database

3. Figure 5-5).
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2010_07_05_3.plt
2010_07_05_4.plt
2010 07_23_2 plt
2010°07_23_3.plt
20010°07_23_1.plt

2010.07_29 2pt ¥

ak. |

LCancel

Delete |

4. Figure 5-6).

o Evaluated Plates File — Transfers plate data from evaluated tests to
and from the instrument.

e Eval. Plates, Text File — Re-evaluates plate data saved as a *.res
file and converts the results to a tab-delimited text file that can
be imported into spreadsheet or database application for further
evaluation.

= Text files (*.txt) cannot be transferred from a computer back to
the instrument. Therefore, Eval Plates, Text File in the PC->Instrument
column has no function.
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Figure 5-6: Selection for evaluated plates

5. Select the desired file(s) to transfer. Multiple files can be selected
by holding CTRL and selecting additional files.

6. Choose OK to transfer the selected files from the source to the
destination.

OR

Choose Cancel to close Selection without transferring any test
definition files.

OR

Choose Delete to delete the selected file(s) from the source.
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5.2.2.

Editing and Transferring Plate Formats

The Zenyth 340 microplate reader supports plate formats ranging from
6 to 1536 wells. Plate dimensions, or plate formats, are stored in the
instrument firmware and can be uploaded to the computer and stored in
plate definition (*.plt) files. Plate definition files store the plate formats
for several different plates.

= Not all plate types are suitable for absorbance measurements, even if
the format is supported by the Zenyth 340. For example, only 1536-well
plates with a well capacity = 10ul are recommended. To ensure accurate
measurement results, verify plate performance before measuring
samples.

When a plate definition file is downloaded to the instrument, all plate
formats saved in the file are copied to the instrument firmware, erasing
the plate formats previously stored there. For this reason, backing up
plate definition files uploaded from the instrument is important.

Edit Plate Definition can edit plate formatting information stored in any
plate definition file saved on the computer. However, it is intended to be
used only to edit plate formats currently stored in the instrument
firmware.

Edit Plate Definition provides the ability to:

e Create and edit plate formats (refer to Section 5.2.2.2, Creating and
Editing Plate Formats).

e Delete plate formats (refer to Section 5.2.2.3, Deleting Plate
Formats).

e Transfer plate definition files (5.2.2.4, Transferring Plate Formats to
the Instrument).

The Plate Definition options next to Edit Plate Definition transfer plate
definition files in the same manner as the transfer options for uploading
and downloading other types of data.

ADAP Software Operating Manual 5-15
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5.2.2.1.

5.2.2.2.

Uploading and Backing Up Plate Formats Stored on the
Instrument

Before editing a plate format, all plate formats uploaded from the
instrument to the computer should be backed up. Backing up the
original plate formatting information is critical because each time edited
plate formats are downloaded to the instrument, the original plate
formatting information is overwritten.

To upload and backup plate formats:

1. Put the instrument in Remote Control mode. Refer to the instrument
user’s manual for more information.

2. In the ADAP software, from the Setup menu, choose Instrument.
Instrument appears (Figure 5-1).

3. Choose Down/Upload (Error! Reference source not found.).

4, In Test/Plate Definition, choose Plate Definition under Instrument ->
PC to transfer the stored plate definition file from the instrument to
the computer.

5. Browse to the directory where the uploaded plate formats will be
stored in a plate definition (*.plt) file.

6. In File name, choose a name for the file; for example,
default_plates_backup.plt.

7. Choose Save to create the backup plate definition file.

8. Repeat steps 4 and 5 to create a second copy of the plate definition
file. This is the file that will be edited and transferred back to the
instrument.

9. In File name, choose a name for the plate definition that will be
edited and transferred back to the instrument. Use a name similar
to that given to the backup file; for example default_plates.plt.

10. Choose Save.

Creating and Editing Plate Formats

Plate formats uploaded from the instrument and stored in a plate
definition (*.plt) can be created and edited.

To create or edit a plate format:
1. Upload and backup plate formats using the steps detailed in

Section 5.2.2.1, Uploading and Backing Up Plate Formats Stored on
the Instrument.

ADAP
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4,

In Test/Plate Data Transfer, choose Edit Plate Definition. Open

appears.

Browse to and select the plate definition (*.plt) file to edit.

Choose Open. Plate Definition appears (

i Plate Definition X
File Edit
AlY Delta™ Well Diameter
o il s I
A ILO0000000C
DEHEXI-OOOOOOOO(:
90000000
Mame |STANDARD -
el 9 -
A =
ADY 4%
Delta E
Delta'y R
Diarneter Imi
Figure 5-7).
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Figure 5-7: Plate Definition

5. To create a new plate format, in Name, enter a name for the new
plate format.

OR

6. To edit an existing plate format, in Name, select the desired plate
format to edit.

7. In Well, select the number of wells on the plate.

2 Refer to the graphic in Plate Definition (

Figure 5-7) showing the dimensions when configuring steps 8-12. All
measurements are in millimeters (mm). Plate dimensions should be
measured, or taken from the specifications provided by the plate
manufacturer.

8. In AOX, enter the distance from the edge of the X-axis of the
microplate to the center of the first well in the X-axis.

9. In AQY, enter the distance from the edge of the Y-axis of the
microplate to the center of the first well in the Y-axis.

10. In Delta X, enter the distance between well centers in the X-axis.

11. In DeltaV, enter the distance between well centers in the Y-axis.

ADAP

ADAP Software Operating Manual 5-18



\

12. In Diameter, enter the diameter of each well.

= The Diameter must be smaller than the values for Delta X and
Delta V.

13. From the File menu, choose Save to save the new or edited plate
format to the plate definition file.

14. From the File menu, choose End to close Plate Definition.

= To transfer the plate formats from the computer to the
instrument, refer to Section 5.2.2.4, Transferring Plate Formats to
the Instrument.

5.2.2.3. Deleting Plate Formats

Plate formats uploaded to the instrument and stored in a plate definition
(*.plt) file can be deleted.

To delete a plate format:
1. Upload and back up plate formats using the steps detailed in
Section 5.2.2.1, Uploading and Backing Up Plate Formats Stored on

the Instrument

2. In Test/Plate Data Transfer, choose Edit Plate Definition. Open
appears.

3. Browse to and select the plate definition (*.plt) file to edit.

Choose Open. Plate Definition appears (
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B Plate Definition
File Edit

ADY Deltay Well Diameter

o il 5 IR .
A O0000000C
parax TTOO OO 00O OC
9999908Q¢
Mame STANDARD |
el 36 -
A =
ADY 143\
Delta R
Delta 'y R
Diarneter |547
Figure 5-8).
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Figure 5-8: Plate Definition

5. In Name, select the desired plate format to delete from the list.

6. From the Edit menu, choose Delete. A confirmation appears. Select
Yes to delete the plate format from the plate definition file.

= To transfer plate formats from the computer to the instrument, refer
to Section 5.2.2.4, Transferring Plate Formats to the Instrument.

ADAP
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5.2.2.4. Transferring Plate Formats to the Instrument

Plate formats stored in a plate definition (*.plt) file can be transferred
from the computer to the instrument.

To transfer plate formats:

1. Put the instrument in Remote Control mode. Refer to the instrument
user’s manual for more information.

2. From the Setup menu, choose Instrument. Instrument appears
(Figure 5-1).

3. Choose Down/Upload (Error! Reference source not found.).
4. Choose Plate Definition under PC -> Instrument.

5. Browse to the directory where plate definition file is saved and
select it.

6. Choose Open to transfer the plate definition file which includes the
plate formats from the computer to the instrument.
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5.2.3. Importing and Exporting Test Definitions and
Measurement Results

The ADAP software stores test definitions and measurement results in a
database. Test definitions created and used by the Zenyth 340s
microplate reader are stored in individual *.dwr files.

Import/Export Test Files is used to import uploaded test definitions and
measurement results to the test database or export test definitions and
measurement from the database to *.dwr and *.plt files that can be
read by the instrument.

This section covers:

e Importing test definitions to the ADAP database (refer to Section
5.2.3.1, Importing Test Definitions to the ADAP Database).

e Importing/Exporting test definitions from the ADAP database
(refer to Section 5.2.3.2, Exporting Test Definitions from the Test
Database).

e Importing test measurement results to the ADAP database (refer
to Section 5.2.3.1, Importing Test Definitions to the ADAP
Database).

= Test definitions may be imported to and exported from all types of
the ADAP software; however, a valid ADAP Plus or Expert license code is
required to read and modify the files.
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Importing Test Definitions to the ADAP Database

Any test definition file that has been uploaded from a microplate reader
can be imported into the test database. A test definition must be in the
test database to perform a measurement using the ADAP software.

To import a test definition into the test database:

1. In the ADAP software, choose Instrument from the Setup menu.
Instrument appears (Figure 5-1).

2. Choose Down/Upload (Figure 5-9).

& Instrument
File

In&trumentl Functinnﬂ] Functiohs 2 Down/Uplaad

Firrnware
Instrument - PC PC -» Instrument
| Firrnweare |
EEFROM Data | EEFROM Data |

| Standalone Software |

Test / Plate Data Transfer

Instrumnent -> PC PC == Instiument

Test Definition File | Test Diefinition File |
Ewvaluated Plates File | Ewaluated Plates File |
Eval Plates, Test File | Eval Plates, Test File |
Plate Definition | | Edit Plate Diefirition Plate Definition |

Import # Export Test Files

Import to D atabaze | Export from D atabaze

Figure 5-9: Down/Upload - Import/Export Test Files
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3. In Import/Export Test Definition, choose Import to Database. Open
appears (Error! Reference source not found.).

4. Browse to and select the test definition to import to the test
database.

5. Choose Open. The selected test definition file is imported to the
ADAP software database.

5.2.3.2. Exporting Test Definitions from the Test Database

Any test definition in the ADAP software database can be exported to a
test definition file that can be downloaded to a Zenyth 340s.

To export a test definition from the database to a file:

1. In the ADAP software, From the Setup menu, choose Instrument.
Instrument appears (Figure 5-1).

2. Select the Down/Upload tab to display it (Figure 5-9).

3. In Import/Export Test Definition, choose Export from Database.
Selection appears (Figure 5-10).

16 items

BCA Standard

Bradford [Coomassie]
Bradford Aszay
Bradford Micro
Bradford Standard

Cell counting

dzDMa EMA 8 ELISA
dzDMA EMA B ELISA 2
EMNA BELISA

[ala Cuantitation

MTT Cell Growth hd

update list Delete

|

M atchoode |
oK |
|

Cancel

Figure 5-10: Select test to export

4. Select the test definition to export from the test database.
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= Choose Matchcode to search for test definitions containing
specific plate IDs (refer to Section 8.7, Using Matchcode to Search
for Test Definitions and Saved Plates).

5. Choose OK. The selected test definition file is exported from the
ADAP software test database as a test definition file that can be
downloaded to the instrument (refer to Section 5.2.2, Editing and
Transferring Plate Formats
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6. Performing Quick Measurements

6.1. Overview

The ADAP software is capable of performing photometric and quick

measurements. Quick measurements are configured in Quick-Read,

which is designed to allow measurement parameters to be changed
quickly and easily (

Figure 6-1). Quick measurements do not require defining tests.

=2 Tests offer additional measurement parameters that are configured in
test definitions which may be saved, reused, and modified (refer to
Chapter 8, Defining and Running Tests).

The types of Quick measurements available depend on the instrument
being controlled by the software (Table 6-1).

Measurement Type Zenyth 200 | Zenyth 340 EZ Read 400/
2010/2020
Endpoint photometric X X X
Kinetic photometric X X X
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% Quick-Read

Load Plate Eject Plate

Farmat
Flate Tupe

FMeazurement Position All

| Mizraplate

|STANDARD
[ Set Sample

keasurement kode;

keazurement Filker

Reference Filker

| Endpaint Phatametric

| 450

Bl

Shaking |
Start Cancel |
Multiwavelength X X X
Linear scan X X N/A
Area scan X X N/A
Spectral scan X N/A N/A
Table 6-1: Measurement Capability by Instrument
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Figure 6-1: Quick-Read

= When Quick-Read opens, the parameters set for the last Quick
measurement run are displayed. Parameters for canceled Quick
measurements are not saved.

The process of configuring and performing Quick measurements is
divided into three parts:

e Choosing the type of photometric Quick measurement to perform
and configuring measurement parameters (refer to Section 6.2,
Configuring Photometric Quick Measurements).

e Choosing the type of microplate and setting which wells are
measured (refer to Section 6.3, Configuring Microplate Type and
Measurement Positions).

e Running the Quick measurement and saving the results (refer to
Section 6.4, Running Quick Measurements and Saving Measurement
Results).

= Refer to Chapter 7, Viewing Quick Measurement Results for
information on viewing measurement results.
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Configuring Photometric Quick Measurements

Configuring a photometric Quick measurement requires selecting the
desired Measurement Mode and configuring the available measurement
parameters. Photometric Quick measurements that can be performed
include:

e Endpoint photometric (refer to Section [, Configuring an Endpoint
Photometric Quick Measurement).

e Kinetic photometric (refer to Section 6.2.1, Configuring a Kinetic
Photometric Quick Measurement).

e Multiwavelength photometric (refer to Section 6.2.2, Configuring a
Multiwavelength Quick Measurement).

e Area scan (refer to Section 6.2.3, Configuring an Area Scan Quick
Measurement).

e Linear scan (refer to Section 6.2.4, Configuring a Linear Scan Quick
Measurement).

e Configuring an Endpoint Photometric Quick Measurement

An endpoint photometric Quick measurement performs a single
absorbance measurement on samples at a user-specified wavelength. If
desired, a bichromatic endpoint measurement may also be performed.
Bichromatic measurements perform a second measurement using a
reference wavelength. This measurement is subtracted from the first to
calculate the final result.

To perform an endpoint photometric Quick measurement:
1. From the Reading menu, choose Quick.

OR

p

Choose Quick-Read. Quick-Read appears (
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Figure 6-1).
2.

In Measurement Mode, select Endpoint Photometric. The

measurement parameters available for endpoint photometric
measurements appear.

In Measurement Filter, select the desired wavelength for the
measurement (Figure 6-2).

= The measurement wavelengths available depend on the filters
installed in the instrument (refer to Section 3.2, Configuring the
Microplate Reader).

ADAP
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% Quick-Read

Load Flate Eject Flate

Format | Microplate ﬂ
Plate Type |STANDARD |
Measurement Pogition Al [v Set Sample |

Measurement Mode: |Endpuint Phatometric ﬂ

Measurement Filter |45|:| ﬂ
Reference Filter
Shaking [

Stark LCancel |

Figure 6-2: Quick Read - selecting a Measurement Filter

4. To perform a bichromatic endpoint measurement, in Reference Filter
select the desired wavelength for the reference measurement.

= The measurement wavelengths available depend on which filters
are installed in the instrument (refer to Section 3.2, Configuring the
Microplate Reader).

= When a Reference Filter is selected, the reference measurement is
subtracted from the first measurement to calculate the final
measurement result.

=> If no Reference Filter is desired, select <-->. An endpoint
photometric measurement will be performed.

If desired, select Shaking to shake the microplate prior to the Quick
Quick measurement. Quick-Read expands to display Shaking parameters
parameters (
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5.

Figure 6-3).

=> If shaking is not desired, go to step 8.
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Figure
Read -

6. If

7. If

Load Plate

Farmat
Plate Type

Meazurement Position

Eject Flate

Al

|Mic:n:||:||ate

|STANDARD |

v

Set Sample |

Meazurement Mode:

|Enu:||:u:uint Photametric ﬂ

Meazurement Filker |45E| ﬂ
Reference Filter |52|:| j
[w Shake now |
Intenzity  |Medium  « | Time 5 -
Start LCancel |

6-3: Quick
Shaking

Shaking is
selected,
select the
Intensity of
the shaking:
Low,
Medium, or
High.

Shaking is
selected,
select the
Time to shake
seconds.

Choose Shake

Now to immediately shake the plate for the Intensity and Time
specified.

Choose the Plate Type and Measurement Position following the steps in

Section 6.4, Configuring Microplate Type and Measurement
Positions.
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6.2.1.

Configuring a Kinetic Photometric Quick Measurement

A kinetic photometric Quick measurement performs a user-specified
series of absorbance measurements on each sample at user-specified
intervals. Single or bichromatic measurements may be performed at
user-specified wavelengths. Bichromatic measurements perform a
second measurement in each cycle using a Reference Filter. This
measurement is subtracted from the first, and then final measurement
results are calculated using a data reduction method.

= Refer to Table 6-2 for information about the data reduction methods.

= To perform Quick measurements using a standalone instrument (for
example, the Zenyth 340s); place the instrument in Remote Control
mode. Refer to the instrument user’s manual for more information about
Remote Control mode.

To perform a kinetic photometric measurement:

1. From the Reading menu, choose Quick.

ox P

Choose Quick-Read. Quick-Read appears (Figure 6-4).

B Quick-Read X
Load Plate Eject Plate
Farmat | ticroplate ﬂ
Plate Type |STANDARD -]
teazurement Pozition Al ~ Set Sample |

Meazurement Mode:

Measzurement Filter

| E ndpoint Photometric

Start

| 450 |
Reference Filker | E20 j
-

Cancel

Figure 6-4: Quick Read
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2. In Measurement Mode, select Kinetic Photometric. The
measurement parameters available for kinetic photometric
measurements appear (Figure 6-5).

i Quick-Read

Eject Plate

Load Flate

Farmat

Plate Type

teasurement Paozition

&l

X

Bl
N

| kicroplate
|STAMDARD
v Set Sample

teasurement tode:

teasurement Filker

Reference Filker

Finetic Phatametne

| 450
620

Shaking

Internzity

k edium

-

v Shake now |

5 =

Time

K.inetic Measurement
[nterval
Cycles

Drata Reduction

|45 seconds
|'|
| ¢

El

Start

Cancel |

Figure 6-5: Quick Read - Kinetic Photometric parameters

3. In Measurement Filter, select the desired wavelength for the

measurement.

= The measurement wavelengths available depend on the filters
installed in the instrument (refer to Section 3.2, Configuring the

Microplate Reader).
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4. To perform a bichromatic kinetic measurement, in Reference Filter,
select the desired wavelength for the reference measurement.

= The measurement wavelengths available depend on which filters
are installed in the instrument (refer to Section 3.2, Configuring the
Microplate Reader).

= When a Reference Filter is selected, the reference measurement is
subtracted from the first measurement, and then final
measurement results are calculated using a data reduction method.

=> If no Reference Filter is desired, select <-->. An endpoint kinetic
measurement will be performed.

5. If desired, select Shaking to shake the microplate prior to each
cycle in the Quick measurement. Quick-Read expands to display
Shaking parameters.

= If shaking is not desired, go to step 8.

6. If Shaking is selected, select the Intensity of the shaking: Low,
Medium, or High.

7. If Shaking is selected, select the Time to shake in seconds.

= Choose Shake Now to immediately shake the plate for the
Intensity and Time specified.

8. In Interval, enter the length of time in seconds between each
measurement of the same well.

9. In Cycles, enter the number of times to measure each well.

10. Choose a Data Reduction method. Refer to Section 6.2.1.1, Data
Reduction Methods, for details about each data reduction method.

= The configuration parameters Smoothing Points, Lower Limit, Upper
Limit and In/Decrease become available depending on which data
reduction method is selected. Refer to the Additional Configuration
column in Table 6-2 for more details.

11. Choose the Plate Type and Measurement Position following the steps in
Section 6.3, Configuring Microplate Type and Measurement
Positions.
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Data Reduction Methods

Data Reduction is used to determine a single value per sample based on

the results of a sequence of measurements over a period of time. Table
6-2 describes the 12 data reduction methods for kinetic measurements
supported by the ADAP software.

Data Reduction
Method

Description Additional
Configuration

Average Slope

Determines the average slope of the Smoothing Points
reaction curve by calculating the average of
all linear regressions calculated over each
group of Smoothing Points in the kinetic
reading sequence. A decreasing slope
shows a decline.

Delta OD Difference in optical density between the N/A
first and last measurements in a kinetic
assay.
Delta OD — Max. Slope | Difference in OD between the first Smoothing Points

measurement and the center point of the
maximum slope.

= The center point of the maximum slope
is calculated by determining the center
point between the smoothing points of the
regression line with the maximum slope.

Delta Time — Absolute | Time elapsed from one preselected OD Lower Limit
value to another. Upper Limit
Delta Time — Max. Time difference in seconds between the first Smoothing Points

Slope

measurement and the occurrence of the
center point of the maximum slope.

= The center point of the maximum slope
is calculated by determining the center
point between the smoothing points of the
regression line with the maximum slope.

Delta Time — Relative

Time elapsed in seconds from the first In-/Decrease
measurement to reaching a set
increase/decrease amount from the first OD
measurement.

Maximum Declining

Determines the maximum declining rate of Smoothing Points

ADAP
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Data Reduction
Method

Description

Additional
Configuration

Slope

the reaction curve by calculating a linear
regression over each group of Smoothing
Points in the kinetic reading sequence.

Maximum Inclining
Slope

Determines the maximum inclining rate of
the reaction curve by calculating a linear
regression over each group of Smoothing
Points in the kinetic reading sequence.

Smoothing Points

Maximum Slope

Maximum slope of the curve in OD/min.
The line with the highest slope is calculated.
Also the maximum reaction speed.

= The accuracy of this calculation depends
on the number of measurement cycles
selected.

Smoothing Points

Mean

Determines the mean value per sample
within a sequence of measurements.

N/A

Time Peak Value

Used to detect the time elapsed until the
peak value is reached.

Smoothing Points

Peak Value Used to detect the highest value per sample Smoothing Points
within a sequence of measurements.
Table 6-2: Data Reduction Methods
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6.2.2. Configuring a Multiwavelength Quick Measurement

A multiwavelength Quick measurement performs up to eight absorbance
measurements for each well at different user-specified wavelengths.

= The number of measurements that can be performed in a
multiwavelength measurement depends on the number of filters
installed in the instrument.

To perform a multiwavelength Quick measurement:

1.  From the Reading menu, choose Quick.

on P

Choose Quick-Read. Quick-Read appears (Error! Reference
ource not found.).

I Quick-Read X
Load Flate Eject Plate
Format | Microplate j
Plate Type |STANDARD ]|
kMeazurement Pozsition Al [ Set Sample |

keazurerment Mode;

keazurement Filter

| Endpoint Photometnic

Start

450 |
Reference Filker | E20 j
'gﬁél'{'i'r{&: -

LCancel

Figure 6.6 Quick Read
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2. In Measurement Mode, select Multiwavelength. The
measurement parameters available for multiwavelength
measurements appear (Figure 6-6).

% Quick-Read

Load Plate Eject Plate

Farmat | Microplate j
Plate Type |STANDARD ]|
keazurement Position All ™ Set Sample |
Meazurernent bode: | Multivavelength j

Muriber of W avelengths m

teasurement Filker | 450 ﬂ
620 ]
340 -
-

Shaking [w Shake now |

Intensity  |Medium  * | Time 5 -

Start LCancel |

Figure 6-6: Quick-Read - Multiwavelength parameters

Choose the Number of Wavelengths to measure. A field for each
Measurement Filter appears.

= Up to eight measurements may be performed in a
multiwavelength measurement.

In Measurement Filter, select the desired wavelength for each
measurement.

= The measurement wavelengths available depend on the filters
installed in the instrument (refer to Section 3.2, Configuring the
Microplate Reader).

If desired, select Shaking to shake the microplate prior to the
Quick measurement. Quick-Read expands to display Shaking
parameters.

=> If shaking is not desired, go to step 8.

ADAP

ADAP Software Operating Manual 6-15



\

5. If Shaking is selected, select the Intensity of the shaking: Low,
Medium, or High.

6. If Shaking is selected, select the Time to shake in seconds.

= Choose Shake Now to immediately shake the plate for the
Intensity and Time specified.

7. Choose the Plate Type and Measurement Position following the steps in
Section 6.4, Configuring Microplate Type and Measurement
Positions.
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6.2.3.

Configuring an Area Scan Quick Measurement

Area scan Quick measurements perform absorbance or transmission
measurements at a number of points across each well. Area scans can
measure samples on 6-, 12-, 24-, 48-, and 96-well microplates, and are
performed at the maximum resolution allowed by the plate type.

= Area scan Quick measurements are available only with the Zenyth
340 microplate reader.

= To perform Quick measurements using a standalone instrument (for
example, the Zenyth 340s); place the instrument in Remote Control
mode. Refer to the instrument user’s manual for more information about
Remote Control mode.

To perform an area scan photometric measurement:

1. From the Reading menu, choose Quick.

ox P

Choose Quick-Read. Quick-Read appears (Figure 6-7).

B Quick-Read X

Load Flate Eject Plate

Faormat | Microplate ﬂ
Plate Type |STANDARD ]|
keazurement Positian Al [ Set Sample |

Measurement Mode: | Endpaint Photarmetric ﬂ

keasurement Filker |45EI j
Reference Filter |52EI j
Shaking -

Start LCancel |

Figure 6-7: Quick-Read
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In Measurement Mode, choose Scan Area. The measurement

parameters available for area scan measurements appear (Figure
6-8).

i Quick-Read

Load Flate Eject Flate

Format | Microplate j
Plate Type |STANDARD |
Meazurement Pazsitian All i~ Set Sample |

keasurement Mode;

Scan Area

keasure Transmizsion [
kMeazurement Filter | 450 ﬂ
Shaking [

Start Cancel |

Figure 6-8: Quick-Read - Scan Area parameters

If desired, select Measure Transmission to measure transmission
instead of optical density (OD).

In Measurement Filter, select the desired wavelength for the
measurement.

= The measurement wavelengths available depend on the filters
installed in the instrument (refer to Section 3.2, Configuring the
Microplate Reader).

If desired, select Shaking to shake the microplate prior to the
Quick measurement. Quick-Read expands to display Shaking
parameters.

=>» If shaking is not desired, go to step 8.

If Shaking is selected, select the Intensity of the shaking: Low,
Medium, or High.

If Shaking is selected, select the Time to shake in seconds.

= Choose Shake Now to immediately shake the plate for the
Intensity and Time specified.

ADAP
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8. Choose the Plate Type and Measurement Position following the steps in
Section 6.3, Configuring Microplate Type and Measurement
Positions.
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6.2.4.

\

Configuring a Linear Scan Quick Measurement

Linear scan Quick measurements perform transmission measurements
at 25 points along a linear axis crossing the center of each measured
well. Linear scans may be performed only on 96-well plates.

=>» Linear scan Quick measurements are available only with the Zenyth
340 microplate reader.

= To perform Quick measurements using a standalone instrument (for
example, the Zenyth 340s); place the instrument in Remote Control
mode. Refer to the instrument user’s manual for more information about
Remote Control mode.

To perform a linear scan photometric measurement:

1.  From the Reading menu, choose Quick.

ORb

Choose Quick-Read. Quick-Read appears (Figure 6-9).

= Quick-Read

Load Plate Eject Plate

Format | Microplate ﬂ
Flate Type |STANDARD ]|
keazurement Pozition All = Set Sample |

kMeasurement Mode:

Meazurement Filter

| E ndpoint Photometric

...................

Start

|450 |
Reference Filter | E20 ﬂ
Shaking I_

LCancel

Figure 6-9: Quick-Read

ADAP
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2.

In Measurement Mode, choose Scan Linear. The measurement
parameters available for linear scan measurements appear
(Figure 6-10).

= Quick-Read

Load Plate Eject Plate

Format | Microplate ﬂ
Plate Type |STANDARD -]
keazurement Position All v Set Sample |

keasurement bode;

Scan Linear

Measurement Filter | 450 j

Shaking [

Start Cancel |

Figure 6-10: Quick-Read - Scan Linear parameters

In Measurement Filter, select the desired wavelength for the
measurement.

= The measurement wavelengths available depend on the filters
installed in the instrument (refer to Section 3.2, Configuring the
Microplate Reader).

If desired, select Shaking to shake the microplate prior to the
Quick measurement. Quick-Read expands to display Shaking
parameters.

=>» If shaking is not desired, go to step 7.

If Shaking is selected, select the Intensity of the shaking: Low,
Medium, or High.

If Shaking is selected, select the Time to shake in seconds.

= Choose Shake Now to immediately shake the plate for the
Intensity and Time specified.

ADAP
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7. Choose the Plate Type and Measurement Position following the steps in
Section 6.3, Configuring Microplate Type and Measurement
Positions.

= Choose Info to view a summary of the parameter settings.

8. Choose the Plate Type and Measurement Position following the steps in
Section 6.3, Configuring Microplate Type and Measurement
Positions.
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6.3. Configuring Microplate Type and Measurement

Positions

After choosing and configuring a Quick measurement, the type of
microplate and which wells are measured must be selected. Both
parameters are configured in Quick-Read (Figure 6-11).

= Microplate is the only available plate Format for the Zenyth 340
microplate readers.

i Quick-Read

Load Plate Eject Plate

Farmat | ticroplate ﬂ
Plate Type |STANDARD |
Meazurement Pozition All [ Set Sample |

Measurement Mode:

teasurement Filter

| Endpoint Photormetric:

450 =
Reference Filter | =0 j
S T -

Start

Cancel |

Figure 6-11: Quick-Read - Plate Type and Measurement Position
To select and configure Plate Type and Measurement Position:
1. Select the Plate Type being used in the Quick measurement. In

Measurement Position, select All to perform measurements on all
wells on the plate.

= Deselecting All does not deselect all wells. The measurement
wells must be deselected manually in Set Sample.

OR

Choose Set Sample to specify the wells on the plate to measure.
Set Sample appears (Figure 6-12).
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3| MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS
4| MEAS = MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS
5| MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS
E| MEAS = MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS
7| MEAS = MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS

8| MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS | MEAS

Figure 6-12: Set Sample
2. In Type of Selection, select the type of processing to configure:

o Measurement Position — specifies the wells to measure. Click and
drag over the wells to measure to select them.

3. Select a command from the Edit menu or by right-clicking within
the selected area:

o Set/De-select all wells — selects/deselects all wells on the
microplate.

o Set/De-select actual row — selects/deselects all wells in the same
row as the initial well selected (Figure 6-12).

o Set/De-select actual column — selects/deselects all wells in the same
column as the initial well selected (Figure 6-12).

o Set/De-select selected well — selects/deselects wells selected by
dragging.

4. Repeat step 3 through step 5 to configure another type of
processing, if necessary.

5. Choose OK to close Set Sample.

= The Measurement Position layouts defined in Set Sample are saved
after a measurement is run.
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6.4. Running Quick Measurements and Saving
Measurement Results

After choosing the measurement type and configuring measurement and
microplate parameters, the Quick measurement may be run from Quick-
Read (Figure 6-13). Measurement results are saved immediately after
completing the Quick measurement.

& Quick-Read

Load Plate Eject Plate

Farmat | icroplate ﬂ
Plate Type |STANDARD ]
b eazurement Pozition Al ~ Set Sample |

Measurement Mode: | Endpaint Phatometric ﬂ

Measurement Filker | 450 j
Reference Filker | 20 j
haking ™
Start Cancel |

Figure 6-13: Quick-Read
To start a Quick measurement and save the measurement results:

1. If using the Zenyth 340 microplate reader, choose Eject Plate to
move the plate carrier outside the instrument. Place the microplate
to be measured on the plate carrier and choose Load Plate to
move the plate and plate carrier inside the instrument.

OR

If using the EZ Read 400, Anthos 2010/2020 microplate reader,
manually load the microplate into the instrument (refer to the
instrument user’s manual for more information about loading
microplates).
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2. Choose Start to begin reading the plate. When the measurement is
complete, Plate-ID appears (Figure 6-14).

= To stop a measurement in progress before it completes, choose
STOP Measurement.

OR

Choose Cancel to return to the ADAP software main screen without
performing the measurement.

Plate-ID

[nput Plate-D:

Ok

Figure 6-14: Plate-ID

3. In Input Plate-ID, rename the plate, if desired.

= The default format of Plate-ID names is YYYYMMDD-N, where
YYYY is the year, MM the month, DD the day and N the number of
the reading made that day.

4. Choose OK to save the measurement results to the database.

5. If using the Zenyth 340 absorbance detector, choose Eject Plate
to move the plate carrier outside the instrument. Remove the
measured microplate from the plate carrier and choose Load Plate
to move the plate carrier inside the instrument.
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/7. Viewing Quick Measurement
Results

7.1. Overview

After a Quick measurement is performed and saved, the measurement
results are displayed in a series of tabs in the ADAP software main
window. The tabs that are displayed vary depending on the type of
measurement performed and instrument capability.

= Refer to Chapter 6, Performing Quick Measurements for detailed
information about performing and saving Quick measurements.

All Quick measurement results are stored in the ADAP software database
and may be:

e Opened for viewing, printing, or exporting (refer to Section 7.2,
Viewing Saved Quick Measurement Results).

e Viewed in the ADAP software main window (refer to Section 7.3,
Viewing Quick Measurement Results).

e Printed as a hard copy or data file such as an Acrobat® PDF (refer to
Section 7.4, Printing Quick Measurement Results).

e Exported to another application such as a word processor or
spreadsheet (refer to Section 7.5, Exporting Quick Measurement
Results to Other Applications).
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7.2.

Viewing Saved Quick Measurement Results

7.2.1.

All Quick measurement results are saved in the ADAP software database
and may be opened for viewing, printing, and exporting (refer to Section
7.2.1, Opening Saved Quick Measurement Results).

Searching for saved measurement results by name is possible with
Matchcode, the search feature built into the ADAP software (refer to

Section 7.2.1.1, Using Matchcode to Search for Saved Measurement
Results).

Opening Saved Quick Measurement Results

All Quick measurement results are saved in the ADAP software database
and may be opened at any time.

To view saved measurement results:

1. From the Database menu, select Open Saved Plate. Selection
appears (Figure 7-1).

= Saved measurement results are listed in descending
chronological order by measurement date.

151 items

2 M 224-6
2010224-5
2010224-4
201012243
20mz224-2
20102241
2 M 2235
201 223-4
20102233
2 m223-2
2 m22341 .

fram: 09/05/2010 -
to: 09/01/2011 =

update ligt | Delete

|

b atchcode |
ok |
|

Cancel

Figure 7-1: Selection - saved Quick measurements
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7.2.1.1.

2. Select the measurement results to view. Only one plate may be
viewed at a time.

= To narrow the list by date, select dates in from and to, and
choose update list.

To search for a specific plate ID by characters in the Plate ID name,
choose Matchcode (refer to Section 7.2.1.1, Using Matchcode to
Search for Saved Measurement Results).

3. Choose OK to view the measurement results.

OR
Choose Cancel to close Selection without opening a saved plate
OR

Choose Delete to delete the selected measurement results from
the database.

Using Matchcode to Search for Saved Measurement Results

Matchcode is the search feature that appears in Selection. Depending on
from which screen or tab Selection is accessed, Matchcode performs
searches for saved measurement results or test definitions. Matchcode
provides wildcard operators, * and ?, which simplify searching by
allowing users to search for a set of possible characters in the filename
(see Table 7-1).

= A valid license code for the ADAP Plus or ADAP Expert software is
required to view test definitions located by Matchcode. Refer to Chapter
8, Defining and Running Tests for more information about test
definitions.

To search for measurement results by plate ID:

1. From Selection, choose Matchcode. Plate-ID appears (Figure 7-2).

Plate-ID

[nput Plate-1D:

20110511-1

Ok

Figure 7-2: Plate-ID
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2. In Input Plate-ID, enter a plate ID or test definition name.

Wildcard Pattern Result
*a* Lists all plate IDs or test definition names with
an a in the ID or name.
ax* Lists all plate IDs or test definition names with
an a at the beginning of the ID or name.
*a Lists all plate IDs or test definition names with
an a at the end of the ID or name.
alph? Lists all plate IDs or test definition names with
alph followed by an additional character. For
example, alpha or alphb.

Table 7-1: Matchcode wildcard operators

3. Choose OK. Plate IDs or test definition names that match the
search query appear in Selection.

=> If Matchcode finds no matches to the search query, choose update
list to display the entire list of plate IDs or test definitions again.

ADAP ADAP Software Operating Manual

7-4

\




7.2.2. How Measurement Results are Displayed

Measurement results for microplate samples are displayed in rows and
columns that correspond to the layout of wells on the plate; for
example, Figure 7-3 displays results for samples on a 96-well plate. To
easily identify specific samples, rows and columns use the same well
labels imprinted on the microplate.

¥ ADAP Software - [20110520-3 Quick Mode] M=1E3
-8 x

Database Reading Setup Help
] L it \ L
= tl-ilD': = Tb =IDQD%ZE$ —
b Al = ;‘ =] In.strumem
=| V| R [Simulstor - SNeOT000 =] ;
oD ] Statuz ]
1 2 3 4 5 g 7 8 g 10 1 12
A 1.53 2E13 0891 1.5 1.067 1.080 2330 3966 3776 1.553 2148 3953
? 1.670 3413 2.640 2177 2162 1.670 0.927 2818 0.067 3822 0.877 2.277
? 1.818 1.EE65 3633 0.433 2174 1.670 3523 30 3534 3554 2870 1.975
D 1.966 2E73 2709 1.529 2033 1.865 2435 2230 0983 0.352 3250 1.872
? 2058 1.349 3.909 0.923 2345 1.986 1.455 1.142 1.986 3178 0103 281
? 3269 3066 1.428 3.287 2248 3649 2953 1.423 2.083 2248 2285 1.732
? 3288 1.389 1.910 0.426 3744 0.799 3783 2464 3271 1.054 0.827 2.949
: 2850 2570 2471 3607 0.E14 1.538 1.355 0.8v3 3189 2425 2323 3.500

Figure 7-3: Measurement results for a 96-well microplate
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7.3. Viewing Quick Measurement Results

Quick measurement results are displayed in a series of tabs in the ADAP
software main window. The tabs displayed vary for each measurement

type:

Endpoint photometric — Displays OD (optical density) and Status for
absorbance measurements (refer to Section 7.3.1, Viewing Endpoint
Photometric Measurement Results).

Kinetic photometric — Displays Reduced Data, Status, Raw Data, and
Kinetic Graph (refer to Section 7.3.2, Viewing Kinetic Photometric
Measurement Results).

Multiwavelength — Displays Raw Data, Graphic, Status, and Curve Info
(refer to Section 7.3.3, Viewing Multiwavelength Photometric
Measurement Results).

Linear scan — Displays Raw Data Scan, Scan, Status, and Curve Info
(refer to Section 7.3.4, Viewing Linear Scan Measurement Results).

Area scan — Displays Raw Data, Scan, and Status (refer to Section
7.3.6, Viewing Area Scan Measurement Results).

ADAP
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7.3.1. Viewing Endpoint Photometric Measurement Results

Measurement results for endpoint photometric measurements are
displayed in two tabs:

e OD — in photometric measurement results, displays the optical
density measurement for each sample (refer to Section 7.3.1.1,
Viewing Optical Density (OD) Measurement Results).

e Status — Displays which samples were measured successfully and
which were not because of errors during measurement (refer to
Section 7.3.1.2, Viewing Sample Status).
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7.3.1.1. Viewing Optical Density (OD) Measurement Results

OD displays the optical density measurement for each sample (Figure
7-4). For bichromatic measurements, OD is calculated by subtracting
measurements made with the reference filter from the measurements
made with the primary filter.

= Refer to Section 7.4.1, Printing General Measurement Results for
information about printing OD measurement results.

B ADAP Software - [20110511-3 Quick Mode] =
Database Reading Setup Help B |:|" X
1 -
== Al . 3
Al=|~a Instrument
b =| V | & [Simdlator - SNr0T000 |
ao l Status ]
1T [ 2 | s [« | s [ s | 7 ] 8 | 3 | w ] nn ] 12

A| 0776 | 189m0 | 2678 | 232 | 3778 2826 | 3682 | 1709 | 0067 | 2999 | 0211 | 0490
6| oo 1as  aws 2no 3w nsm 52 | 2sm | 2135 08% | 219 0040
o] e vew  aess  omz | 12m 2ese | izl ass  i7ss | am1 | 128 297
0| a4 oms | tsn asw | 253 aose | azss | asio 047 | 348 | 213 07
| a0 oo ism 2 a7 tses 0w | oss | 2em | amd | 3M7 | 15@
£ o1ss | toer | ams | e | 1S | 0781 | 249 | 3435 | 33 | 4% | 131 | 309
6| sss 01w 2wy 2ms | 2om ams | asms | a0 im0 23 | o 200
| csm | sws  asn tss | 11m 2o 24 2sis 130 0sn | 2614 230

Figure 7-4: Measurement Results - OD
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7.3.1.2. Viewing Sample Status

Status displays which samples were measured successfully and which
were not because of errors during the measurement (Figure 7-5):

e OK — The well was measured successfully.
e Error — The well was not measured because an error occurred.

e Calc Error — the well was not measured because an error occurred;
for example, division by zero in a transformation formula.

e Overflow — a measurement could not be made because the optical
density (OD) was above the indication limit.

e Underflow — a measurement could not be made because reduced
data could not be calculated.

e Notused — the well was not selected to be measured in the plate
layout.

=> Calc Error and Not Used appear only in measurement results from tests
run in the ADAP Plus or ADAP Expert software.

= Refer to Section 7.4.1, Printing General Measurement Results for
information about printing Status results.

B ADAP Software - [2010linearityplate45 Quick Mode]

Database Reading Setup Help - |5 x
1
== -
Al=| Instrument

b ﬁ = | V | & [Zenyth - SeO1351 =

l Fiaw Data ] Kinetic Graph ]

1 ] 2 ] s [ 4 [ s | e [ 7 ] 8 ] s ] w [ 1] 2
& 0K 0K 0K 0K 0K 0K 0K 0K 0K 0K 0K 0K
? ok ok ok ok ok ok ok ok ok ok ok ok
? ok ok ok ok ok ok ok ok ok ok ok ok
F ok ok ok ok ok ok ok ok ok ok ok ok
? ok ok ok ok ok ok ok ok ok ok ok ok
? ok ok ok ok ok ok ok ok ok ok ok ok
? ok ok ok ok ok ok ok ok ok ok ok ok
: ok ok ok ok ok ok ok ok ok ok ok ok

Figure 7-5: Measurement results - Status
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7.3.2. Viewing Kinetic Photometric Measurement Results

Results for kinetic photometric Quick measurements are displayed in
four tabs:

e Reduced Data — Displays the results for each sample calculated using
the data reduction method configured for the Quick measurement
(refer to Section 7.3.2.1, Viewing Kinetic Measurement Reduced
Data).

e Status — Displays which samples were measured successfully and
which were not because of errors during measurement (refer to
Section 7.3.1.2, Viewing Sample Status).

e Raw Data — Displays measurement results for each cycle performed
in the measurement (refer to Section 7.3.2.2, Viewing Kinetic
Measurement Raw Data).

e Kinetic Graph — Displays a graph of the kinetic measurement results
for each sample (refer to Section 7.3.2.4, Viewing the Kinetic Graph
for an Individual Sample).
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7.3.2.1. Viewing Kinetic Measurement Reduced Data

Reduced Data displays the results for each sample calculated using the
data reduction method configured in the Quick measurement (Error!
eference source not found.). The actual tab name changes to reflect
what type of results have been calculated. For example, most Slope
reduction methods display OD/min; while Time reduction methods
display t(sec) (refer to Section 6.2.1.1, Data Reduction Methods).

=>When no data reduction method is configured in the Quick
measurement, the tab is labeled N/A and no data is displayed in the tab.

= Refer to Section 7.4.1, Printing General Measurement Results for
information about printing Reduced Data measurement results.
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7.3.2.2. Viewing Kinetic Measurement Raw Data

Raw Data displays measurement results for each cycle of a photometric
kinetic measurement (Figure 7-6). The cycle currently displayed and
number of cycles in the measurement are shown to the right of Next
Cycle.

To view results from a different cycle:

Choose Previous Cycle to view the measurement results from the
preceding cycle.

OR
Choose Next Cycle to display results from the following cycle.

To print Raw Data for all cycles:

Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data
and Curve Info).

B ADAP Software - [2010linearityplate45 Quick Mode] =1Ed
Database Reading Setup Help - |5 x

1

ey t; E{,DE — -
Al =" Instrument
b E =| V| [Zerwth - SN:D1351 B3|
Status KineticGraph]
< Previous Cycle ‘ Mext Cycle > | Cycle1 /10 Frint B aw Data
1 [ 2 ] s ] ¢ 1 s T e T 7 | & ] a ] 1o ] 1] 12

Al 0208 0328 0443 0.563 0.ea nan 0933 1.043 1.183 1.288 1.403 1.529
E 0202 0325 0446 0.567 0688 0808 D.S 1.047 1.166 1.286 1.406 1.527

C| 02zm 0.324 0444 0.565 0687 0.807 0528 1.046 1166 1.285 1.404 1.525
F 0199 0322 0443 0.565 0.685 0.805 0.926 1.046 1166 1.284 1.403 1526
? 1.294 1472 1.653 1.838 2.020 2.208 2389 2574 2754 2942 3119 3318
T 1.293 1.475 1.653 1.843 2.026 2212 2393 2579 2757 2935 30933 338
F 1.288 1.480 1.664 1.881 2035 2220 2402 251 2780 2340 212k 334
n

1.303 1.485 1671 1.858 2042 2223 2.407 2583 2773 2947 3137 3314

Figure 7-6: Measurement Results - kinetic measurement raw data
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7.3.2.3. Viewing Kinetic Measurement Graphs

Kinetic Graph displays graphs of the kinetic measurement results for all
samples. The time or cycle number is plotted on the x-axis; Raw Data is
plotted on the y-axis. The resulting graph shows how the measurement
value varied over time.

To change the Kinetic Graph view:

e Use the scroll bars to view graphs for all samples, if necessary.

e Click on a well to view a detailed graph of the individual sample
(refer to Section 7.3.4.2, Viewing the Kinetic Graph for an Individual
Sample).

To print Kinetic Graph:

Choose Print Graph to print the graphs for all samples measured
on a single page (refer to Section 7.4.3, Printing Graphs).

B ADAP Software - [2010linearityplate45 Quick Mode] M [=1ET

Database Reading Setup Help - |8 %

== -
= | sy Instrurnent
b @ AV e [Zergh - SNrO1351 ~]

Status | RamData Kinelic Graph |

Measurement time:

Scale'; 3.400 Print Graph
10410

Cycle:

Figure 7-7: Measurement results - Kinetic Graph
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7.3.2.4. Viewing the Kinetic Graph for an Individual Sample
Kinetic Graphs for individual samples can be viewed in detail. Positioning
the cursor over any point on the curve displays the x and y coordinate
values of that position in the upper right corner of the tab.

To display the Kinetic Graph for a single sample:

In Kinetic Graph, click on the desired well to view. Kinetic Graph
displays the detailed kinetic graph for the selected sample (

Figure 7-8).
To return to the main Kinetic Graph view:

OR Click on the detailed kinetic graph. Kinetic Graph displays kinetic
graphs for all samples (Figure 7-7).

=> Print Graph prints kinetic measurement graphs for all measured
samples, not the individual sample being viewed in detail (refer to
Section 7.4.3, Printing Graphs).
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Figure 7-8: Kinetic graph for a single sample
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7.3.3. Viewing Multiwavelength Photometric Measurement
Results

Results for multiwavelength photometric Quick measurements are
displayed in four tabs:

e Raw Data — Displays measurement results for each wavelength
chosen in the Quick measurement (refer to Section 7.3.3.1, Viewing
Multiwavelength Measurement Raw Data).

e Graphic — Displays a graph of multiwavelength measurement results
for each sample (refer to Section 7.3.3.2, Viewing Multiwavelength
Measurement Graphs).

e Status — Displays which samples were measured successfully and
which were not because of errors during measurement (refer to
Section 7.3.1.2, Viewing Sample Status).

e Curve Info — Displays optical density and percentage transmission
values for a single sample at each wavelength measured. In the
ADAP Plus and ADAP Expert software, more detailed information
about the curve, including peak and valley data, is also displayed
(refer to Section 7.3.3.4, Viewing Multiwavelength Measurement
Curve Info).
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7.3.3.1. Viewing Multiwavelength Measurement Raw Data

Raw Data displays the optical density (OD) for each sample at each
wavelength measured (Figure 7-9). Results for each measured
wavelength are displayed separately. The wavelength currently being
displayed is indicated near the center of the tab.

To view results from a different measurement wavelength:

Choose Previous Filter to view the results from the previous
measured wavelength.

OR

Choose Next Filter to display results from the next measured
wavelength.

To print Raw Data measurement results for all wavelengths:

Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data
and Curve Info).

B ADAP Software - [20110511-1 Quick Mode] =13
Database Reading Setup Help - | &%
= E; EiID= = -4
Al=| Instrument
b =| V | & [Simulator - SNEOT000 =

Graphic] Status ] Eurvelnfo]

<- Previous Filker | Mext Filter -» | Wavelength 3401 / 4] Frint Raw Data

1 ] 2 ] s ] 4 ] s | e | 7] 8 ] 8 ] 1w [ n 12

0.496 36N 1.656 1.368 2629 1.852 0526 0915 AR 2538 0.904 0710

0.243 1.413 2675 2234 2541 3767 2348 374 2563 0132 1616 2073

1.643 0621 3063 2444 2681 134 3733 1.930 2.262 0.235 3725 0622

3054 2329 0961 1181 1.702 20028 1.246 775 330 1622 273 0873

3758 0.0z22 3925 1.780 2583 1.830 2365 1118 0225 3.030 1.073 3947

1.085 1.707 1.963 2130 2918 2411 3130 2538 2570 3760 3736 2110

2182 0.0g2 0.541 1.143 2002 3547 0136 3576 a7 2.055 0.361 2677

I|m|-n|rn|D|l—J|m|I>-

3841 2582 1.943 0133 1.082 3534 2.462 ama 2.805 210 1173 0033

Figure 7-9: Measurement results — multiwavelength Raw Data
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7.3.3.2. Viewing Multiwavelength Measurement Graphs

Graphic displays graphs of multiwavelength measurement results for all
samples (Figure 7-10). The measurement wavelength is plotted on the
x-axis; the OD or transmission values are plotted on the y-axis.

To change the Graphic view:

e Use the scroll bars to view graphs for all samples, if necessary.
e Click on a sample. Choose an option from the menu that appears:

e Curve Info — Displays the Curve Info tab (refer to Section 7.3.3.4,
Viewing Multiwavelength Measurement Curve Info)

e Zoom Graph — Displays a detailed graph of the results for the
selected sample (refer to Section 7.3.3.3, Viewing the
Multiwavelength Graph for an Individual Sample).

e Show Graph — Displays the Graph window where curves for all
samples can be studied in greater detail with additional viewing
and calculation options (refer to Section 7.3.5, Viewing and
Performing Calculations on Curves in the Graph Window).

=> Show Graph is only available with a valid ADAP Plus or ADAP
Expert license code.
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To print Graphic:

Choose Print Graph to print the graphs for all samples measured
(refer to Section 7.4.3, Printing Graphs).
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Figure 7-10: Measurement results — multiwavelength Graphic
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7.3.3.3. Viewing the Multiwavelength Graph for an Individual

Sample

The multiwavelength Graphic for an individual sample can be viewed in

detail. Positioning the cursor over any point on the curve displays the x

and y coordinate values of that position in the upper right corner of the

tab.

To display the multiwavelength Graphic for a single sample:

1. In Graphic, click on the desired well to view.

2. Choose Zoom Graph from the menu that appears. Graphic displays
the detailed multiwavelength graph for the selected sample (Figure
7-11).

To return to the main multiwavelength Graphic view:

Click on the detailed multiwavelength graph. Graphic displays
multiwavelength graphs for all samples (Figure 7-10).

=> Print Graph prints multiwavelength graphs for all measured samples,
not the individual sample being viewed in detail (refer to Section 7.4.3,
Printing Graphs).
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Figure 7-11: Multiwavelength Graphic for a single sample
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7.3.3.4.

Viewing Multiwavelength Measurement Curve Info

Curve Info displays the OD and transmission values at each wavelength
measured for a single sample (Error! Reference source not found.).
he ADAP Plus and ADAP Expert software display more detailed
information about the curve, including values of peaks, valleys, and
average slope.

To view Curve Info for a different sample:

Choose Previous Sample to view Curve Info for the previous
sample.

OR
Choose Next Sample to view Curve Info for the next sample.

To print Curve Info measurement results for all samples:

Choose Print.

To print Curve Info tables for the displayed sample:

Right click in a Curve Info table and choose the desired printing
option (refer to Section 7.4.2.1, Printing Curve Info Data Tables).
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7.3.4. Viewing Linear Scan Measurement Results
Results for linear scan Quick measurements are displayed in four tabs:

e Raw Data Scan — Displays values from the 25 measurement points
across center of each well (refer to Section 7.3.4.1, Viewing Linear
Scan Measurement Raw Data).

e Scan — Displays graphs of the linear transmission profiles for all
wells measured (refer to Section 7.3.4.2, Viewing Linear Scan
Graphs).

e Status — Displays which samples were measured successfully and
which were not because of errors during measurement (refer to
Section 7.3.1.2, Viewing Sample Status).

e Curve Info — Displays the transmission values for a single sample at
all 25 measurement points. In the ADAP Plus and ADAP Expert
software, more detailed information about the curve, including peak
and valley data, is also displayed (refer to Section 7.3.4.4, Viewing
Linear Scan Curve Info).

ADAP ADAP Software Operating Manual 7-22



7.3.4.1. Viewing Linear Scan Measurement Raw Data

Raw Data Scan displays values from the 25 measurement points across
the center of each well (Figure 7-12).

= Raw data values displayed are percentage transmission values, not
absorbency. For example, 0.000 refers to no transmission of light, which
in terms of OD is overflow. 100.000 refer to 100% transmission, which
is 0 OD. 10.000 equal 10% transmission, which is 1 OD.

The currently displayed measurement point and total humber of
measurement points are shown to the right of Next Cycle.

To view results from a different measurement point:

Choose Previous Cycle to view the measurement results from the
previous measurement point.

OR

Choose Next Cycle to display results from the next measurement
point.

To print Raw Data Scan measurement results for all cycles:

Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data
and Curve Info).
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Figure 7-12: Raw Data tab for a Linear Scan Measurement
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7.3.4.2. Viewing Linear Scan Graphs

Scan displays graphs of the linear transmission profile for all wells on the
plate (Figure 7-13). A linear transmission graph displays the
transmission measured at 25 points across the center of the well. The y-
axis refers to transmission percentage; the x-axis refers to
measurement positions.

= Data in the graphs are percentage transmission values, not
absorbency. For example, 0.000 refers to no transmission of light, which
in terms of OD is overflow. 100.000 refer to 100% transmission, which
is 0 OD. 10.000 equals 10% transmission, which is 1 OD.
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Figure 7-13: Measurement results - linear scan graphs
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To change the Scan view:

e Use the scroll bars to view graphs for all samples, if necessary.
e Click on a sample. Choose an option from the menu that appears:

e Curve Info — Displays the Curve Info tab (refer to Section 7.3.4.4,
Viewing Linear Scan Curve Info).

e Zoom Graph — Displays a detailed graph of the results for the
selected sample (refer to Section 7.3.4.3, Viewing the Linear
Scan Graph for Individual Wells).

e Show Graph — Displays the Graph window where curves for all
samples can be studied in greater detail with additional viewing
and calculation options (refer to Section 7.3.5, Viewing and
Performing Calculations on Curves in the Graph Window).

=>» Show Graph is only available only with a valid ADAP Plus or ADAP
Expert license code.

To print Scan:

Choose Print Graph to print the graphs for all wells measured
(refer to Section 7.4.3, Printing Graphs).
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7.3.4.3. Viewing the Linear Scan Graph for Individual Wells
Linear scan graphs for individual wells can be viewed in detail.
To display the linear scan graph for an individual well:
1. In Scan, click on the desired well to view.

2. Choose Zoom Graph from the menu that appears. Scan displays the
detailed linear scan graph for the selected well (Figure 7-14).

To return the main Scan view:

Click on the detailed linear scan graph. Scan displays linear scan
graphs for all wells (Figure 7-13).

=> Print Graph prints linear scan graphs for all measured wells, not

the individual well being viewed in detail (refer to Section 7.4.3,
Printing Graphs).
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Figure 7-14: Linear scan graph for a single well
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7.3.4.4. Viewing Linear Scan Curve Info

Curve Info displays the transmission values at all 25 measurement points
for a single sample (Error! Reference source not found.). The ADAP
and Plus ADAP Expert software display more detailed information about
the curve, including values of peaks, valleys, and average slope.

To view Curve Info for a different well:

Choose Previous Sample to view Curve Info for the previous
sample.

OR
Choose Next Sample to view Curve Info for the next sample.

To print Curve Info measurement results for all samples:

Choose Print.

To print Curve Info tables for the displayed sample:

Right click in a Curve Info table and choose the desired printing
option (refer to Section 7.4.2.1, Printing Curve Info Data Tables).
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7.3.5. Viewing and Performing Calculations on Curves in the
Graph Window

In the ADAP Plus and ADAP Expert software, Graph provides options to
view, compare, and perform curve fitting on graphs for multiwavelength
and linear measurement results. Graphs for all samples measured are

displayed simultaneously and color coded for differentiation (Figure
7-15).

= Graph is available only with a valid ADAP Plus or Expert software
license.

File Edit Options

Select Line: |i el 1.1 ﬂ

Actual Values: 30070000 Curvealue: 86230 Area under Curve: 0.000

100

Figure 7-15: Graph

To open Graph:

From the Graph tab in multiwavelength measurement results or the
Scan tab in linear scan measurement results, click on a sample
graph and choose Show Graph from the menu that appears.

To close Graph:
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From the File menu, choose End.

= To save smoothed curves before closing Graph, from the File
menu, choose Save Calc Container (refer to Section 7.3.5.4.2,
Saving Smoothed Curves).

= To clear Graph, from the Options menu, choose Clear Graph.

Graph provides the ability to:

e View individual curves (refer to Section 7.3.5.1, Viewing Individual
Curves).

e View the properties of individual curves in text form (refer to Section
7.3.5.2, Viewing the Properties of an Individual Curve).

e Change the graph view by zooming in on specific areas of Graph
(refer to Section 7.3.5.3, Changing the Graph View by Zooming).

e Smooth curves using curve fitting methods (refer to Section 7.3.5.4,
Using Curve Fitting Methods to Smooth Curves).

e Calculate the area under curves (refer to Section 7.3.5.4.4,
Calculating the Area under Curves).

e Copy Graph as a bitmap image that can be pasted into other software
applications (refer to Section 7.3.5.5, Copying the Contents of
Graph).

e Print the contents of Graph (refer to Section 7.3.5.6, Printing the
Contents of Graph).
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7.3.5.1. Viewing Individual Curves

When Graph is opened, curves for all samples measured are displayed.
Individual curves can be selected and viewed.

To view an individual curve:
1. From the Options menu, select Draw Single Line.

2. In Select Line, choose the individual curve to view. Graph displays
only the chosen curve (Figure 7-16).

File Edit Options

SelectLine: | IO ~|
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Figure 7-16: Graph displaying an individual curve

= To view the X and Y values for a point on the curve, position the
cursor over the desired point. Actual Values displays the X and Y values
at that position.

Curve Value displays the OD or transmission value at the curve peak or
valley nearest to the current cursor position.

Area under Curve displays the calculated value for the area under a curve
(refer to Section 7.3.5.4.4, Calculating the Area under Curves).
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To display all curves after viewing an individual curve:

From the Options menu, choose Restore Graph 1:1. Graph displays
all curves in the measurement results.

=> Draw Single Line remains enabled until it is toggled off by
selecting it again. When enabled, each time a curve is chosen in
Select Line, Graph displays the chosen curve individually.
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7.3.5.2.

Viewing the Properties of an Individual Curve

Detailed information about curve properties, including OD and
transmission values, curve peak and valley values, and average slope,
may be viewed in text form for any curve displayed in Graph. Curve
properties may also be:

e Copied to other applications (refer to Section 7.3.5.2.1, Copying
Curve Properties to Other Applications).

e Saved as text files (refer to Section 7.3.5.2.2, Saving Curve
Properties as Text Files).

e Printed (refer to Section 7.3.5.2.3, Printing Curve Properties).

To view curve properties:
1. In Select Line, choose the desired curve.

2. From the File menu, choose Curve Properties. Information
appears (Figure 7-17).

= [nformation

File

HPS
Type Walue at
Peak 89.490 8.00
Peak 55.620 14.00
Peak 87.750 20.00
Peak High 89.430 8.00
Peak Low 55.620 14.00
Peak Mean 77.620
Peak Count 3.000
Walley 77.720
Yalley 54.710 13.00
W alley 54.460 15.00
Yalley High 77720
W alley Low 54.460 15.00
Walley Mean B2 297
Walley Count 3.000
MaxSlope Increment 71.760 18.00
MaxSlope Decrement T4.480 11.00
Average Slope -0.559
Y alue Min 54.460 15.00
W alue M ax 89.490 8.00
Walue Mean 77344
W alue Area =0 15933.600
Walue Area Start to End Y 87.210
Faoint oo Transmission
a 0103 7772
1 0.077 8374
2 0.068 85.57
3 0.063 86.43
4 0.060 87.04
c A'ncn AT cT

Figure 7-17: Information - curve properties

To close Information:

From the File menu, choose End.

ADAP
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7.3.5.2.1. Copying Curve Properties to Other Applications
Curve properties displayed in Information can be copied to the
clipboard. The properties can then be pasted into another application for
storage or further analysis.

To copy curve properties:

1.  From the File menu, choose Copy.

2. Open or switch to the application where the curve properties will be
pasted.

3. Paste the curve properties into a new or existing file using the
Paste command for the application.

\

= Most applications have CTRL+V assigned as the Paste command
keyboard shortcut.

7.3.5.2.2. Saving Curve Properties as Text Files

Curve properties displayed in Information can be saved as text files
which can be viewed in any text editor or imported into many statistical
software packages or spreadsheet applications.

To save curve properties as a text file:

1. From the File menu, choose Save. Save As appears.

2. Browse to the desired location to save the text file.

3. Enter a File name for the text file.

4. Choose Save to save the file

OR

Choose Cancel to return to the ADAP software without saving the
curve properties as a text file.

7.3.5.2.3. Printing Curve Properties

Curve properties displayed in Information can be printed. Printing may
output hard copies or files; for example, Acrobat® PDF documents.

To print curve properties:

1. In the File menu, choose Print. Print appears.

ADAP
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2. In Printer, select the desired printer to print the information. All

printers that are properly installed and configured on the computer
are listed.

3. In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

4. Choose OK to print curve properties.

=> If the selected printer is configured to print to a file, such as an
Acrobat PDF (*.pdf), a prompt asking for the filename appears. The
printed file is saved to the ADAP software home directory.
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7.3.5.3.

Changing the Graph View by Zooming
Graph provides two methods of zooming to change the graph view:

e Zooming in and out by fixed percentages (refer to Section 7.3.5.3.1,
Zooming by Fixed Percentages).

e Zooming in by dragging over the desired region (refer to Section
7.3.5.3.2, Zooming by Dragging Over the Desired Region).

7.3.5.3.1. Zooming by Fixed Percentages

The graph view may be changed by zooming in and out at fixed
increments between 50% and 200%.

= The ability to zoom in or out is disabled when the option the option to
calculate the area under a curve is enabled (refer to Section 7.3.5.4.4,
Calculating the Area under Curves).

To zoom in or out:

From the Options menu, choose Zoom, and then the desired fixed
percentage to zoom.

= When zoomed in, use the scroll bars to access regions of the graph
view not visible.

To reset the original graph view:

From the Options menu, choose Zoom>100%.
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7.3.5.3.2. Zooming by Dragging Over the Desired Region

Zooming in on a section of the graph view may be accomplished by
dragging over the desired region to enlarge.

= The ability to zoom by dragging is disabled when the option to
calculate the area under a curve is enabled (refer to Section 7.3.5.4.4,
Calculating the Area under Curves).

To zoom in by dragging:

1. Position the cursor at the desired starting position for the selection,
then depress and hold the mouse button down.

2. Drag the mouse until the desired region is selected (Error!
eference source not found.). The selected region is highlighted
in blue.

3. Release the mouse button. Graph displays a zoomed view of the
selected region.

\

= When zoomed in by selection, regions of the graph not visible are not
accessible. To view regions not included in the zoom selection, choose
Restore Graph 1:1 to reset the graph view to 100%.

To reset the original graph view:

From the Options menu, choose Restore Graph 1:1.
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7.3.5.4.

Using Curve Fitting Methods to Smooth Curves

Curves can be smoothed using one of the five curve fitting methods
available in the ADAP software.

Smoothed curves may also be:

e Deleted (refer to Section 7.3.5.4.1, Deleting Smoothed Curves).
e Saved (refer to Section 7.3.5.4.2, Saving Smoothed Curves).

e Opened (refer to Section 7.3.5.4.3, Opening Saved Smoothed
Curves).

To apply a curve fitting method to a curve:

1. In Select Line, choose the curve to smooth.

\

=> If desired, the curve to smooth can be viewed individually (refer
to Section 7.3.5.1, Viewing Individual Curves).

2. From the Edit menu, choose the curve fitting method to apply:

¢ Smooth Curve Linear — Curve is smoothed by a linear
regression calculation.

e Smooth Curve Mean — Curve is smoothed using mean values.

¢ Smooth Curve Cubic Spline Low — Curve is smoothed by a
cubic spline calculation.

= Choose this option when the deviation of measurement points is
low.

¢ Smooth Curve Cubic Spline Medium — Curve is smoothed by
a cubic spline calculation.

= Choose this option when the deviation of measurement points is
medium.

e Smooth Curve Cubic Spline High — Curve is smoothed by a
cubic spline calculation.

= Choose this option when the deviation of measurement points is
high.

= Refer to Section 8.2.3.2.1, Curve Fitting Models for more information
about each type of curve fitting model.

The smoothed curve is calculated and displayed with the original curve.
In Select Line, smoothed curves are labeled using the format curve fitting
method (original curve label); for example Mean (Well 1.1).
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3. To smooth additional curves, repeat steps 1 and 2 above.
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7.3.5.4.1. Deleting Smoothed Curves

Smoothed curves displayed in Graph can be deleted. Deleting a
smoothed curve removes it from the graph view, but does not delete
smoothed curve data saved in Calc Container files.

To delete smoothed curves:

From the Edit menu, choose Delete Calc Container. Smoothed
curves are removed from the graph view.

7.3.5.4.2. Saving Smoothed Curves

Smoothed curve data can be saved for further evaluation. Smoothed
curves are stored in a Calc Container, a text file that may be opened by
most word processors, spreadsheets, and database applications.

To save a Calc Container:

1. From the File menu, choose Save Calc Container. Save As
appears.

2. Browse to the desired location to save the text file.
3. Enter a File name for the file.
4. In Save as type, select the type of file to save:
e TXT — Saves the smoothed curve data in a text file that can be

opened by many word processing, spreadsheet, and database
applications.

¢ XML — Saves the smoothed curve data in an XML file. XML is a
format designed for sharing information over the Web.

\

= The DWR file type is also available. DWR Calc Containers are
designed to save test definition data, and should not be used to
save smoothed curves.

5. Choose Save to save the file.

OR

Choose Cancel to return to the ADAP software without saving the
Calc Container.

7.3.5.4.3. Opening Saved Smoothed Curves

Saved Calc Containers with smoothed curve data can be opened and
viewed in Graph.

To open a Calc Container:

ADAP
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1. From the File menu, choose Open. Open appears .

2. Browse to and select the Calc Container file to open.

= If necessary, select the File of type that stores the Calc
Container data: Result Container TXT (*.txt) or Result
Container XML (*.xml). Only files of the selected type are
displayed in Open.

3. Choose Open to open the Calc Container.

OR

Choose Cancel to close Open without opening a Calc Container.
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7.3.5.4.4. Calculating the Area under Curves

The area under a curve can be calculated. The actual area calculated can
be modified by dragging the start and/or endpoint of the straight line
that indicates the bottom border of the area calculated.

= The ability to calculate the area under a curve is disabled when the
graph view is zoomed in or out (refer to Section 7.3.5.3, Changing the
Graph View by Zooming).

To calculate the area under a curve:

1.

In Select Line, choose the desired curve.

=> If desired, select an individual curve to view in Graph (refer to
Section 7.3.5.1, Viewing Individual Curves).

From the Options menu, choose Calculate Area under Curve. A
blue straight line with endpoints appears (Figure 7-18). The
calculated area under the curve is displayed in Actual Values.

File Edit Options

SelectLine: |10 well 1.2 =l
ActualValues:  13.00 /5462 Curve Value: 54.710 Area under Curve: 220.570
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Figure 7-18: Graph - calculating the area under a curve

To move the endpoints of the straight line and recalculate the area
under a curve:

Click on an endpoint and drag it to a new location on the curve.
The area under the curve is automatically recalculated based on the
new position of the straight line.

To turn off Calculate Area under Curve:

From the Options menu, deselect Calculate Area under Curve.

ADAP
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7.3.5.5.

\

Copying the Contents of Graph

The contents of Graph can be copied as a bitmap image that can be
pasted into other software applications such as word processors.

To copy the contents of Graph to another software application:

1.  From the Edit menu, choose Copy. The contents of Graph are
copied to the clipboard as a bitmap image.

2. Open or switch to the application where the bitmap image will be
pasted.

3. Paste the bitmap image into a new or existing file using the Paste
command for the application.

= Most applications have CTRL+V assigned as the Paste command
keyboard shortcut.

ADAP
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7.3.5.6. Printing the Contents of Graph

Graph may be printed. Printing may create either hard copies or files,
such as Acrobat PDF documents.

To print Graph:

1. In the File menu, choose Print.

2. In Printer, select the desired printer to print the information. All
printers that are properly installed and configured on the computer

are listed.

3. In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

4. Choose OK to print Graph.

= If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The
printed file is saved to the ADAP software home directory.
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7.3.6. Viewing Area Scan Measurement Results
Results for area scan Quick measurements are displayed in three tabs:

e Raw Data Scan — Displays values from all measurement points across
the well (refer to Section 7.3.6.1, Viewing Area Scan Measurement
Raw Data).

e Scan — Displays graphs of the area scan transmission profiles for all
wells measured (refer to Section 7.3.6.2, Viewing Area Scan
Transmission Profiles).

e Status — Displays which samples were measured successfully and
which were not because of errors during measurement (refer to
Section 7.3.1.2, Viewing Sample Status).
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7.3.6.1. Viewing Area Scan Measurement Raw Data

For area scan measurements, Raw Data displays results for measurement
points one well at a time (Figure 7-19). Results are displayed in a matrix
that corresponds to the layout of the measurement points for each well.

= Raw data values displayed are percentage transmission values, not
absorbency. For example, 0.000 refers to no transmission of light, which
in terms of OD is overflow. 100.000 refers to 100% transmission, which
is 0 OD. 10.000 equals 10% transmission, which is 1 OD.

To view results from a different well:

Choose Previous Well to view the measurement results from the
preceding well.

OR
Choose Next Well to display results from the following well.

To print Raw Data measurement results for all wells:

Choose Print Raw Data (refer to Section 7.4.2, Printing Raw Data
and Curve Info).

B ADAP Software - [20110512-2 Quick Mode] =13
- 8 x

Database Reading Setup Help

[ E; E{IDE [—| E b J—
b E = 3 :_; ||zneSr::1mem- SNEO1351 |

‘ Meazurement in progress. ..

STOP Measurement

Raw D ata Scan lscan ] Statuz ]

<- Previous Well ¢ Mest well -» | whell A1 Prirt Faw Data
1 2 3 | 4 5| B | 7 | B

1 0.702 0.674 0509 04839 0.482 0837 0.851 0.643
? 0.624 0.342 0108 0.073 n.o7z 0124 0.409 0.826
? 0.418 0112 0.062 0.056 0.085 0.061 0158 0.E06
T 0.342 0.076 0.056 0162 0.114 0052 0.078 0.436
? 0.329 0.074 0.068 0.283 0.241 0.050 0.088 0.523
? 0.449 0125 0.068 017z 0.160 0.055 0152 0.625
T 0.E678 0.351 0127 0.073 0.070 0161 0503 0.839
: 0.532 0.782 0.549 0.437 0.436 0628 093 0.707

Figure 7-19: Raw Data for an area scan measurement of Well A1
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7.3.6.2. Viewing Area Scan Transmission Profiles

For area scan measurements, Scan displays three-dimensional
transmission profiles for all measured wells on the plate (Figure 7-20).
The values presented are a percentage of transmission. Two yellow lines

indicate 0% and 100% transmission (Error! Reference source not
found.).

= Data presented in the profiles are percentage transmission values,
not absorbency. For example, 0.000 refers to no transmission of light,
which in terms of OD is overflow. 100.000 refers to 100% transmission,
which is 0 OD. 10.000 equals 10% transmission, which is 1 OD.

B ADAP Software - [20110512-2 Quick Mode] =13
Database Reading Setup Help - 8%
H r_lLD& —_ KE D -
b [ = | g Instrument —
¢ 2| V| [Zenyth - shreOT3ET | o
Raw Data Soan  Soan lStatus ]
3d iew j

| Refresh Graph Frint Graph
i R

Figure 7-20: Measurement results — area scan transmission profiles
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To print area scan transmission profiles:

Choose Print Graph to print the profiles for all wells measured
(refer to Section 7.4.3, Printing Graphs).

To change the absorbance profile view:

e Use the main scroll bars to view the graphs for all wells on the plate,
if necessary.

e Use the 3d View scroll bars in the upper left of the Scan tab to
change the angle for all wells on the plate (refer to Section 7.4,
Printing Quick Measurement Results).

e Click on an individual well to view a detailed three-dimensional
rendering of the transmission profile that can be rotated, zoomed,
and viewed with different colors and textures applied (refer to
Section 7.3.6.4, Viewing the Transmission Profile of a Single Well).

= The ADAP Expert software is required to view transmission
profiles of single wells.

Changing the Viewing Angle for All Wells

The 3d View controls in the upper left of Scan allow the transmission
profiles for all wells to be viewed from different angles.

To change the viewing angle:

1. Use the horizontal scroll bar to rotate the view left and right, if
desired.

2. Use the vertical scroll bar to rotate the view up and down, if
desired.

3. Choose Refresh Graph to update the display of the absorbance
profiles to the new viewing angle.

ADAP
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7.3.6.4. Viewing the Transmission Profile of a Single Well

= An ADAP Expert software license code is required to view
transmission profiles of single wells.

A detailed view of the transmission profile for each measured well is
available in View3D. This 3-D image can be rotated, zoomed, and
viewed with different textures and colors applied.

To display View3D:

1. In Scan, click on the desired well to view. View 3D appears
(Figure 7-21).

View3D

Figure 7-21: View 3D

2. To change the viewing angle of the transmission profile, click and
hold the left mouse button, and move the mouse in the desired
direction of rotation.

OR

To zoom in or out, click and hold the right mouse button, and move
the mouse left or right, or up or down.

= When zooming, moving the mouse up and down produces the
same zoom effect as moving the mouse left and right.

3. If desired, change the texture and brightness of the 3-D image by
choosing options in the View menu:

e Light — brightens the 3-D image.
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e Wireframe — hides the surface layer so that only the underlying
wireframe, or skeleton, of the 3-D image is visible.

e Solid — displays the 3-D image as a solid object.

e Shaded — Divides the surface layer into sections differentiated
by color.

e Transparent — displays the 3-D image with a translucent
surface layer.

e Outlined — Displays only the outer outline of the 3D image.

e Metallic — displays the surface texture of the 3D image with a
simulated metallic finish.

e Atmosphere — subtly modifies the brightness and texture of the
surface layer.

If desired, change the color of the surface layer by choosing
options in the Edit menu:

e Color White — displays the surface color of the 3-D as white.

e Color Gradient — blends the surface layer color of the 3-D
image using a gradient.

7.3.6.5. Saving Transmission Profiles

3-D images of transmission profiles can be saved as image files separate
from the measurement results. Images are saved in Dex3D (*.dex)
format.

To save a 3-D image of a transmission profile:
1.  From the File menu, select Save. Save as appears.

2. Browse to directory where the file will be saved and choose a File
name.

3. Choose Save to save the file.
OR

Choose Cancel to return to View3D without saving the image.
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7.3.6.5.1. Loading Transmission Profiles

3-D images of transmission profiles saved in Dex3D (*.dex) format can
be loaded into the ADAP software for viewing.

= View3D must be open to load a 3-D image.

To load a 3-D image of a transmission profile:

1.  From the File menu, select Load. Open appears (Error! Reference
source not found.).

2. Browse to directory where the desired image is saved and select it.

3. Choose Open to load the image.

= Selecting Open as read-only prevents the 3-D image from being
modified while the file is open.

OR

Choose Cancel to return to View3D without opening the image.
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7.4. Printing Quick Measurement Results

For record-keeping purposes, the ADAP software has the ability to print
Quick measurement results and information. The printing procedure
varies depending on which measurement results or information tab is
being printed.

e OD, RLU, Reduced Data, and Status — From the Setup menu or toolbar,
choose Print to print the combined measurement results and
information displayed by these tabs (refer to Section 7.4.1, Printing
General Measurement Results).

e Raw Data and Curve Info— Depending on the button available within
the tab, choose Print Raw Data or Print (refer to Section 7.4.2,
Printing Raw Data and Curve Info).

e Graphs — in the tab itself, choose Print Graph to print graphs for all
measured samples (refer to Section 7.4.3, Printing Graphs).
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Printing General Measurement Results

Measurement results and information from OD, RLU, or Reduced Data are
combined with Status into a single printout.

To print results and information:

1. From the Setup menu, choose Print. Print appears (Figure 7-22).

ORI—l

Choose Print. Print appears (Figure 7-23).

= Choosing Print from the toolbar opens a simplified type of Print
(Figure 7-23).

& Print

Prirter

Options
Fontz | (Adnial Unicode M5

~|
Size g -

k. Cancel |

Figure 7-22: Print chosen from Setup menu

2. In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

3. In Options, select the desired Font, text Size, and number of
Copies.

=> If printing from the simplified Print (Figure 7-23), in Options,
select the desired Font and text Size. A single copy is printed
automatically.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

ADAP
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= In range, selecting All Tests or Single Test produces the same
printout for Quick measurements.

4. Choose OK.

=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The
printed file is saved to the ADAP software home directory.

7.4.1.1. Viewing General Measurement Results Printouts

Printouts generated from OD, Reduced Data and Status display
measurement results and information in a matrix that matches the plate
layout (Error! Reference source not found.). For each well, the first
line lists the plate layout label assigned to the well, the second OD, or
Reduced Data results, and the third Status.

= A general measurement results printout of kinetic measurement
results includes kinetic graphs for measured wells. Kinetic graphs can
also be printed separately by choosing Print Graph in Kinetic Graph
(refer to Section 7.4.3, Printing Graphs).

To print kinetic raw data, in Raw Data, choose Print Raw Data (refer to
Section 7.4.2, Printing Raw Data and Curve Info).
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Printing Raw Data and Curve Info

Raw Data, Raw Data Scan, and Curve Info can be printed from
measurement results that include any of these tabs.

= Information in the OD, Transmission, Reduced Data and Status tabs are
printed by choosing Print in the Setup menu (refer to Section 7.4.1,
Printing General Measurement Results).

To print kinetic or scan graphs, choose Print Graph in Kinetic Graph or
Scan respectively (refer to Section 7.4.3, Printing Graphs).

To print Raw Data or Curve Info:

1.

In Raw Data or Raw Data Scan, choose Print Raw Data.

OR

In Curve Info, choose Print. Print appears (Figure 7-23).

=> Curve Info data tables may also be printed by right-clicking on a
table within the Curve Info tab.

Options
Fonts | @drial Unicode M5 ﬂ

Size g -

0k, LCancel |

Figure 7-23: Print

In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

ADAP
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7.4.2.2.

7.4.2.3.

7.4.2.4.

4. Choose OK to print the raw data.

=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The
printed file is saved to the ADAP software home directory.

Printing Curve Info Data Tables

Measurement results displayed in Curve Info tables may be printed using
the print options built into the Curve Info tab

To print complete tables:

1. Right click on a results table. A menu with print, copy, and text file
options appears.

2. Choose a printing option:

¢ Print this Table — Prints only the table right-clicked on.
e Print all Tables — Prints both tables.

\

=> Print all Tables is available only in the ADAP Plus and ADAP Expert
Software.

3. Follow steps 2-4 in Section 7.4.2, Printing Raw Data and Curve
Info, to print the tables.

Viewing Kinetic Raw Data Printouts

Kinetic measurement raw data printouts display measurement results
from all cycles sequentially for each well.

= Wells are labeled in Row-Column format. For example, A2 represents
the well in the first row of the second column.

Viewing Linear Scan Raw Data Printouts

Linear scan raw data printouts display the 25 measurement points in a
column for each well.

= Wells are labeled in Row-Column format. For example, A2 represents
the well in the first row of the second column on the plate.

Viewing Area Scan Raw Data Printouts

Area scan raw data printouts display the measurement points for each
well in a matrix that represents the layout of the measurement points.

ADAP
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= Wells are labeled in Row-Column format. For example, A2 represents
the well in the first row of the second column.

7.4.2.5. Viewing Curve Info Printouts

Curve Info printouts for multiwavelength and linear scan measurement
results present data in the same column format displayed when viewing
Curve Info onscreen.

= The ADAP Plus or ADAP Expert software is required to print Curve Info
other than OD and transmission results.
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Printing Graphs

Measurement results can be printed from all Graphic tabs.

Frint Graph

To print a graph:

1. Choose Print Graph. Print appears (Figure 7-24).

= When Print Graph is chosen from a Graphic tab displaying the
results for an individual sample, graphs for all measured samples
are printed.

% Print

Prirter

Options
Faonts | @arial Unicode M5 ﬂ

Size g -

] Cancel |

Figure 7-24: Print
2. In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

3. In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

4. Choose OK to print the information.

=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears.
The printed file is saved to the ADAP software home directory.

=> Kinetic graphs can also be printed with OD, RLU, Reduced Data, and
Status results and information by choosing Print from the Setup menu or
toolbar (refer to Section 7.4.1, Printing General Measurement Results).

ADAP
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7.4.3.1. Viewing Kinetic Graph Printouts

Kinetic graph printouts display kinetic graphs for all measured wells on
the plate.

= Wells are labeled in Row-Column format. For example, C2 represents
the well in the third row of the second column.

7.4.3.2. Viewing Linear Scan Graph Printouts

Linear scan graph printouts display linear scan graphs for all measured
wells on the plate.

= Wells are labeled in Row-Column format. For example, C2 represents
the well in the third row of the second column.
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7.4.3.3. Viewing Area Scan Graph Printouts

Area scan graph printouts display area scan graphs for all measured
wells on the plate.

= Well labels are not printed in area scan graph printouts. However, the
layout matches the Row-Column format used by kinetic and linear scan
graph printouts, so the well in the third row of the second column is C2.

ADAP ADAP Software Operating Manual 7-59



\

7.5. Exporting Quick Measurement Results to Other
Applications

Quick measurement results can be exported to other applications for
further analysis or manipulation. The ADAP software provides two
methods to export data:

e Data can be copied and pasted into another application such as a
word processor (refer to Section 7.5.1, Copying and Pasting
Measurement Results into another Application).

e Data can be saved to a text file and then opened by or imported into
another application (refer to Section 7.5.2, Saving Measurement
Results as Text Files).

7.5.1. Copying and Pasting Measurement Results into
another Application

Measurement results displayed in any tab can be copied to a clipboard.
These results can then be pasted into another application for storage or
further analysis.

= For example, data from the ADAP software could be pasted into a
spreadsheet with formulas or macros already configured to perform
preliminary analysis on measurement results data.

To copy measurement results to the clipboard:
1. Select the desired results tab to copy to the clipboard.

2. From the Options menu, choose Copy displayed data into clipboard
to copy only the displayed results to the clipboard.

Ez

From the Options menu, choose Copy all data into clipboard to
copy all results from a kinetic or scan measurement to the
clipboard.

OR

= When copying Raw Data, choosing Copy displayed data into
clipboard copies only the cycle or well displayed. To copy raw data
results for all cycles or wells measured, choose Copy all data into
clipboard.

3. Open or switch to the application where the measurement results
will be pasted.
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4. Paste the measurement results into a new or existing file using the
Paste command for the application.

= Most applications have CTRL+V assighed as the Paste command
keyboard shortcut.

7.5.1.1. Copying and Pasting Curve Info Results into another
Application

Measurement results displayed in Curve Info tables may be copied and
pasted using the copy options built into the Curve Info tab (Figure 7-25).
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Figure 7-25: Curve Info copy options

To copy complete tables into another application:

1. Right click on a results table. A menu with print, copy, and text file
options appears (Figure 7-25).

2. Copy this Table — Copies all data in the table clicked on to the
clipboard.

3. Open or switch to the application where the measurement results
will be pasted.
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4. Paste the measurement results into a new or existing file using the
Paste command for the application.

= Most applications have CTRL+V assigned as the Paste command
keyboard shortcut.

To copy selected data from a table into another application:

1. Click and drag over the table data desired to copy. The selected
data is highlighted.

2. Right click on a results table. A menu with print, copy, and text file
options appears (Figure 7-25).

3. Choose Copy Selection. The selected data is copied to the
clipboard.

4. Open or switch to the application where the measurement results
will be pasted.

5. Paste the measurement results into a new or existing file using the
Paste command for the application.

= Most applications have CTRL+V assigned as the Paste command
keyboard shortcut.
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7.5.2. Saving Measurement Results as Text Files

Measurement results can be saved as text files which can be viewed in
any text editor or imported into many statistical software packages or
spreadsheet applications.

To save measurement results to a text file:
1. Select the desired results tab to save as a text file.

2. From the Options menu, choose Save displayed data as TXT to
save only the displayed results as a text file.

OR

From the Options menu, choose Save all data as TXT to save all
measurement results as one text file.

OR

Select the desired command from the toolbar.

= When saving Raw Data to a text file, choosing Save displayed
data as TXT copies only the cycle or well displayed. To save raw
data results for all cycles or wells measured, choose Save all data
as TXT.

3. Save As appears. Browse to the desired location to save the data.

=> If the ADAP software is configured in Setup-System to automatically
save measurement results as text files, these files may also be opened
in a text editor or other application. Refer to Section 3.3, Configuring
System Settings for information about configuring the ADAP software to
automatically save measurement results as text files.
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7.5.2.1. Saving Curve Info Table Data as a Text File

Table data in the Curve Info tab for multiwavelength and linear scan
measurements can be saved to a text file within the Curve Info tab.

To save table data as a test file:

1.

Right click on a results table. A menu with print, copy, and text file
options appears (Figure 7-25).

Choose Save all Tables as TXT. Save As appears.
Browse to the desired location to save the text file.
Enter a File name for the text file.

Choose Save to save the file.

OR

Choose Cancel to return to the ADAP software without saving the
curve info data as a text file.

ADAP
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Defining and Running Tests

Overview

= An ADAP Plus or ADAP Expert software license code is required to
access the functions described in this chapter.

A test is a protocol for making and evaluating measurements using
Biochrom microplate readers. Tests offer more programming and
evaluation options than Quick measurements, and may be saved for
future use.

Tests performed with Biochrom microplate readers are defined and
edited using a series of test definition tabs in the ADAP software. The
ADAP software provides options to:

e Define new tests (refer to Section 8.2, Defining New Tests).
e Save new tests (refer to Section 8.3, Saving Test Definitions).
e Run existing tests (refer to Section 8.4, Running Existing Tests).

e Edit, copy, or delete tests (refer to Section 8.5, Editing, Copying, and
Deleting Tests).

e Print tests (refer to Section 8.6, Printing Test Definitions).

e Search for specific microplates (refer to Section 8.7, Using
Matchcode to Search for Test Definitions and Saved Plates).

\

= Tests may be performed by all authorized users; however, tests may
only be defined, edited, and deleted by Level 2 (administrator) and
Level 3 (system administrator) users (refer to Chapter 2, User Login and
System Administration).
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8.2. Defining New Tests

The ADAP software can define a wide range of test protocols. Test
protocols define how the Biochrom reader performs measurements and
interprets the resulting data.

Tests are defined using a series of test definition tabs that configure
different categories of parameters. Based on the instrument
configuration, a test definition may include parameters set in any of the
following categories:

e General — Configures general information about the test, including
name, instrument, shaking, measurement filters, and variables
(refer to Section 8.2.1, Configuring General Options).

e Plate Layout — Accessed from General, sets the location of standards,
blanks, controls, replicates, and samples on the plate (refer to
Section 8.2.2, Defining Plate Layout).

e Quantitative — Configures standard curve data (refer to Section 8.2.3,
Configuring a Quantitative Evaluation).

e Qualitative — Configures cutoff groups and formulas (refer to Section
8.2.4, Configuring a Qualitative Evaluation).

e Option — Configures printing options and tools for test evaluation
(refer to Section 8.2.5, Configuring Test Options).

e Kinetic — Configures kinetic measurement parameters
(8.2.7, Configuring Scan Measurements).

e Scan — Configures scan measurement parameters
(refer to Section 8.2.7, Configuring Scan Measurements).

= Scan measurements may only be performed by the Zenyth 340
microplate reader.

o Rejection/Validation — Programs replicate elimination and test
validation formulas (refer to Section 8.2.8, Programming
Rejection/Validation Formulas).
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To open ADAP test definition setup:

From the Setup menu, choose Calculation.

o L

Choose Create/Edit Calculation. ADAP test definitions options
appear with the General tab open (Figure 8-1).
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Figure 8-1: ADAP test definition - General

Configuring General Options

General provides options to set up the basic parameters of a test

definition.

1. In Test Name, enter a name for the test.

= Test names cannot be longer than 20 characters in length.

2. In Instrument, select the instrument to be used to perform the Test.

= The type and serial humber of the instrument currently

connected or used in the previous test is automatically selected.

The instrument setting only needs to be selected manually if a
different instrument will be used to perform the Test currently

being defined.

ADAP
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In Data Transfer Mode, if desired, select how measurement results are
transferred from the instrument to computer:

o Plate — Transfers data for the entire plate at one time.
e Row — Transfers data one row at a time.

e Well — Transfers data one well at a time.

= The ADAP software automatically chooses a Data Transfer Mode
that is supported by the connected instrument and is most
applicable to the type of measurement being performed.

3. In Lot#, if desired, enter the lot number of any reagent or kits
being used in the test and select Yes if the concentration is lot-
number dependent.

4. In Shaking, if desired, select Yes to shake the plate before the
measurement is made.

= In kinetic measurements, the plate is shaken before each
measurement cycle.

5. If Shaking is selected, in Time, select the number of seconds to
shake.

6. If Shaking is selected, select Low, Medium, or High shaking
intensity.

7. In Measurement filter/Reference filter, select the desired wavelengths
for the Measurement filter and the Reference filter.

=> All filters installed on the instrument appear in the Measurement
filter and Reference filter lists.

= When a Reference filter is selected, the final measurement result
is calculated by subtracting the reference filter measurement from
that of the Measurement filter.

=> If no reference filter is needed, select <-->.

8. In Parameter, enter numeric values for up to six variables that can
be used in any formula defined in the test definition.

=>» Parameter variables are typically used with test kits that have
cutoff values or standard correction values based on lot number.

9. In Check Variable, select Yes to display the Parameter variables
after the measurement, but before the results are evaluated. This
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allows the variables to be changed to account for variations in lot-
dependent reagents.

= Changes made to Parameter variables during a test run are
automatically saved in the test definition.

8.2.2. Defining Plate Layout

Define Layout configures the parameters and well layout of the plate to
be measured. Define Layout is divided into four sections:

e Options — Configures plate parameters including plate type, strip
use, filling direction, replicates, and well labeling format (refer to
Section 8.2.2.1, Configuring Plate Parameters in Options).

e Control-Position — Configures the type and label numbering of wells
to be laid out on the plate (refer to Section 8.2.2.2, Configuring Well
Types and Labels in Control-Position).

e Plate Layout — Defines the location of standard, control, blank, and
sample wells on the plate (refer to Section 8.2.2.3, Defining Well
Location in Plate Layout).

e Factor — Configures multiplication factors for wells on the plate (refer
to Section 8.2.2.4, Entering Dilution Factors for Wells). To open
Define Layout:

In ADAP test definition options, choose Layout.
OR

In General, under Test Name, choose Edit/Define Layout. Define
Layout appears (Figure 8-2).
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Figure 8-2: Define Layout
Configuring Plate Parameters in Options

Options configures plate parameters including plate type, strip use, filling
direction, replicates, and well labeling format.

To configure plate parameter, in Options:

1. In Plate Type, select the type of plate used in the test.

= Available plate types vary depending on the instrument in use.

2. In CAG-Strips, select the location of antigen control strips if they
are used in the test. CAG wells are assigned to the plate layout:

e No — Antigen control strips are not used.

e 1st - Horizontal — Antigen control well is located horizontally
before the samples.

e 2nd - Horizontal — Antigen control well is located horizontally after
the samples.

e 1st - Vertical — Antigen control well is located vertically before the
samples.

e 2nd - Vertical — Antigen control well is located vertically after the
samples.

ADAP
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= When CAG-Strips is selected, the measurement of the control
antigen well is automatically subtracted from the full antigen well.

3. In Filling Direction, select how samples are humbered based on the
filling direction of the plate:

e Vertical — Sample labels are numbered in ascending order
column by column.

e Horizontal — Sample labels are numbered in ascending order row
by row.

4. In Replicate No./Direction, select the number of replicates to be used
for each sample, and set the filling direction of replicates:

e Vertical — Replicate labels are numbered in ascending order
column by column.

e Horizontal — Replicate labels are numbered in ascending order
row by row.

5. In Well Labels, select the format of the well labels:

e Al, A2, Bl, B2— Labels rows by letter, columns by number.

e 1.1,1.2,13..2.1,2.2,and 2.3. — Labels rows and columns by
number.
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8.2.2.2. Configuring Well Types and Labels in Control-Position

The options in Control-Position work in conjunction with Plate Layout to
configure well types, label numbers, and locations on the plate.
Standards, controls, and blanks are configured using Control-Position,
and then placed on the plate using Plate Layout.

= All controls used in the subsequent assay analysis must be defined
plate layout.

= Define the locations of controls, blanks and/or standards first and then

Fill Flate with S amplez

use the automatic to fill the

remaining empty wells in the plate.

To configure well types and label numbers:
1. In Type, select the control or sample to place in the selected well:

o Standard (S) — A solution with known concentration to generate a
standard curve.

e Positive Control (PC) — a solution that gives an absorbance value
that that allows samples to be categorized as positive. Positive
controls are also used for test validation.

o Negative Control (NC) — a solution that gives an absorbance
values that allows samples to be categorized as negative.
Negative controls are also used for test validation.

e Control (K) — a solution with a known, expected signal used to
verify the results of the plate. Or to be used in a transformation
formula to be applied to sample measurements.

¢ Quality-Control (Q) — A solution with a known absorbance
measurement which is used to check lot-dependent variations
between kits or reagents.

e Blank (B) — a solution that contains the assay reagents but not
controls or samples that is used to normalize the absorbance
measurements of standards, controls and samples.

= The mean value of Blank wells is automatically subtracted from
all other wells (refer to 8.2.5.3, Configuring Blank Subtraction).

e Sample (PR) — a solution with absorbance value that will be
analyzed in comparison to standards and/or controls.

2. In Numbers, click and drag the slider to change the number
associated with the control. E.g. S1, S2, PC1, C
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= Drag the slider to the right to increase the label number, or to
the left to reduce it.

3. In plate layout, define the location by selecting specific wells that
will contain the standards, controls, blanks or standards. Simply
highlight the well with your mouse or using the keyboard arrow
keys and select <enter>.

4. After defining locations for the configured well Type, repeat steps
1-3 above for each additional well type desired on the plate.

5.  When all standards, controls, and blanks have been configured,
choose Fill Plate With Samples to populate all remaining wells
with samples.

= Samples numbers will be automatically incremented using

Filling Direction |‘-.-’ertiu:a| -
Feplicate Count |1 | Harizontal ﬂ
wiell Labels |41, 42,43 B1, B2. -

to indicate
replicates and fillingn direction.

8.2.2.3. Defining Well Location in Plate Layout

Plate Layout defines the location of standard, control, blank, and sample
wells on the plate (Figure 8-3). Well locations may also be edited and
deleted using the options in Plate Layout.

Define Layout
File W3

Bl set all wells L Options
TV De-select all wells hd Plate Type BC_56_F :l'
Nu CAG-Ships Mo -
Set actual row
De-select actual rov j Filing Direction ertical -
Freplicate Count 1 Harizantal -
Set actual column P
Wwiell Labels 41,42, 83,8182, hd

~—  De-select actual column

Plat  Set selected wells
—  De-select selected wells |

Figure 8-3: Define Layout - Plate Layout
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To define locations on the plate for wells configured in Control-Position:

1. In Plate Layout, click on the desired well to define (Figure 8-3).

= Select multiple wells by clicking and then dragging over the
desired wells.

2. From the Edit menu, choose a method for selecting which wells will
be defined as the type configured in Control Position:

OR

Right-click on the selected well(s) and choose a method for
selecting which wells will be defined as the type configured in
Control Position:

3. Set/De-select all wells — Populates or clears all wells on the
microplate.

4, Set/De-select actual row — populates or clears all wells in the same
row as the first well selected (Figure 8-3).

5.  Set/De-select actual column — populates or clears all wells in the same
column as the first well selected (Figure 8-3).

6. Set/De-select selected wells — Populates or clears the selected wells.
7. In Control-Position, configure another well Type, if desired (refer to

Section 8.2.2.2, Configuring Well Types and Labels in Control-
Position).

= When all standards, controls, and blanks have been configured, in
Control Position, choose Fill Plate With Samples to populate the
remaining wells with samples.
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8.2.2.4. Entering Dilution Factors for Wells

Factor allows entering dilution factors for wells on the plate (Figure 8-4).

Define Layout

File Edit
Options
[ ||| Plate Type [BC_g6 F =l
CAG-Stips [No =]
J J Filling Direction |Vertical j
Fieplicate Count ’1_ Horizontal -
| wiell Labels |41, 42 43 B1.82 |
1 [ 2 [ s [ 4 s [ e | 7 ] 8 | 8 [ ] n ] 12

I|m|-n|rn|D|l—J|m|I>

Figure 8-4: Define Layout - Factor
To enter multiplication factors:
1. Choose Factor.

2. Select a well and enter numerical value for the Factor (Figure 8-4).

= Select multiple wells by clicking and dragging over the desired
wells. When a new factor is entered for the first well selected, all
selected wells are assigned the new factor.

3. Repeat the previous step for all wells desired.

= F can be entered in transformation formulas and refers to the
individual multiplication factor for each well position entered in Factor. F
is typically used in quantitative transformation formulas to correct the
concentration of samples for their dilution factor: e.g. X' = X * F.
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8.2.2.5. Completing Define Layout

When all parameters are configured and the plate layout defined, save
Define Layout and return to ADAP test definition options to complete the
configuration of the test definition.

To close Define Layout:
From the File menu, choose End to save the new plate parameters.

OR

From the File menu, choose Cancel to exit Define Layout without
saving the new plate parameters and layout.

=> In the File menu, Print and Open perform their respective functions on
the complete test definition, not Define Layout, and may not be
accessible if the test definition is not completely configured.
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8.2.3. Configuring a Quantitative Evaluation

Quantitative configures parameters for standard curves, concentration
values, and response and transformation formulas. Quantitative is
divided into five sections:

4.

Standards — Configures concentration and response formula
parameters for standards (refer to 8.2.3.1, Configuring Standards).

Curve — Configures standard curve fitting parameters (refer to
8.2.3.2, Configuring Standard Curve Parameters).

Factor — Sets a multiplication factor which enables the
concentration value to be scaled to the desired unit (refer to
8.2.3.3, Configuring the Factor).

Use stored Standard Curve — Loads a stored standard curve into the
test definition (refer to 8.2.3.4, Opening a Stored Standard Curve).
Only available in ADAP Expert.

Transformation — Configures a transformation formula to apply to
concentrations (refer to 8.2.4.3, Configuring a Transformation
Formula). Only available in ADAP Expert.

To define a standard curve for a quantitative evaluation:

Please note: Use stored
Standard Curve and
Transformation features are
available in ADAP Expert not
ADAP Plus.

Select Quantitative (Figure 8-5).

% File Layout -8 x
General l Qualitative ] Options ] Kingtic ] Scan] Rejection / Yalidation
Standards Curve
Concentration Response Farmula |F'0int 1o Port j
1 e <> dus (X lindlin -
& |<"'> |<"> E xtrapalation 1] %
* |<"'> |<"> Units Concentrat
& |<" ? |<" ? Y alidate Curve
5 |<" ? |<" ? Min. Correlation %
S P =
Factor
7 e =
Concentration * 1.0
g fo =
& |<---> |<-- » Use stored Standard Curve
10: [ = N =l
Transformation
™ No C ¥es K= i
(® Plates ) Row ) Column Units |«

Figure 8-5: Quantitative tab
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8.2.3.1. Configuring Standards

Standards configures up to 10 concentration values.

= To use parameters from a saved test definition, refer to Section
8.2.3.4, Opening a Stored Standard Curve.

To configure concentration values and response formulas:

1. Under Concentration, enter the concentration of the standard.

=>» For Concentration values less than 1, enter a leading 0 before the
decimal; for example, 0.51. Values entered without the leading 0
produce an error when the measurement is performed.

2. Under Response Formula, enter the standards (e.g. S1...510) used in
the plate layout.

= Response formulas may contain any controls, standards, or
variables defined in the test, as well as any numerical constants
and mathematical operators +,-,*,/,(,), ..

=> For Response Formula values less than 1, enter a leading 0 before
the decimal; for example, 0.51. Values entered without the leading
0 produce an error when the measurement is performed.

3. The resulting graph will plot the concentrations on the x-axis and
the absorbance measurement of the standards on the y-axis.

ADAP ADAP Software Operating Manual 8-14



\

8.2.3.2. Configuring Standard Curve Parameters

Curve configures new standard curve parameters.

= To use standard curve parameters from a saved test definition, refer
to Section 8.2.3.4, Opening a Stored Standard Curve.

1. In Curve, select the curve fit method: Point to Point, Linear Regression,
Cubic Spline, or 4-Parameter Fit.

= Refer to Section 8.2.3.2.1, Curve Fitting Models for detailed
information about Curve Fit methods.

2. In Axis (X/Y), select the scale to use for the X and Y axes.
3. lin/lin — Linear/Linear

4. lin/log — Linear/Logarithmic

5. log/log — Logarithmic/Logarithmic.

6. In Extrapolation, enter a percentage value to extrapolate the

standard curve above and below the highest and lowest standard
points in the curve, if desired.

=> Extrapolation percentages can be used only with Linear Regression,
Cubic Spline or 4-Parameter Fit curve fitting methods

= The percentage value entered in Extrapolation can be up to
99.9%

7. In Units, enter the units of concentration of the standards.

=>» Units are used for documentation purposes only and do not
impact the standard curve. Units appears in Transform in the test
measurement results window (refer to Section 10.2.3, Viewing
Concentration Results).

8. In Validate Curve, choose Yes or No to validate the test based on an
acceptable coefficient of correlation (R?).

=> Validate Curve is only available with the Linear Regression curve
fitting method.

= For most standard curves, an acceptable R? value is >95% or 0.95
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8.2.3.2.1. Curve Fitting Models

Table 8-1 describes the four curve fitting models supported by the ADAP
software.

Method Description

Construction of a straight line using the least squares
method with the highest possible approximation to all
standard points.

Linear

. Requires a minimum of 2 standard points.
regression

Linear regression is used in assays such as total
protein quantitation assays.

Direct connection of all standard points.

Requires a minimum of 2 standard points.

Point to Point to point, also called interpolation should only be
Point used if other curve-fitting algorithms are not
suitable.

Curve extrapolation cannot be used with Point to
Point.

All standard points are connected by the best fitting
curve.

=»Can only be used for nonlinear and non-sigmoid

. . functions.
Cubic Spline

Requires a minimum of 3 standard points.

Curve extrapolation cannot be used with Cubic
Spline.

his procedure can be used only to characterize
sigmoid curves.

4 Parameter Requires a minimum of 4 standard points

4-parameter fits are used in competitive binding
assays and most ELISA assays.

Table 8-1: Curve Fitting Models
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8.2.3.3.

8.2.3.4.

Configuring the Factor

In Factor (Figure 8-5), if desired, enter a dilution factor to enable the
concentration value to be scaled to the desired unit.

Please note: Use of Factor with 4-parameter curve-fitting is not
recommended.

Opening a Stored Standard Curve

Use stored Standard Curve permits standard curve parameters from saved
test definitions to be loaded into the current test definition.

To open standard curve parameters from an existing test definition:

1. In Use stored Standard Curve, choose Yes. Selection appears

(Figure 8-6):

14 items

BCA Standard
Bradford [Coomagzie)
Bradford Agzzay
Bradfard Micro
Bradfard Standard
dsDMaA ENA 8 ELISA
dsDMA ENA BELISA 2
EMA BELISA

195 Quantitation

MTT Cell Growth
MNe&DHdepletion o

update list Delete

|
tatchcode |
i3 |
|

LCancel

Figure 8-6: Selection - test definition

2. Select the desired test and choose OK. Fields in Standards and Curve
are automatically populated with the standard curve parameters
from the selected test. The name of the selected test appears in
Use stored Standard Curve.

= Selecting No after a stored standard curve has been loaded removes
the test name from Use stored Standard Curve, but not the parameters
loaded in Standards and Curve. Parameters in Standards and Curve must be
edited or deleted manually.

ADAP
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8.2.3.5.

\

Configuring a Transformation Formula

Transformation inserts the absorbance measurement into a mathematical
function.

=> X is defined as the absorbance value and must be included in a
transformation formula.

Transformation formulas do not need to be defined for concentration
values calculated from standard curves. ADAP performs these
calculations automatically once a standard curve is defined in
Quantitation and Plate Layout.

To configure a transformation formula:

1. Choose Yes or No to indicate whether a transformation formula will
be used.

2. If Yes is selected, in X'=, enter the transformation formula.
For example: if the absorbance value of a sample is to be
expressed relative the positive control than the formula would
appear:

X'=X/PC1
X" is the result of the calculation

X is the absorbance measurement

PC1 is the positive control (which must be defined in plate layout)

= The formula may contain any controls, standards, or variables
defined in the test, any numerical constants, as well as
mathematical operators () * +, - ./ ~, ABS, SQR, L, F, X, and V
(refer to Section 8.2.8.3, Logical and Mathematical Operators).

Standards and controls are abbreviated as: S for standard, K for
control, QC for quality control, PC for positive control, and NC for
negative control.

3. Select Plate, Row, or Column to define how the transformation
formula is applied to the wells on the plate:

4. Plate — applies the transformation formula to all wells on the plate.

5. Row — applies the transformation formula to all wells in a row with
a defined control position.

ADAP
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6. Column — applies the transformation formula to all wells in a
column with a defined control position.

7. In Units, enter the units of the resulting calculation, which will be
displayed in the Test measurement results.

=> Units are used for documentation purposes only and do not
impact the standard curve. Units appears in Transform in the test
measurement results window (refer to Section 10.2.3, Viewing
Concentration Results).
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8.2.4. Configuring a Qualitative Evaluation

Qualitative configures qualitative evaluations that classify measured
samples according to defined cutoff values. Up to five groups of samples
may be classified using cutoff formulas. Qualitative is divided into three
sections:

Groups — Defines sample group names (e.g. “positive” or
“negative” and cutoff formulas (refer to 8.2.4.1, Configuring
Groups and Cutoff Formulas).

Factor — Sets a dilution factor that enables the measurement value
to be scaled to the desired unit (refer to 8.2.4.2, Configuring the
Factor).

Transformation — Configures a mathematical formula to apply to raw
data (refer to 8.2.4.3, Configuring a Transformation Formula).

To configure qualitative evaluation options:

Select Qualitative (Figure 8-7).

% File Layout - 8 X
General] Guantitativeg l Dptions] S-:an] Rejection / Validation
Groups
Group 1: =
Cutoff Formula 1: ¢z
Group 2: =
Cutaff Formula 2: [z
Group 3: =
Cutoff Formula 3: |<___>
Group 4 =
Cutaff Formula 4: [c-z
Group 5: Py
| Interpretation | 0D j
Factor
Meas. Value *  [1.0
Transformation
(® Mo ) Yes = o
Uitz | <>

Figure 8-7: Quantitative tab
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8.2.4.1.

Configuring Groups and Cutoff Formulas

Groups define group names and cutoff formulas to separate them. Up to
five group names and four cutoff formulas may be defined.

1.

In Group 1 - Group 5; enter names (e.g. positive or negative) for the
groups to be separated by the cutoff formulas.

In Cutoff Formula 1 — Cutoff Formula 4, enter the cutoff formulas that
separate the samples into groups. The cutoff formula can be
thought of as group 1>group 2>group 3 where the > sign is
followed by the formula that describes the difference between the
two groups (see example below).

= Each cutoff formula may be defined as one of the controls
defined on the plate layout or as a mathematical formula. The
result of the formula is then used as the related cutoff value.

In Interpretation, select the basis for the cutoff calculation: OD
(Optical Density), Concentration, Transformation (from mathematical
formula described in the Qualitative page, or Transf. (Conc) (as described on
the Quantitative page).

B ADAP - [ENA 8 ELISA] L EX
- 0 X

" File Layout
Ganeral] Guantitative Q ] Optlions I Fejection /Y alidation I
Groups
Group 1: Puositive
Cutoff Formula 1: [1.25
Group 2: Equivacal
Cutoff Formula 2: |D a0
Group 3: Megative
Cutaff Forrmula 3: |<,,,>
Group 4: P
Cutaff Forrmula 4: |<...>
Group 5: oy
Interpretation | Transformation A
Factor
Meas. Value * |1 0
Transformation
C Ha W ez K= [poivn
Units | Transforma

=>For example: In this example the qualitative test will defines a
transformation formula to express the samples as transform the
absorbance as a ratio of PC1 and V1. The result of the formula is
used in the Cutoff Formula to define the groups that categorizes
the samples. All values >1.25 will be assigned to Group 1 and thus
labeled “Positive”. Values which are <1.25 but >0.80 are assigned

ADAP
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to Group 2 and thus labeled “Equivocal”. The remaining samples
will be assigned to Group 3 and will be labeled as “Negative”.

8.2.4.2. Configuring the Factor

In Factor, if desired, enter a dilution factor to scale the measurement
value to the desired unit.
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Configuring a Transformation Formula

Transformation configures transformation formulas, which are used to
transform raw data (X) based on an algebraic formula (X'=).

= X must be included in a transformation formula.

To configure a transformation formula:

1. Select Yes or No to indicate whether a transformation formula will
be used.

2. If Yes is selected, in X'=, enter the transformation formula.
An example of a transformation formula:
X'=X/ (PC1-NC1)
Where X is the absorbance measurement
PC1 is a positive control defined on the plate

NC1 is a negative control defined on the plate

= The formula may contain any controls, standards, or variables
defined in the plate layout, any numerical constants, as well as
mathematical operators () * +, - ./ ~, ABS, SQR, L, F, X, and V
(refer to Section 8.2.8.3, Logical and Mathematical Operators).

Standards and controls are abbreviated as: S for standard, K for
control, QC for quality control, PC for positive control, and NC for
negative control.

3. Select Plate, Row, or Column to define how the transformation
formula is applied to the wells on the plate:

4. Plate — applies the transformation formula to all wells on the plate.

5. Row — applies the transformation formula to all wells in a row with
a defined control position.

6. Column — applies the transformation formula to all wells in a
column with a defined control position.

7. In Units, enter the units of the transformed value.

=>» Units are used for documentation purposes only and do not
impact the standard curve. Units appears in Transform in the test

ADAP
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measurement results window (refer to Section 10.2.2, Viewing
Transformation Formula Results).
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8.2.5. Configuring Test Options

Options page is divided into four sections that configure replicates,
printing, validating blanks, and evaluating controls:

Replicate Mean Values — Configures how mean values for replicates
are calculated (refer to Section 8.2.5.1, Configuring Replicate Mean
Values).

Print Options — Configures how test reports are formatted (refer to
Section 8.2.5.2, Configuring Print Options).

Blank Validation — Configures where the mean value of blanks is to
be applied (refer to Section 8.2.5.3, Configuring Blank
Subtraction).

Evaluate Controls — Configures how standards and controls are
evaluated (refer to Section 8.2.5.4, Configuring Evaluation
Controls).

To configure Options:

Select Options (Figure 8-8).

"% File Layout -8 %
General] Quantitative] Qualitative | 0 Rejection /' alidation
Replicate Mean Values Blank Validation
® Plates © Plates
C
) nane oz
) Calumn
Print Options E valuate Controls
[~ Table [ Standard curve 1 [ Qualitative
P M atriz: [~ Standards [ Duantitative
[ Information K: [ Qualitative
[ Mean [ 4 alidation [ Quartitative
[~ Transformation [ Cutaff Farmula e, [ Qualiative
[~ Concentration [~ Scan / Kinetic Graph [™ Quantitative
[~ RawData pe. [ Qualtative
B Status " [ Quantitative
e [ Qualtative
" [ Quantitative
Select al |

Figure 8-8: Options tab
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8.2.5.1. Configuring Replicate Mean Values

Replicate Mean Values configures how mean values for replicates are
calculated.

To select where replicate mean values are calculated:

Select the mean calculation method:

8. Plate — applies the mean calculation to all replicates of a sample or
standard across the plate, regardless of well location.

9. Row — Applies the mean calculation to replicates of a sample or
standard located within an individual row.

10. Column — applies the mean calculation to replicates of a sample or
standard located within an individual column.

11. None — turns the mean calculation off. The first value of the
replicate group is used for further calculation.

=> In none, the first value of the replicate group refers to the left
most or uppermost replicate in the group.

= Test results display the mean value in the first replicate position
based on filling direction.

= If the selected mean calculation does not correspond to the
defined replicate order, no mean calculation is performed.

8.2.5.2. Configuring Print Options

Print Options configures how test reports are formatted and which test
measurement results they include.

1. Select how the test results are formatted on the page: Table (as a
list), Matrix (values shown in the plate layout format), or both.

2. Select the measurement data to be printed as part of a test report
after a test measurement is completed.
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8.2.5.3. Configuring Blank Subtraction

Blank Subtraction configures where the mean value of blanks is to be
applied.

Select how mean values are applied:

3. Plate — across the entire plate.

4. Row — Only within the row containing the blanks.

5. Column — Only within the column containing the blanks.
8.2.5.4. Configuring Evaluation Controls

Evaluate Controls configures whether standards and controls are
evaluated using quantitative or qualitative methods.

For each type of standard or control, select the evaluation method:
Quantitative or Qualitative.

= In Options, standards and controls are abbreviated as: S for standard,
K for control, QC for quality control, PC for positive control, and NC for
negative control.
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8.2.6.

Configuring a Kinetic Photometric Measurement

A kinetic photometric measurement performs a specified number of
measurements for each selected well on a microplate. The final result of
a kinetic measurement is produced by a specified data reduction
method. Kinetic is divided into two sections:

Kinetic Measurement — Configures the basic parameters of a kinetic
Measurement (refer to 8.2.6.1, Configuring a Kinetic
Measurement).

Parameter — Selects and configures the data reduction method
(refer to Section 8.2.6.2, Configuring the Data Reduction
Parameters).

=>Kinetic test analysis is only available in ADAP Expert.

To configure a kinetic photometric measurement:

Select Kinetic (Figure 8-9).

= Additional configuration options in Parameter are enabled only as
needed by the Data Reduction method chosen.

CEX

% File Layout

Generall Quantitative] Qualitative] Options K tICl Scanl Rejection / Walidation

Kinetic Measurement

Kinetic Measurement [~ YES

Cycles 2
Interval 20 360,
Temperature [C) 0
Parameter
[rata Reduction Lo j

Figure 8-9: Kinetic tab
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8.2.6.1. Configuring a Kinetic Measurement

The options in Kinetic Measurement configure the basic parameters of a
kinetic measurement.

1. In Kinetic Measurement, select Yes to perform a kinetic
measurement.

2. In Cycles, enter then number of times each well will be measured.

3. In Interval, enter the length of time, in seconds, between each
measurement of the same well.

4. In Temperature, set the internal instrument temperature, if desired.

= Temperature control appears only when a kinetic measurement
is configured to run on a Zenyth 340 microplate reader with
temperature control.
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8.2.6.2. Configuring the Data Reduction Parameters

Parameters selects and configures the data reduction method used to
calculate the results of a kinetic measurement. The ADAP software
supports 12 data reduction methods.

To select and configure a data reduction method:

1.

In Data Reduction, select the method of data reduction.

= Depending on the data reduction method selected, additional
parameters may need to be configured using the four options
displayed below Data Reduction. Refer to Table 8-2 for the additional
configuration requirements of each data reduction method.

Configure the parameters required by the data reduction method.

Data Reduction
Method

Description

Additional
Configuration

Average Slope

Determines the average slope of the
reaction curve by calculating the average
of all linear regressions calculated over
each group of Smoothing Points in the
kinetic reading sequence. A decreasing
slope shows a decline.

Smoothing Points

Delta OD

Difference in optical density (OD) between
the first and last kinetic measurements.

N/A

Delta OD — Max. Slope

Difference in OD between the first
measurement and the center point of the
maximum slope.

=>The center point of the maximum slope
is calculated by determining the center
point between the smoothing points of the
regression line with the maximum slope.

Smoothing Points

Delta Time — Absolute Time elapsed from one preselected OD Lower L!m!t
value to another Upper Limit
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Data Reduction
Method

Description

Additional
Configuration

Delta Time — Max. Slope

Time difference in seconds between the
first measurement and the occurrence of
the center point of the maximum slope.

= The center point of the maximum slope
is calculated by determining the center
point between the smoothing points of the
regression line with the maximum slope.

Smoothing Points

Delta Time - Relative

Time elapsed in seconds from the first
measurement to reaching a set
increase/decrease amount from the first
OD measurement.

In-/Decrease

Maximum Declining Scope

Determines the maximum declining rate of
the reaction curve by calculating a linear
regression over each group of Smoothing
Points in the kinetic reading sequence.

Smoothing Points

Maximum Inclining Scope

Determines the maximum inclining rate of
the reaction curve by calculating a linear
regression over each group of Smoothing
Points in the kinetic reading sequence.

Smoothing Points

Maximum Slope

Maximum slope of the curve in OD/min.
The line with the highest slope is
calculated. Also the maximum reaction
speed.

=>The accuracy of this calculation depends
on the number of measurement cycles
selected.

Smoothing Points

Mean

Determines the mean value per sample
within a sequence of measurements.

N/A

Time Peak Value

Used to detect the time elapsed until the
peak value is reached.

Smoothing Points

Peak Value

Used to detect the highest value per
sample within a sequence of
measurements.

Smoothing Points

Table 8-2: Data Reduction Methods
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8.2.7. Configuring Scan Measurements

Scan measurements are only available with the Zenyth 340 microplate
reader. Linear and area scan measurements make a series of
measurements at defined points within a well. Three scan measurement
options are available:

Normal Scan Measurement/96 Well Plate — Configures a linear scan
with up to 25 user-defined measurement points (refer to Section
8.2.7.1, Performing an Area Scan Measurement).

Area Scan/6, 12, 24, 48 or 96 Well Plate — Configures an area scan with
user-defined measurement points and resolution (refer to Section
8.2.7.2, Performing a Normal Scan Measurement).

Scan All/96 Well Plate — Configures a linear scan with 27
measurement points across the well (refer to Section 8.2.7.3,
Performing a Scan All Measurement).

= Evaluation functions such as qualitative and quantitative analysis, and
transformation, rejection, and validation formulas are not available with
scan measurements. Any configured evaluation functions are ignored.

To configure a linear or area scan measurement:

1. Define the plate layout if it has not been done (refer to Section
8.2.2, Defining Plate Layout).

Select Scan (

B ADAP - [scan] M =1Ed

T File Layout

General] Huanhlatlve] Dual\talwe} Dphnns] Kinetic ~ Soan ] He|ect|ﬂnf\u"al|dat|nn]

Normal Scan Measurement / 96 Well Plate
[ Perform nomnal 5can measuremant
I I Y o o i
'1‘2 E‘I +'|I2

Select al Irvert Selection Deselect al

2. 24, 48, 36 Well Plate

‘whell:

Paints [Height and Width]: 4 -
Resolution: [ -

Scan All Measurement / 96 Well Plate

[ Perform ScansAll measurement

2. Figure 8-10).
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Figure 8-10: Scan tab (Zenyth 340 absorbance detector only)
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8.2.7.1.

\

Performing a Normal Scan Measurement

Normal Scan Measurement/96 Well Plate performs a linear scan of
measurement points across the center of each well measured on a 96-
well plate. The number and location of measurement points are user
defined.

=>This feature can ONLY be used with a 96-well plate

To perform a Normal Scan Measurement/96 Well Plate:
1. Select Perform normal Scan measurement.

2. Select each measurement point to be scanned individually.

= 25 measurement points are available and are labeled -12 to
+12, with point 0 being the center of the well.

OR

3. Choose a selection option:

4. Select all automatically selects all 25 measurement points, if
desired.

5. Deselect all deselects all measurement points, if desired.

6. Invert Selection selects the opposite set of measurement points from
those currently selected. Points selected before choosing Invert
Selection are deselected.

ADAP
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8.2.7.2.

8.2.7.3.

Performing an Area Scan Measurement

Area Scan Measurement/6, 12, 24, 48, 96 Well Plate performs an area scan of
measurement points arranged in grid across the well. The distance
between and number of measurement points are user-defined. Area
scan measurements may be performed on 6, 12, 24, 48, and 96 well
plates.

= The plate format must be defined in Define Plate before configuring an
area scan measurement (refer to Section 8.2.2, Defining Plate Layout).

To perform an Area Scan Measurement/6, 12, 24, 48, 96 Well Plate:
1. Select Perform Area Scan Measurement.

2. In Points (Height and Width), select the number of measurement
points.

\

= The number of points selected in Points defines how many points
will be measured both vertically and horizontally; for example
choosing 6 means that 36 measurement points will be laid out in
grid across the well.

=>The number of point selections available depends upon the plate
format selected in the plate layout. 12-well plates have a resolution
of about 20 x 20 points; 24-well plates about 14 x 14; 96-well
plates about 8 x 8. The exact resolution depends on plate type.

3. In Resolution, select the resolution, or space, between each
measurement point. The highest resolution value is 1, where the
distance between measurement points is the smallest.

= Well displays the layout and resolution of measurement points
currently selected. Reducing resolution maintains the same
coverage, but spaces fewer measurement points further apart;
increasing resolution adds measurement points to the same
coverage area.

Performing a Scan All Measurement

Scan All Measurement performs a linear scan of 27 measurement points
across the center of each well measured on a 96-well plate.

To perform a Scan All Measurement:

Select Perform Scan All Measurement.

ADAP
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8.2.8. Programming Rejection/Validation Formulas

Formulas programmed in Rejection/Validation are used to reject replicates
or invalidate tests that do not meet certain conditions. After the first
replicate elimination, the mean value of the remaining replicates is
recalculated and the condition re-evaluated. If necessary, the
elimination cycle is repeated. If the minimum number of replicates is
available, the test is considered valid. If not, the test is marked invalid
on the printout.

Rejection/Validation is divided into two sections:
4. Replicate Rejection — Programs up to 12 replicate rejection formulas
(refer to Section 8.2.8.1, Programming Replicate Rejection

Formulas).

5. Validation — Programs up to 12 validation formulas for tests (refer
to Section 8.2.8.2, Programming Test Validation Formulas).

To program replicate rejection or test validation formulas:

Select Rejection/Validation (Figure 8-11).

E# ADAP - [scan]

T File Layout -8 x

Replicate Rejection .
Mame  Formula kin. Repl Baze

aD
oD
oD
oD
[0 [oD

AT e A e

RO IRV IOV IV RV

L bl e L s

oo e M

Replicate Rejection 7 - 12

Yalidation
Formula Base

[¢re oD
¢ oD
= oo
= oD
= oD
|<- oD

M M e L Mt
Lele e lielie e}

Walidation Farmula 7-12

Figure 8-11: Rejection/Validation tab
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8.2.8.1.
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Programming Replicate Rejection Formulas

Replicate rejection formulas eliminate individual replicates which do not
fulfill conditions defined in the formula.

To program replicate rejection formulas:

1. In Name, enter the type of well to be evaluated by the formula; for
example use the label PC1 to evaluate wells that are defined as
PC1.

= Well types entered in Name should match those configured in
Define Layout (refer to Section 8.2.2, Defining Plate Layout).

2. In Formula, enter the replicate rejection formula used to evaluate
the replicates.

= The original measurement value, X, must be used in the
replicate rejection formula.

= Refer to Section 8.2.8.1.1, Replicate Rejection Examples for
examples of replicate rejection formulas.

= Replicate rejection formulas may contain any controls,
standards, or other variables that were previously defined in the
test. It is also possible to use numerical values, mathematical
operators (+,-,*%, /, (,), , <=, >=, =), and the additional
mathematical and logical operators listed in Table 8-3.

3. In Min. Repl. (Minimum Replicates), enter the minimum number of
replicates that must be left after elimination for the test to remain
valid.

= If, after elimination, the minimum number of replicates for a well
type is not met, the test is marked Invalid.

4. In Base, select the basis for the evaluation:
OD — the raw measurement value(s).

Transformation — Uses the results of the transformation formula as
defined in the Qualitative tab (refer to 8.2.4, Configuring a
Qualitative Evaluation).

Concentration — Uses the concentration value that is calculated by
applying the standard curve as configured in the Quantitative tab to
the absorbance measurement. (refer to 8.2.3, Configuring a
Quantitative Evaluation).

5. Repeat steps, 2 - 4 to program additional replicate rejection
formulas.

ADAP
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= A total of 12 replicate rejection formulas may be entered at one
time.

6. Choose Replicate Rejection 7 -12

Replicate Rejection 7-12

to toggle back and forth between formulas 1-6 and 7-12.

= When replicate rejection formulas 7 - 12 are displayed, Replicate
Rejection 7 - 12 is named Replicate Rejection 1 -6.
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8.2.8.1.1. Replicate Rejection Examples

Table 8-3 illustrates several practical applications where replicate
rejection formulas are used. All examples use the measurement data as
the Base for the evaluation of formulas. The Replicate Rejection formula is
applied to all wells of the type specified in Name when evaluating

replicates.

=> In replicate rejection formulas, the variable X can be used to refer to
the individual replicates of the control specified by in the previous
window under Name. The name itself refers to the mean value of
currently valid replicates. Both may be used in the same formula.

Application

Name

Replicate Rejection Formula

The absorption of a blank well may not
exceed 0.020 OD

BL

X<=0.02

The absorption of each negative control
well NC1 must be less than or equal to
0.150 OD.

NC1

X<=0.15

Each standard well S1 must not deviate
from the mean value of all standard wells
S1 by more than 20%.

S1

S$1*0.8<X<S1%*1.2

The absorption of each negative control
well NC1 must be less than 0.200 OD.
Additionally, they must not deviate from
the mean value of all negative control
wells NC1 by more than 30%.

NC1

X<0.2 AND 0.7*NC1<X<1.3*NC1

The absorption of each positive control
well PC1 must be greater than the mean
value of the first two standard wells (S1
and S2) and less than the mean value of
the last two standard wells (S3 and S4).

PC1

(S1+S2)*0.5<X<(S3+S4)*0.5

This formula uses the logical operator,
AND, to examine each individual replicate
of PC1 to find if it is smaller than the
mean plus 10% and if it is bigger than the
mean minus 10%.

PC1

X<PC1*1.1 AND X>PC1*.09

Table 8-3: Example replicate rejection formulas
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8.2.8.2. Programming Test Validation Formulas

Test validation formulas invalidate tests that do not meet certain
conditions. To program test validation formulas:

1. In Formula, enter the validation formula used to evaluate the test.

= Refer to Section 8.2.8.2.1, Test Validation Examples for
examples of validation formulas.

= The validation formula may contain any controls, standards, or
variables defined in the test, any numerical constants,
mathematical operators (+,-,*, /, (,), , <=, >=, =), and the
additional mathematical and logical operators listed in Table 8-3.

2. In Base, select the basis for the evaluation:
OD — the raw measurement value(s).

Transformation — Uses the results of the transformation formula as
defined in the Qualitative tab (refer to 8.2.4, Configuring a
Qualitative Evaluation).

Concentration — Uses the concentration value that is calculated by
applying the standard curve as configured in the Quantitative tab to
the absorbance measurement. (refer to 8.2.3, Configuring a
Quantitative Evaluation).

3. Repeat steps, 1 and 2 to program additional test validation
formulas.

= A total of 12 test validation formulas may be entered at one
time.

4. Choose Validation Formula 7 - 12 to toggle back and forth
between formulas 1-6 and 7-12.

= When validation formulas 7 — 12 are displayed, Validation Formula 7 -12
is named Validation Formula 1 - 6.
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8.2.8.2.1. Test Validation Examples

Table 8-4 illustrates several practical applications using test validation
formulas. All examples use the OD measurement data as the Base for
the evaluation of formulas.

Application Test Validation Formula

The test is valid only if the mean absorption value
of the positive control wells PC2 is less than or PC2<=0.8
equal to 0.8 OD.

The test is valid only if both controls are within the

. 0.1<=K1<=3.0 AND 0.1<=K2<=3.0
linear range of the photometer.

Table 8-4: Example test validation formulas
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8.2.8.3. Logical and Mathematical Operators

Replicate elimination and validation conditions may include any of the
logical or mathematical operators defined in Table 8-5.

Operator Definition
AND True if all conditions are fulfilled.
OR True if one of more of the
conditions is fulfilled.
NOT True if the condition is not fulfilled.
XOR True if exactl_y one of the conditions
is fulfilled.
ABS Absolute value.
POW Raises a number to the power of an
exponent.
SOR Returns the square root of a
number.
L Returns the natural logarithm of a
number.
CcVv CV% value of replicates
V Variable 1 to variable 6
F (Rejection formulas only) Well factor (dilution)
Actual well value of base (OD,
X (Rejection formulas only) Transformation, or Concentration)
during calculation

Table 8-5: Logical and mathematical operators
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8.3. Saving Test Definitions

When the plate layout and all required parameters for a test definition
have been properly configured, the test definition may be saved. Test
definitions must be saved before measurements can be performed.
To save a test definition and return to the main ADAP screen:

1. From the File menu, choose Save. The test definition is saved in
the database and may be used to run a test.

2. From the File menu, choose End to return to ADAP main screen.
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8.4.

Running Existing Tests

Tests may be run as soon as they are defined and saved. All test
definitions are stored in the ADAP software database.

To run a Test:

1.

2.

From the Reading menu, choose Single Test.

ORB

Selection appears (Figure 8-12).

15 items

Bradford Aszay
Bradiord Micro
Bradford Standard
dzDMA EMA 8 ELISA
dzDMA ENA B ELISA 2
EMNA BELISA

lalm Quantitation
MTT Cell Grawth
MADHdepletion
Dsptocin ELISA
Pierce GRO

update list Delete

b atchoode

Ok

LCancel

Figure 8-12: Selection - test definitions
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3. Select a test definition and choose OK. Numbers of Samples appears
(Figure 8-13).

= Choose Matchcode to search for test definitions by name (refer
to Section 8.7, Using Matchcode to Search for Test Definitions and
Saved Plates).

Numbers of Samples

Test Mame: Bradford Azzay

Mumberz of Samples:

(75

Ok

Figure 8-13: Number of Samples

4. Enter the number of samples to be measured on the plate and
choose OK. The measurement results screen appears and the
measurement procedure begins. After the measurement is
complete, the results are displayed (refer to Chapter 10, Viewing
Test and Multitest Assay Measurement Results).
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8.5. Editing, Copying, and Deleting Tests

Tests stored in the database can be edited, copied, or deleted using the
ADAP software.

= Tests may edited, copied, and deleted only by Level 2 (administrator)
and Level 3 (system administrator) users (refer to Chapter 2, User Login
and System Administration).

8.5.1. Editing Tests
Test definition parameters may be edited by Level 2 (administrator) and
Level 3 (system administrator) users (refer to Chapter 2, User Login and
System Administration).

To edit a test stored in memory:

1. From the Setup menu, choose Test Definition.

x

2. Select File>Open for current test definition options appear (Error!
eference source not found.).

OR

3. From the File menu, choose Open. Selection appears with a list of
saved tests (Figure 8-14).

15 items

BC4 Enhanced ~
BCA Standard

Bradford [Coomassie)
Bradford Assay
Bradford Micro
Bradford Standard
dsDM& EMA 8 ELISA

dsDMA ENA B ELISA 2

ENA& BELISA

IgG Qluantitation

MTT Cell Growth

MAD Hdepletion M

update list Dielete

|
Matchoode |
aK |
|

LCancel

Figure 8-14: Selection - test definitions
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4. Select a test to edit and choose OK. The chosen test definition
appears.

= Choose Matchcode to search for test definitions by name (refer
to Section 8.7, Using Matchcode to Search for Test Definitions and
Saved Plates).

5. Edit the desired test definition parameters.

= Refer to Section 8.2, Defining New Tests for detailed information
about defining test definition parameters.

6. From the File menu, choose Save. The test definition is saved in
the database and may be used to run a test.

7. From the File menu, choose End to return to ADAP main screen.

= Refer to Section 8.3, Saving Test Definitions for more
information about different methods of saving test definition data
and returning to the main ADAP screen.
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8.5.2. Copying Tests

Test definition parameters may be copied by Level 2 (administrator) and
Level 3 (system administrator) users (refer to Chapter 2, User Login and
System Administration).
To copy a test definition:

1. From the Setup menu, choose Calculation. ADAP test definition
options appear (Error! Reference source not found.).

x

Choose Create/Edit Calculation. ADAP test definition options
appear (Figure 8-15).

OR

COX]

% File Layout
General l Quantitative] Qualitative ] Optionz ] Kinetic ] Scan] Rejection / alidation
Test Hame Shaking
| [ Yes Time O Low
m @ tedium
Edit / Define Layout | C High
Instrument Mea nt Filter / Ref Filter
Measurement Filker [ ~ | nm
Zeryth - SMNeD1351 j Fieference Filter <oy - | nm
['ata Transfer Mode Plates A Parameter
V1 1] WE: a
Lokl W 0 WE: 1]
W3 1] W7 o
b va [0 v |0
Lat# Dependent Concentration S Cives
eck Variables
C Yes ® Mo ® No

Figure 8-15: ADAP software test definition options

2. From the File menu, choose Open. Selection appears with a list of
saved tests (Figure 8-16).
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15 items

BCA Enhanced -~
BCA Standard
Bradford [Coomassis]

Bradhord Assa
Bradford Micro
Bradford Standard

dsDNA EMA B ELISA
dsDNA EMA BELISA 2

EMN& B ELISA

lgG Quantitation

MTT Cell Growth
NADHdepletion -

update list Delete

|
Matchcods |
(i3 |
|

LCancel

Figure 8-16: Selection — Test definitions

Select a test to copy and choose OK. The chosen test definition
appears.

= Choose Matchcode to search for test definitions by name (refer
to Section 8.7, Using Matchcode to Search for Test Definitions and
Saved Plates).

In Test Name, enter a new name for the test (Figure 8-15).

= Test names cannot be longer than 20 characters in length.

From the File menu, choose Save. The test definition is saved in
instrument memory with the new name and may be used to run a
test.

From the File menu, choose End to return to ADAP main screen.

ADAP
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= Refer to Section 8.3, Saving Test Definitions for more
information about different methods of saving test definition data
and returning to the main ADAP screen.
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8.5.3. Deleting Tests
Test definition parameters may be deleted by Level 2 (administrator)
and Level 3 (system administrator) users (refer to Chapter 2, User Login
and System Administration).

To delete a test definition:

1. From the Setup menu, choose Calculation. ADAP test definition
options appear (Figure 8-17).

x

OR

Choose Create/Edit Calculation. ADAP test definition options
appear (Figure 8-17).

EEX

% File Layout =

General l Quantitativel Bualitative l Options l Kineticl Scanl Rejection / Walidation

Test Hame Shaking
| [ Yes Time O Low
(@ Medium
5 - )
Edit # Define Layout | O High
Instrument Measurement Filter / Reference Filter
Measurement Filker |<---> ﬂ nm
Zenyth - SNrO1351 ﬂ Reference Filter |<---> ﬂ him

Data Transfer Mode m Parameter
Y¥1: |0 Ve |0

Lottt W2 1] WE: 0

Wi a0 W 0

o W4 0 Wa: 0
Laot# Dependent Concentration ) Yes

N
Check Yariables
&
O Yes ® No Al

Figure 8-17: ADAP software test definition options

From the File menu, choose Open. Selection appears with a list of saved
saved tests (
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2.  Figure 8-18).

15 iterns

BCA Erhanced
BCA Standard
Bradford [Coornassie

Bradford Micro
Bradford Standard

dsDMA ENA 8 ELISA
dsDMNA EMNA B ELISA 2

EN& BELISA

1gG Quantitation

MTT Cell Growth
MADHdepletion v

update list Delete
Matcheods
LCancel

Figure 8-18: Selection - test definitions

3. Select a test definition(s) to delete.

= Choose Matchcode to search for test definitions by name (refer
to Section 8.7, Using Matchcode to Search for Test Definitions and
Saved Plates

= To select multiple test definitions, hold Ctrl while selecting each
test definition name.

4. Choose Delete. Message appears (Figure 8-19).
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@ Delete selected Tests?

Figure 8-19: Message — Delete selected Tests?

5. Choose Yes to delete the test definition, or No to cancel the
deletion and return to Selection.
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8.6. Printing Test Definitions

Test definitions may be printed out to provide a record of the test
protocol.

= Test definitions may be printed by Level 2 (administrator) and Level 3
(system administrator) users (refer to Chapter 2, User Login and
System Administration).

To print a test definition:

From the Setup menu, choose Calculation. ADAP test definition options
options appear (

1. Figure 8-21).

x

Choose Create/Edit Calculation. ADAP test definition options appears
appears (

OR

Figure 8-21)
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% File Layout -8 %
General l Quantitative] Qualitative ] Optiors ] Kinetic ] Scanl Rejection / Validation
Test Hame Shaking
| [~ Yes Time O Low
m @ Medium
Edit / Define Layout | O High
Instrument Meazurement Filter / Reference Filter
Measurement Filter [CO * | nm
Zenyth - SHrin3st ﬂ Reference Filter Lomry | nm
Data Transfer Made Flates A Parameter
W1 ] W a
Lot W2 0 WE: i}
W3 0 W7 i}
o we |0 LT [1]
Lot Dependent Concentration

) ) es
Check Variables Mo

Figure 8-20: ADAP software test definition options

From the File
appears with
(Figure 8-

15 items

BC& Enhanced ~
BCA& Standard

Eradford Standard

dsDMA ENA BELISA
dsDMA EMNA BELISA 2

EMNA& BELISA

1gG Guantitation

MTT Cell Grawth
MADHdepletion M

update list Delete

|
Matchoode |
K |
|

LCancel

menu, choose Open. Selection
a list of saved test definitions
23).

Figure 8-21: Selection - test definitions

Select a test to be printed and choose OK. The chosen test
definition appears.

= Choose Matchcode to search for test definitions by name (refer
to Section 8.7, Storing Measurements in the Database).
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4, From the File menu, select Print. Print appears (Figure 8-22).

& Print

Privter

Cptionsg
Faonts | @arial Unicode M5 ﬂ

Size .

(] Cancel |

Figure 8-22: Print

5. In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

6. In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

7. Choose OK to print the raw data.

= If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The
printed file is saved to the ADAP software home directory.
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8.7. Using Matchcode to Search for Test Definitions
and Saved Plates

Matchcode is the search feature that appears in Selection. Depending on
from which screen or tab Selection is accessed, Matchcode performs
searches for saved test definitions or measured plate results. Matchcode
provides wildcard operators which simplify the search procedure.

To search for measured plate results by plate ID, or test definitions by
name:

1. Choose Matchcode. Plate-ID appears.

2. In Input Plate-ID, enter a plate ID or test definition name.

=> Input Plate-ID appears when searching for a test definition name.

= The wildcards * and ? may be used in searches (refer to Table

8-6). Table 8-6.
Wildcard Pattern Result
Lists all plate IDs or test definition
*a* names with an a in the ID or

name.

Lists all plate IDs or test definition
a* names with an a at the beginning
of the ID or name.

Lists all plate IDs or test definition
*a names with an a at the end of the
ID or name.

Lists all plate IDs or test definition
alph? names with alph followed by an

' additional character. For example,
alpha or alphb.

Table 8-6: Matchcode wildcard operators

3. Choose OK. Plate IDs or test definition names that match the
search query appear in Selection.

=>» If Matchcode finds no matches to the search query, choose update
list to display the entire list of plate IDs or test definitions again.
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9. Defining and Running Multitest
Assays

9.1. Overview

= An ADAP Expert software license code is required to access the
functions described in this chapter.

Multitest assays combine up to 12 user-selected tests into one assay. Up
to six tests may be combined onto one plate. To define a Multitest
assay, test definitions are selected, sample IDs are assigned, and single
or multiple tests are selected to be performed on each sample ID. Based
on the parameters of the tests selected, the ADAP software
automatically creates plate layouts for the assay, combining tests on
plates, if possible.

= Multitest assays are ideal for use with commercial ELISA kits that use
removable well strips.

Defining and running Multitest assays includes:

4. Selecting tests to be performed (refer to Section 9.2, Defining a
Multitest Assay).

5. Assigning sample IDs and tests to specific samples (refer to Section
9.2.2, Assigning Sample IDs).

6. Creating and viewing plate layouts (refer to Section 9.2.3, Creating
and Viewing a Multitest Plate Layout).

7. Deleting Multitest configurations (refer to Section 9.3, Deleting
Multitest Configurations).

8. Performing the Multitest assay (refer to Section 9.4, Running a
Multitest Assay Measurement).
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9.2. Defining a Multitest Assay

Defining a Multitest assay is a four-step process:

Select up to twelve previously defined tests (refer to Section 9.2.1,
Selecting Tests to Use in a Multitest Assay).

Assign sample IDs (refer to Section 9.2.2, Assigning Sample IDs).

Select which tests will be performed on each sample ID (refer to
Section 9.2.2.3, Selecting Tests to Perform on Sample IDs).

Creating and Viewing a Multitest Plate Layouts (refer to Section
9.2.3, Creating and Viewing a Multitest Plate Layout).

= Multitest definitions are not saved to external files. Instead, all plates
configured for a Multitest assay are saved by default after the plate
layouts have been determined (refer to Section 9.2.3, Creating and
Viewing a Multitest Plate Layout).

To define a Multitest assay:

From the Setup menu, choose Multitest.

‘3§£E

OR L
BE ADAP - [Multitest]
“ES File  Windows - | & %
Select Test e
B election
Combine Samplel D T[2]3]4[6[6]7[8]Y
1o [ - | S P _[Sample 1 A
Sample 10 EAES
P - YES
2 | [ | m Sample 2 e
) PN | I ves Sample 3 FEAES
Sample 4 EAES
4 |<"'> ﬂ [ ves Sample & RS
[T EE ~| [ YES Sample B MR
| J Sample 7 EAES
[ |<---> j [~ ES Sample 8 HE
7 |<___> ﬂ ™ YES " Sample 9 EAES
I P | ™ Es
g < = vES
10 |<---> ﬂ ™ YES
11: e | I ¥ES
12 |<---> ﬂ [~ WES
Make view Plate Lapout |
Open Sample 1D File |
Delete parameters? | g | | D

Figure 9-1: Multitest assay definition
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9.2.1. Selecting Tests to Use in a Multitest Assay
Up to 12 previously defined tests may be selected for use in a Multitest
assay. Selected tests are not automatically performed on every sample
ID. The tests performed on each sample ID are selected independently.

To select the tests to use:

1. In Select Test, select up to 12 previously defined tests.

= All existing tests in the database are available for use in
multiplate assays.

2. For each test, select Combine to combine the tests onto one plate,
if desired.

= Multiple tests cannot be combined on a single plate.

= From the File menu, choose End or the End button to return to the
ADAP software main screen. Tests selected for the Multitest assay are
automatically saved.
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9.2.2. Assigning Sample IDs

\

Sample IDs must be assigned to wells before a Multitest assay can be
performed. Sample IDs may be entered manually or imported from text

files.

= The ADAP software is capable of handling up to 32,000 sample IDs at

a time.

9.2.2.1. Entering Sample IDs Manually

To enter sample IDs manually in a Multitest assay configuration:

1. In Select Sample IDs, click a SampleID field and enter the sample
ID (Figure 9-2).

= Sample IDs may not include spaces or exceed 20 characters in

length.

B ADAP - [Multitest]

&5 File  Windows

LB

Select Test

Combine

|Bradfold Micro

| TS

|Eradfold Aszay

| [ ES

| [ WES

| [ WES

| [ ES

| [ WES

| [ ES

= | [ ES

wom o mom e
~
R

| [ WES

| [ ES

= | [ ES

| [ ES

Makefiew Plate Layout |

Open Sample ID File |

Delete parameters? |

- g
Selection
SamplelD 1{2]3/4|5]6[7]8]19
P |Sample 1 A
Sample 10 A
Sample 2 e
Sample 3 A
Sarnple 4 e
Sampls 5 A
Sampl= B Bk
Sample 7 e
Sampls 8 A
Sarnplz 9 e
*
4 | >

Figure 9-2: Multitest assay with tests selected and sample IDs assigned

2. Repeat step 1 for as many sample IDs as desired.

= Up to 32,000 sample IDs may be assigned to wells.
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9.2.2.2. Importing Sample IDs from Text Files

Sample IDs can be imported from text (*.txt) files. To import correctly,
each sample ID must be listed on a separate line in the text file.

= The ADAP software is capable of handling up to 32,000 sample IDs at
a time.

To import a text file:
1.  From the File menu, choose Open.

OR
Choose Open Sample ID File. Open appears

2. Browse to and select the desired sample ID text file to import, and
then choose Open. The list of sample IDs is imported to the
Multitest assay configuration.
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9.2.2.3.

9.2.2.4.

\

Selecting Tests to Perform on Sample IDs

After assighing sample IDs, the specific tests to perform on each must
be selected.

To select tests to perform on sample IDs:
1. In Select Sample IDs, click the desired test selection field(s) next to

each sample ID. An X indicates the test will be performed on the
sample ID.

= Deselect a specific test by clicking the X in the test selection
field.

A test may be selected or deselected for all sample IDs by clicking
the test number in the header line of Select Sample IDs.

2. Repeat until all desired tests are assigned to the desired sample
IDs.

3.  When all sample IDs and tests are configured, choose View/Make
Plate Layout to set up and view the plate layout for the Multitest
assay (refer to Section 9.2.3, Creating and Viewing a Multitest Plate
Layout).

= Choose Select Sample IDs to toggle to Sort Sample IDs (refer to
Section 9.2.2.4, Sorting Sample Sequences).

Sorting Sample Sequences

Sample IDs may be sorted into groups based on tests performed. To
sort sample IDs:

1. Choose Select Sample IDs. The mode toggles to Sort Sample IDs.

2. Click the test number header to sort sample IDs by test performed.
For example, choosing test 3 sorts all sample IDs on which test 3
will be performed. Sample IDs that meet the sort criteria are
grouped to the top of the list.

= Sample IDs can only be sorted by one test at a time.

= Click the Sample ID column header to sort the list back into
ascending order by Sample ID.

= Choose Sort Sample IDs to toggle to Select Sample IDs (refer to
Section 9.2.2.3, Selecting Tests to Perform on Sample IDs).

ADAP
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9.2.3. Creating and Viewing a Multitest Plate Layout

After sample IDs and tests have been assigned, the ADAP software
needs to create plate layouts for the Multitest assay. If tests cannot, or
are not selected to be combined, several plate layouts are designed for
the assay.

= Multiple tests cannot be combined on a single plate.

To create and view the Multitest plate layout:

From Multitest, choose View/Make Plate Layout. Plate Layout

appears (Figure 9-3).
Plate Layout E

12 & 4 8 & 7 & g 1] 1] 12 e )

1151 51 51 Samp l:“:‘ Bradford Micro

Z|s2 52 s2  Samp N

3|53 53 §3  Samp

4|54 54 54 Samp =E

5|55 55 S5  Samp

Bl 56 56 Samp [ |l

7| BLAN BLAN BLAN Samp o

8| Samp Samp Samp 13/05/2011-10:55-M1

Previous Flate | Mext Plate |

Print |
ik ]

Figure 9-3: Plate Layout

The plate ID appears below the color key.

= Choose OK to close Plate Layout and return to Multitest.
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9.2.3.1. Viewing Additional Multitest Plate Layouts

Multiple plates are designed for the Multitest assay when Combine is not
selected, test parameters are incompatible, or there are more samples
in the assay than can fit on one plate.

To view all plates in the Multitest assay:

Choose Next Plate to display the layout for the following plate.
OR

Choose Previous Plate to view the layout for the preceding plate.

= Choose OK to close Plate Layout and return to Multitest.

9.2.3.2. Printing Multitest Layout Information

Multitest plate layout information can be printed for record-keeping
purposes. To print the Multitest layout:

1. Choose Print. Print appears (Figure 9-4).

& Print

Prirter

Options
Fontz | (Adnial Unicode M5 ﬂ

Size g -

k. Cancel |

Figure 9-4: Print — Multitest layout

2. In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

3. In Options, select the desired Font and text Size.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

4. Choose OK to print the layout information. The position and plate
where each sample ID is located is printed.
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=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears.
The printed file is saved to the ADAP software home directory.
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9.3.

Deleting Multitest Configurations

The current Multitest configuration, which includes selected tests,

sample IDs, and plate layouts, can be deleted to start a new Multitest
configuration.

=>» Multitest configurations are not saved to an external file. All plates
configured for a Multitest assay are saved by default when the Multitest
plate layout has been determined.

To delete the existing selections and layouts,
1. Choose Delete Parameters.

OR

From the File menu, choose New. Message appears (Figure 9-5).

Warning: Delete current Layout!

0K Cancel |

Figure 9-5: Message - Delete current Layout
2. Choose OK to delete the current configuration.

OR

Choose Cancel to return to the current configuration.

ADAP
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9.4.

Running a Multitest Assay Measurement

Once a Multitest assay has been configured and the plate layouts
designed, the measurement can be performed.

To perform a Multitest assay measurement:

1.

In the ADAP software main screen, from the Reading menu, choose
Multitest.

B>

Choose Measure Multitest. Plate Selection appears (Figure 9-6).

[ Plate sel... [X]

13205200 1-10:58-4-1
13/05/2011-10:58-M-2

OR

Delete Plate after
FReading fram List

ok

LCancel

Figure 9-6: Plate selection
Select the desired plate to measure.

Choose OK to begin the measurement of all tests on the specified
plate.

= To manage the sometimes large humber of plates designed for
Multitest assays, select Delete Plate after Reading from List to
delete the plate layout after the measurement has been performed.

OR

ADAP
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Choose Cancel to return to the ADAP software main screen.

After the all tests are completed and evaluated, the test results are
displayed in the ADAP software main screen.
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10. Viewing Test and Multitest Assay
Measurement Results

10.1.0verview

= An ADAP Plus or ADAP Expert software license code is required to
access the functions described in this chapter.

After performing a test or multitest measurement, the results are
displayed in a series of tabs in the ADAP software main window. The
tabs displayed vary depending on the type of measurement performed,
the instrument capability, and options selected in the test definition
(refer to Chapter 8, Defining and Running Tests).

Measurement results are stored in the ADAP software database and may
be exported to another application or printed.

Measurement data can be:

4. Viewed in the ADAP software (refer to Section 10.2, Viewing Test
Measurement Results 10.3, Viewing Multitest Measurement
Results).

5. Recalculated with different parameters following the measurement
(refer to Section 10.4, Recalculating Test Results).

6. Printed to view and store a hard copy (refer to Section 10.5,
Printing Measurement Results).

7. Exported to view in another application (refer to Section 10.6,
Exporting Measurement Results to Other Applications).

8. Stored in the ADAP software database (refer to Section 10.7,
Storing Measurements in the Database).

ADAP ADAP Software Operating Manual 10-13



\

10.2. Viewing Test Measurement Results

Test measurement results are displayed in a series of tabs in the ADAP
software main window. The tabs displayed depend on the type of
measurement performed, the capabilities of the instrument, and options
selected in the test definition.

Test measurement results include:

= The following results screens are identical to the results screens
shown for Quick measurements, and appear depending on type of
measurement performed, instrument capabilities, and options selected
in the test definition. Refer to Chapter 7, Viewing Quick Measurement
Results, for more information.

OD — in photometric measurement results, displays the optical
density measurement for each well measured (refer to Section
7.3.1.1, Viewing Optical Density (OD) Measurement Results).

Status — in all measurements, displays the status for all measured
wells (refer to Section 7.3.1.2, Viewing Sample Status).

Raw Data Kinetic — in kinetic measurements, displays measurement
results for each cycle of a kinetic photometric measurement (refer
to Section 7.3.2.2, Viewing Kinetic Measurement Raw Data).

Kinetic Graph — in kinetic measurements, displays a graph of the
kinetic results over time for each well (refer to Section 7.3.2.3,
Viewing Kinetic Measurement Graphs).

Raw Data Scan — in linear scan measurements, displays the values
for each of the 25 points measured across wells. In area scan
measurements, displays the values for all points measured within
wells on the plate (refer to Section 7.3.6.2, Viewing Area Scan
Transmission Profiles).

Scan — in linear scan measurements, displays a graph of the linear
absorption profile for each well on the plate (refer to Section
7.3.4.2, Viewing Linear Scan Graphs). In area scan measurements,
displays a three-dimensional graph of the results of the area scan
from each well (refer to Section 7.3.6.2, Viewing Area Scan
Transmission Profiles).

Curve Info — in multiwavelength measurements, displays the OD
and transmission values at each wavelength measured for a single
sample (refer to Section 7.3.3.4, Viewing Multiwavelength
Measurement Curve Info). In linear scan measurements, displays
the transmission values for a single sample at all measurement

ADAP
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points (refer to Section 7.3.4.4, Viewing Linear Scan Curve Info).
The ADAP Plus and ADAP Expert software display additional details
about curve peaks, valleys, and average slope.

= The following results screens appear depending on the type of
measurement performed, instrument capabilities, and options
selected in the test definition.

Mean — Displays mean values of replicates based on the mean
calculation mode selected in the test definition (refer to Section
10.2.1, Viewing Mean Results Data).

Transform — Displays calculated measurement values for each well
based on the transformation formula entered in the test definition
(refer to Section 10.2.2, Viewing Transformation Formula Results).

Concentration — Displays calculated concentration of each well based
on the standard curve data entered in the test definition (refer to
Section 10.2.3, Viewing Concentration Results).

Concentration Transformation — Displays calculated concentration
values for each well based on the concentration transformation
formula entered in the test definition (refer to Section Error!
Reference source not found., Error! Reference source not
found.)

Qualitative — Displays the cutoff group name for each well if cutoff
formulas and groups are configured in the test definition (refer to
Section 10.2.4, Viewing Qualitative Results).

Plate Layout — Displays the layout of the plate as defined in the test
definition (refer to Section 10.2.5, Viewing Plate Layout).

Sample ID — Displays the sample identification number for each well
(refer to Section Error! Reference source not found., Error!
ference source not found.).

CV% — Displays the coefficient of variation of the mean values of a
replicate group (refer to Section 10.2.6, Viewing CV% Results).

Factor — Displays multiplication factors for each well as defined in
the test definition (refer to Section 10.2.7, Viewing Factor).

Standard Curves — Displays the standard curve of the measurement
if quantitative parameters are configured in the test definition
(refer to Section 10.2.8, Viewing Standard Curves)

Test Status — Displays a summary of all steps in a test definition,
indicating if each step was performed correctly or if there was an
error (refer to Section 10.2.9, Viewing Test Status Information).
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Evaluation Summary — Displays a summary of test evaluation data
(refer to Section 10.2.10, Viewing Evaluation Summary Results).

= In any measurement result screen that displays the results in
plate layout format, double-click on a well position to see a
summary of measurement results for the well.
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10.2.1. Viewing Mean Results Data

Mean displays the mean value of each replicate group on the plate
(Figure 10-1). The mean value is displayed in the first position of the
replicate group.

= For a kinetic measurement, the Mean value represents the mean of
the data reduction value for each replicate group.

=> If replicates are not used in the test definition, the Mean tab displays
the same values as OD.

B ADAP - [20110513-3 BCA Enhanced] M=
Database Reading Setup Help B |:|"
1 ! L Z
'Qt:lrtyj: = x p 30%%22@ -
= | /4 Instrument
b i av & [Zerth - SNRO1351 ]
ap ug/ml ] Plate La}lout] Sample-ID] Oy ] Factor ] Glaphic] Info-CalcuIation] Hesult-List] Status ]
1 2 3 4 &5 B 7 g 9 10 11 12
A 0030 -0.073 0186 -0.188
? 0122 0.maz2 -0.0028 0128
? 0.053 0.005 nme -0.030
F 0.0Me 0.007 0.009 -0.050
? -0.006 0.004 nmz2 0my
T 0.236 0.043 -D. -0.094
F -0.001 0013 0.040 -0.041
: -0.025 -0.003 -0.005 -0.001

Figure 10-1: Measurement results - Mean
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10.2.2. Viewing Transformation Formula Results

Transform (Figure 10-2) displays measurement values for each well
calculated using the transformation formula configured in Qualitative
(refer to Section 8.2.4, Configuring a Qualitative Evaluation).

=> Transform is the default label for this tab. If Units for the
transformation formula is defined, that name appears instead (refer to
Section 8.2.4.3, Configuring a Transformation Formula).

B ADAP - [20110513-4 ENA 8 ELISA] M=1Ed
Database Reading Setup Help - 8 %
- NER— & B = p - @ :
- ti Eillj— = b 4 ip %E -
Al = | & Instrument
b & = | V| R [Zenyth - SNED135T | :
ap _'_'_._._'_‘Elﬂesults I Plate La_l,Jout] OV ]Factol ]Info-CaIcuIation] Hesult-List] Status I
1 [ 2 ] s ] 4 ] s ] e [ 7 ] e | 8 | w0 | n] 1
&| 0BS | 2222 1125 | 1EI3 | 2624 | 2019 0398 | 2443 1182 | 2666 1570 | OEF
B
C
D
—
E
F
G
H

Figure 10-2: Measurement results - Transformation
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10.2.3.
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Viewing Concentration Results

If standard curve parameters were configured in Quantitative, Concentrat
displays the calculated concentration of each well based on the standard
curve data results (refer to Section 8.2.3, Configuring a Quantitative
Evaluation).

=> Values outside of the valid range of the standard curve are displayed
as < or >.

= Concentrat is the default label for this tab. If Units for the standard
curve is defined, that name appears instead (refer to Section 8.2.3.2,
Configuring Standard Curve Parameters).

B ADAP Software - [20110524-1 BCA Enhanced] M=
Database Reading Setup Help - 8 x
1 ! A \ gL
=’ Eill:l; = T P =|D”QD \;E@ -
b Al=| & Instrument
=| V| R [Simulator - SNr0T00D | :
oD l Flate La_l,lout] Sample-ID] O ] Factar ] Graphic] Info-Calculation] Flesult-List] Status ]
1 A [ & | 7 ] 8 | 8 ] w0 | un |
&1 2500 <5.000 32,06 <5.000
B| »2500 61.08 8613 <5.000
C| 4071 59.20 <5.000 2489
D| 2181 <5.000 9313 <5.000
E| <5000 10,47 181.5 <5.000
F = 3176 <5.000
G| 5525 <5.000 <5.000 10,03
H| 9011 5356 2500 7.685
Figure 10-3: Measurement results - Concentrations
ADAP ADAP Software Operating Manual 10-19



10.2.4. Viewing Qualitative Results

Results displays cutoff group names for each well (Figure 10-4). Cutoff
groups are created by configuring cutoff formulas in Qualitative (refer to
Section 8.2.4, Configuring a Qualitative Evaluation).

B ADAP - [20110513-4 ENA 8 ELISA] =13
Database Reading Setup Help -
) 1 I L z
L’tity:l;lﬁl T b :ID’('?D%ZE% -
Al=|ra Instrument =
b & =| V| ks [Zempth - SNe01351 ]
ap ]Mean ]Transforma l F'IateLa_l,lout] Cwz ]Factor ]Info-EaIcuIation] Hesult-List] Status ]
1T ] 2 e ] e s s | 7] e ] s ] w0 11 12
A | Megative | Positive | Equivocal | Positive Pozitive Pozitive | Megative = Positive | Equivocal | Positive Pozitive | Megative
6|
|
B
€|
]
5|
™

Figure 10-4: Measurement results - Results
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10.2.5. Viewing Plate Layout

Plate Layout (Figure 10-5) displays the layout of the plate as defined in
the test definition (refer to Section 8.2.2, Defining Plate Layout).

B ADAP - [20110513-4 ENA 8 ELISA] M=
Database Reading Setup Help =
) 1 = L =l Z ’
BERREEs T 52XP &
Al =| Instrument =
b & 2 V| [Zenpth - SNrOT351 = @
oo tl CvWx ]Factor llnfo-CaIculationl Flesult-List] Status I
1T [ 2 ] s ] e s s 7 ] s ] s ] ] ] e
A HCT P PR PR2 PR3 PR4 PRS PRE PR7 PRE PRI | PRID
B
C
D
E
F
o]
M

Figure 10-5: Measurement results - Plate Layout
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10.2.5.1. Manually Entering Sample IDs

Sample IDs may be entered one at a time for individual wells. To
manually enter sample IDs:

1. Choose Sample-ID.

2. From the Options menu, choose Edit Sample-ID>Manual
(Figure 10-6).

= The Edit Sample-ID function is only available when Sample-ID is
the tab displayed.

B ADAP CEX
OEIGliGEEN Reading Setup  Help =]

"= Open Saved Plate & = p %E
8 save Actual Data B “Ip ’E} Z b -
Save as TAT file Instrument
i [Zength - SMKO1351 =l

Delete Plates

Export Database
tifi  Repair Database
Compress Database

Views Log Table
—1 Frint Ctrl+P
B opiors = [ “Eitsompied g ool e
1 End Formula 4 File H12xV8

i Af
Delete Well fﬂst: HfS:. 12 .
Restore Well ist of Sample

Copy all data into clipbeard
Copy displayed data into clipboard

2
B
|
5|
|
7|
o

Figure 10-6: Edit Sample-ID
3. Click the desired well in the layout and enter the new sample ID.
4. Repeat step 3 until all desired sample IDs are entered.
10.2.5.2. Importing Sample IDs from Text Files

Sample IDs may be imported from standard text files or text files
configured specifically for 96-well plates.

To import sample IDs from a text file:
1. Choose Sample-ID.

2. In the Option menu, select Edit Sample-ID>:

ADAP
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3. File H12 x V8 to import a text file specifically configured for a
96-well plate with 12 horizontal positions and 8 vertical positions.

OR

4. File H8 x V12 to import a text file specifically configured for a
96-well plate with 8 horizontal positions and 12 vertical positions.

OR
5. List of Sample-ID to import any text file.

= Sample IDs in a standard text file must be listed on separate
lines.
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10.2.5.3. Viewing, Printing, and Copying Individual Sample ID

Information

Test information relevant to each sample ID well may be viewed, printed
or copied to another file. Sample ID information that may be viewed
includes sample ID, test name, well data results, plate layout position,
plate number, and validation status.

To view individual sample ID information:

1.Choose List Sample-ID. Selection appears (Figure 10-7).

16 items

Sample 1

Sample 10

Sample 2

Sample 3

Sample 4

Sample 5 W

fram: nz/01 /201 |
tor 13/05/2011 = |

update ligt |

|
Matchcode |
i3 l
|

Lancel

Figure 10-7: Selection — sample IDs

2. Select the desired sample ID to view and choose OK. Result-List

appears (Figure 10-8)

= To select several sample IDs to display in Result-List, hold Ctrl
while selecting sample IDs.

= Choose Matchcode to search for specific sample IDs by
characters in the sample ID name (refer to Section 8.7,Using
Matchcode to Search for Test Definitions and Saved Plates).
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8 ADAP - [Result-List]

Close  Print

Clipboard  Windows

Test Mame Fiesult Date Flate-ID
Bradford Micro Lo 1.051 00 08/04/2011 HS 201104081
Bradford [Coomassie] Lo 1.051 00 08/04/2011 H5 201104081
Bradford Standard Lo 1.051 00 08/04/2011 H5 201104081
Bradford [Coomassie] < -0.898 0D 07/04/2011 HS 2011040741
Bradford Micro Lo -0.892 0D 07/04/2011 H5 201104071
Bradford Standard Lo -0.892 0D 07/04/2011 HS 201104071
Sample-0: 2

Test Mame Results Result Date Pos Plate-1D
Bradford Micio Lo 111800 08/04/2011 HE 2011040841
Bradford [Coomassie] Lo 111800 08/04/2011 HE 201104081
Bradford Standard Lo 111800 08/04/2011 HE 201104081
Bradford [Coomassie] Lo 002300 07/04/2011 HE 201104071
Bradford Micro Lo 002300 07/04/2011 HE 201104071
Bradford Standard Lo 002300 07./04/2011 HE 201104071
Sample-D: 3

Test Mame Results Result Date Pos Plate-1D
Bradford Micro Lo -1.858 0D 08/04/2011 A12 201104081
Bradford [Coomassie] Lo -1.858 0D 08/04/2011 A12 201104081
Bradford Standard Lo -1.858 0D 08/04/2011 Al2 2011040841
Bradford Micro Lo 0386 00 08/04/2011 Ad 201104081
Bradford [Coomassie] Lo 0386 00 08/04/2011 Ad 201104081
Bradford Standard Lo 0386 00 08/04/2011 A4 201104081
Bradford [Coomassie] Lo -2.834 0D 07/04/2011 A12 201104071
Bradford Micro Lo -2.834 0D 07/04/2011 A12 201104071
Bradford Standard Lo -2.834 0D 07/04/2011 A12 201104071
Bradford [Coomassie] Lo -1.751 0D 07/04/2011 Ad 201104071
Bradfard Micro L -1.751 0D 07/04/2011 A4 201104071
Bradford Standard Lo -1.751 0D 07/04/2011 Ad 201104071
Sample-0: 345

T ~nk bl S, [= ey .I;. =y - [= Y =]l

Figure 10-8: Sample ID information in Result-List

= If a sample ID has been used in several tests, results for all tests are
displayed by date in Result-List.

=> Choose Close to return to the test measurement results.

The sample ID data in Result List can be printed or copied into another

application.
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3. To print the contents of Result-List, refer to Section 10.2.5.3.1,
Printing Sample ID Information.

4. To copy the contents of Result-List so that it can be used in another
application, refer to Section 10.2.5.3.2, Copying Sample ID
Information to another Application.
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10.2.5.3.1. Printing Sample ID Information

Sample ID data displayed in Result-List may be printed. To print sample
ID data:

1.

Choose Print. Print appears (Figure 10-9).

% Print

Printer

[~ Form feed after each Sample-D

O ptions
Fontz |@-‘-‘-.rial Ilhicode MS j
Copies 1 * | Size g -

] 4 Lancel |

Figure 10-9: Print — Result List

In Printer, select the desired printer to use to print the information.
All printers that are properly installed and configured on the
computer are listed.

In Mode, select Form feed after each Sample-ID to print each
sample ID on a separate page, if desired.

In Options, select the desired Font for the report, the Size of the
printed text, and the number of Copies to print.

= Body text is printed in the selected Font and Size. Headlines,
headings, and table text are printed using formatting defined by
the ADAP software.

Choose OK to print the raw data.

Choose OK to print the sample ID data, or Cancel to abort
printing.
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=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears. The
printed file is saved to the ADAP software home directory.
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10.2.5.3.2. Copying Sample ID Information to another
Application

Sample ID data can be copied into another application, such as a word
processor, using the clipboard.

To copy sample ID data to the clipboard:
1. Choose Clipboard. Sample ID data is copied to the clipboard.

2. Open or switch to the application you want to paste the sample ID
data to, and paste the data.

= Most applications have CTRL+V assigned as the Paste command
keyboard shortcut.

= Choose Close to return to the Multitest results.
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10.2.6. Viewing CV% Results

CV% displays the coefficient of variation of the mean values of a
replicate group (Figure 10-10). To calculate a CV, a sample or well type
must have at least 2 replicates. The CV% value is displayed in the first
position of the replicate group. If there are no replicates for a well type,
the CV for the well is displayed as 0.

= The formula for CV% is standard deviation divided by mean value,
multiplied by 100.

B ADAP - [20110513-3 BCA Enhanced]

EEX

Database Reading Setup Help = |=
1 ! il L
"=“t:inID= = T P ED%%Eb -
A= Instrument
b @ = | V | [Zergth - GNrO3E =l
oo ] Mean ] ug/mlL ] Plate Layout Factor ] Graphic] Info-EaIc:uIation] Hesult-List] Statug ]
1 2 3 4 5 B 7 g 3 10 1 12
& 30.80 2778 E.793 2444
; 5B.43 2204 21.85 094
? 56.50 23m 2315 31.96
? 5737 1.921 9738 8.951
? 1217 E.723 0422 13.95
? 17.62 14.00 £4.32 55.22
? 21.87 1512 0453 2458
: 7536 8172 23.04 30.48

Figure 10-10: Measurement results - CV%
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10.2.7. Viewing Factor

Factor (Figure 10-11) displays the multiplication factors for each well
configured in Define Layout in the test definition (refer to Section 8.2.2.4,
8.2.2.4. Entering Dilution Factors for Wells).

i ADAP - [20110513-3 BCA Enhanced]

Database Reading Setup Help -8 x

"=‘E§rt5||j'= = bl EIDP\JDEEb —

NOEE

Instrument
‘Zenyth - 3

SMr01351

=l

oD ] Mean ] ugd/mb ] Plate Layout] Wz F l Graphic} Info-Calculat\on] F!esult-List} Status ]
1 2 3 4 5 E 7 8 9 10 1 12
A 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
B 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
C 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
D 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
E 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
F 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
G 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
H 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000 1.000
Figure 10-11: Measurement results - Factor
ADAP ADAP Software Operating Manual 10-32



\

10.2.8. Viewing Standard Curves

Graphic ( Figure 10-12) displays the standard curve based on the
results of the concentration and response formula configured in
Quantitative in the test definition (refer to Section 8.2.3, Configuring a
Quantitative Evaluation).

= If the ADAP main window is resized, choose Refresh Graph to redraw
the graph display so that it fits the new window size properly.

= To copy the standard curve graph, right-click on the graph and
choose Copy graph into clipboard. The graph can then be pasted into
another application such as a word processor.

B ADAP - [231110mBCA20104 Micro BCA 2010]

File  Measurement Setup Help = (8 o
1
= E_i,l:'; L — S
b Al=| rd Instrument
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Figure 10-12: Standard curve displayed in measurement results — Graphic tab
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10.2.9.

Viewing Test Status Information

Info-Calculation displays a summary of each step in the test definition
and indicates if each step was successful or failed (Figure 10-13).
Results are displayed as OK or Error.

B ADAP - [231110mBCA20104 Micro BCA 2010] =13
g X

File Measurement Setup Help £

==Y -

b Al ra Instrument
=| V |k [EZReaddl0 - SHrO3039 =

oD ] Mean ] g/l I Flate Layout] Cvz } Factor ] Graphic ] Hesult-List} Status ]

Test Name: Micro BCA 2010

Step Result
Heas. WValues 0K
Calculating Blank [8)'4
Calculating Replicates OK
Calculating CVE [8)'4
Rejecting REeplicate. CD OK
Rejecting Replicate. ¢———:3 [8)'4
Response-Fornula OK
Curve 0K
Rejecting Eeplicate. ug-nl 0K
Rejecting Replicate. <———: OK

Figure 10-13: Measurement results — Info Calculations
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10.2.10. Viewing Evaluation Summary Results

Result-List (Figure 10-14) displays a summary of test evaluation data
including standard curve results, cutoff groups, replicate rejection and
test validation formula summaries, and individual well data (Figure

= Use the scroll bar to view all information displayed in Result-List.

=> This Result-List contains different data than the Result-List for
individual sample IDs (refer to Section 10.2.5.3, Viewing, Printing, and
Copying Individual Sample ID Information).

i ADAP - [231110mBCA20104 Micro BCA 2010]

File Measurement Setup Help - |5 x
]
| t!; taE; L —
b y = | Instrurent
= | V| & |[EZReaddin - SMiD203G 2|
oo ] Mean ] ug/ml ] Plate Laynut] w3 ] Factar ] Graphic] Info - Calculation
Micro BCA 2010 Plate-ID 231110nBCAZ0104 -
Standards
Respon=e Formula nominal adjusted oD
S1 200. 00 200.00 2.181
s2 40.00 40.00 0.604
53 20.00 20.00 0.326
S4 10.00 10.00 0.140
=13 5.00 5.00 0.058
S6 2.50 2.50 0.021
S7 1.00 1.00 0.020
S8 0.50 0.50 -0.002
Point to Point
Awi= (¥-Y): linslog
Interpretation (0D)
Validation
Eeplicate Rejection
Sanple list
Sanple-10 Po=zition ug-/mL oD Fesult:
PR1 AS 10.33 0.149 N

Figure 10-14: Measurement results — Result-List
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10.3. Viewing Multitest Measurement Results

= An ADAP Expert software license code is required to perform Multitest
measurements and view the results.

After a Multitest measurement is completed, all applicable measurement
results are displayed for each test performed. Measurement results are
displayed one test at a time (Figure 10-15).

B ADAP - [20110513-9 Bradford Assay] M(=1E3
- 8 x

Database Reading Setup Help
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n1os 0.032 003 0118

0o 0.108 nn4a 0.104

oA 0.053 nnz 0110

=]
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0106 011z o7 0.036

nm 0102 007 0112

0036 0.100 0104 0.03z2
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Figure 10-15: Multitest measurement results

= Refer to Section 7.3, Viewing Quick Measurement Results, and
Section 10.2, Viewing Test Measurement Results, to learn more about
the individual measurement result tabs.

To view results from another test on the plate:

Choose next Test to view the following test results.
OR

Choose previous Test to view the preceding test results.

ADAP ADAP Software Operating Manual 10-36



\

10.4. Recalculating Test Results

10.4.1.

Once the measurement has been completed, raw data associated with
the test can be recalculated with different parameters, such as cutoff
formulas, validation formulas, standards, and standard curve fits.

Individual wells may be rejected as outliers. Tests can be recalculated

with these outliers eliminated.

= Only tests may be recalculated; Quick measurements may not.

Recalculating Test Results
To recalculate results:

1. From the Options menu, select Formula.

OR

Right-click on the displayed measurement results, and select
Formula. The name of the most recently run test appears (Figure

10-16).

B ADAP - [20110513-10 Bradford Assay]

WEELEEEN Reading  Setup  Help - |5 x
Open Saved Plate % = g(\ %:E
2 save Actual Data B =|D ‘E) T & —
i Save as TAT file Instrument
Delete Flates [Zenyth - SNeO13S1 =] 4
|| Export Database
00 Repair Database Sample-ID] v ] Factar ] Graphic:] Info-EaIcuIation] Hesult-List] Status ]
Compress Database
View Log Table
—  Print Ctri+P . . . . . . .
B opons e e Ty
A End Delete Well Bradford Standard
B 0.024 0,106 0.044 1 Restore Well
? 0.07 0.083 0112 i Copy all data into clipboard
— Copy displayed data into clipboard
0| 0123 0103 0103 e
E 0,106 011z 0107 0.036
F| 01m 0102 0.097 011z
G| 0086 0100 0104 0.032
H| 0091 0104 0100
Figure 10-16: Choosing Point_2, the most recently run test, to
recalculate
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2. Choose the test definition name. A window named for the test
definition name appears (Figure 10-17).

Bradford Standard

Cutoff Formula Standards
: | Rezponse Formula Concentration
2 | 1151 1500
3 2 |sz [1000
% | + |53 750
4 |54 |500
Yalidation B |55 |25|:|
1 B 56 [125
2 | 7 |57 25
2 | A P =
i I P =
5 | 10 s =
oK. | Curve | 4-Paramter Fit j
Cancel | Az [+ |I|n:'|u:|g ﬂ

Figure 10-17: Point_2 to recalculate

3. In Cutoff Formula, if desired, enter up to four new formulas to create
new cutoff groups (refer to Section 8.2.4.1, Configuring Groups and
Cutoff Formulas).

4. In Validation, if desired, enter up to five new test validation
formulas to use to validate the measurement results (refer to
Section 8.2.8, Programming Rejection/Validation Formulas).

5. In Standards, if desired, enter new response formulas and
concentrations to create a new standard curve and recalculate
concentration values (refer to Section 8.2.3.1, Configuring
Standards).

6. In Standards, if desired, choose a new Curve fit method to plot a new
standard curve and recalculate the concentration values (refer to
Section 8.2.3.2, Configuring Standard Curve Parameters).

7. In Standards, if desired, select a new AXis scale to plot the standard
curve on a new scale (refer to Section 8.2.3.2, Configuring
Standard Curve Parameters).
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When the new parameters have been entered as desired, choose
OK. The test is automatically recalculated and the new
measurement results displayed.

= A message may appear stating that the plate data exists (Figure
10-18). Choose Yes to overwrite the existing plate data with the
recalculated plate data, No to enter a new plate ID and save the
recalculated plate data as a separate plate, or Cancel to cancel any
changes and return to the measurement results of the test.

Message

Plate 20110513-10 Exists. Delete old data?

Yes Mo Cancel

Figure 10-18: Plate data exists message

OR

Choose Cancel to cancel any changes and return to the original
test measurement results.

ADAP
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10.4.2.

Rejecting Outliers and Recalculating Results

Individual wells may be rejected as outliers. Tests can be recalculated
with these outliers eliminated.

To reject outliers and recalculate test results:

1.

In any measurement results tab that displays well data in plate
format, click the well to reject.

From the Options menu, choose Delete Well.

OR

Right click the well to reject and select Delete Well. The selected
well is labeled Rejected.

= To reject multiple wells simultaneously, click and drag over the
wells to be rejected and choose Delete Well as described in step 2
above.

When all wells to be rejected have been marked as such, on the
toolbar, choose Calculate. Message appears (Figure 10-19).

Message 1X|

@ Are you sure you want to recalculate?

Yes Ma |

Figure 10-19: Message - Are you sure you want to recalculate?
Choose Yes to recalculate the test measurements. OR

Choose No to cancel the recalculation.

= A message appears stating that the plate data exists

(Figure 10-18). Choose Yes to overwrite the existing plate data
with the recalculated plate data, No to enter a new plate ID and
save the recalculated plate data as a separate plate, or Cancel to
cancel any changes and return to the original measurement results
of the test.

ADAP
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10.4.3. Restoring Wells Rejected in Prior Calculations
Raw data from wells rejected as outliers is not included in recalculated
measurements. However, this raw data has not been deleted from the
database and may be restored in future calculations, if desired.

To restore a rejected well:

1. In any measurement results tab that displays well data in plate
format, click the well to restore.

= Wells can be restored in any test measurement tab that displays
well data in plate format. To easily find out which wells have been
rejected, view the Plate Layout or Sample-ID display.

2. From the Options menu, choose Restore Well.

OR

Right-click the well to restore and choose Restore Well. The
selected well is labeled Restored.

= To restore multiple wells simultaneously, click and drag over the
wells to restore and choose Restore Well as described in step 2
above.

3. When all wells to be restored have been marked as such, on the
toolbar, choose Calculate. Message appears (Figure 10-19).

4. Choose Yes to recalculate the test measurements. OR

5. Choose No to cancel the recalculation.

= A message may appear stating that the plate data exists (Figure
10-18). Choose Yes to overwrite the existing plate data with the
recalculated plate data, No to enter a new plate ID and save the
recalculated plate data as a separate plate, or Cancel to cancel any
changes and return to the measurement results of the test.
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10.5. Printing Measurement Results

A summary of the measurement results can be printed to any connected
printer or to a file (for example, a PostScript® or Acrobat® PDF file).

The summary printout includes information about who performed the

measurement, when it was performed, and when the results were

printed. Error! Reference source not found. shows how the actual
measurement results are laid out on the page. Results for each well are
laid out according to the Legend.

= The measurement results that are included in the printout are
selected in Options when configuring the test definition (refer to Section
8.2.5, Configuring Test Options).

To print out the measurement results summary:

1.

From the Database menu, select Print. Print appears (Figure 10-20).

it Print
Frirter
range
Test
& Al Tests =
. f* Bradford Azzay
~
Sl Uest " Bradford Standard
~
~
~
~
Options
Faontz |@.-'3.rial [Inicode k5 j
Copiez 1 - | Size .
(] 4 | LCancel |

Figure 10-20: Print

In Printer, select the desired printer to use to print the
measurement results summary. All printers that are properly
installed and configured on the computer are listed.

ADAP
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3. Inrange, select whether to print All Tests or a Single Test.

=>Selecting All Tests is only applicable for Multitest assays.

4. In Test, select the Test to print summary results for.

5. In Options, select the desired Font, text Size, and number of
Copies.

= Body text is printed in the selected Font and Size. Headlines and
headings are printed using formatting defined by the ADAP
software.

6. Choose OK to print the measurement results summary.

=> If the selected printer is configured to print to a file, such as an
Acrobat® PDF (*.pdf), a prompt asking for the filename appears.
The printed file is saved to the ADAP software home directory.
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10.6. Exporting Measurement Results to Other
Applications

10.6.1.

Measurement results can be exported to other applications for further
analysis or manipulation. The ADAP software provides three methods to
export test measurement data:

7. Data can be copied to the clipboard and pasted into another
application such as a word processor (refer to Section 10.6.1,
Copying Measurement Results to Clipboard).

8. Data can be saved to a text file and then opened by or imported
into another application (refer to Section 10.6.2, Saving
Measurement Results as Text Files).

9. The entire test measurement database can be exported and opened
in Microsoft® Access or a compatible database application (refer to
Section 10.6.3, Exporting the Database).

Copying Measurement Results to Clipboard

The measurement results displayed in any tab can be copied to the
clipboard. The data in the clipboard can then be pasted into any other
application for storage or further analysis.

= For example, the clipboard data could be pasted into a Microsoft®

Excel spreadsheet with formulas or macros already created such that

some preliminary analysis is automatically performed once the data is
pasted into the document.

To copy measurement results to the clipboard:

1. Select the desired results tab to copy to the clipboard.

\

= When copying the Raw Data tab, only the measurement results
shown for the cycle are copied. To copy all raw data results, each
cycle needs to be copied individually, or Copy all data into clipboard
needs to be selected.

2. From the Database menu, choose Copy displayed data into
clipboard to copy only the displayed results to the clipboard.

Ez

OR

= Choosing this option will result in results that can be pasted as a
matrix (identical to the plate layout).

ADAP
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Choose Copy all data into clipboard to copy all of the
measurement results from the test to the clipboard.

3. Open or switch to the application where measurement results will
be pasted.

4. Paste the measurement results into a new or existing file using the
Paste command for the application.

= Most applications have a standard shortcut of CTRL+V assigned
to the Paste command.
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10.6.2. Saving Measurement Results as Text Files
Measurement results can be saved to text files which can be viewed in
any text editor or imported into many statistical software packages or
spreadsheet applications.

To save measurement results to a text file:

1. Select the desired results tab to save as a text file.

2. From the Database menu, choose Save Actual Data to save only
the displayed results in the ADAP database.

Ei

From the Options menu, choose Save as TXT file to save all
measurement results in one text file.

Select the desired command from the toolbar. Data will be saved in
the ADAP program file.

OR

OR

= If the ADAP software is configured in Setup-System to
automatically save measurement results as text files, these files
may also be opened in a text editor or other application. Refer to
Section 3.3, Configuring System Settings for information about
configuring the ADAP software to automatically save measurement
results as text files.

10.6.3. Exporting the Database

To preserve data integrity, all measurement results are stored in a
database that can only be accessed by the ADAP software. However, the
database can be exported in Microsoft® Access format and opened by
Access or a compatible database application.

To export the database:

1. From the Database menu, choose Export Database. A copy of the
database named PlateDataReplica.mdb is exported to the ADAP
software default directory.

2. Choose OK when prompted to complete the export.

3. Open PlateDataReplica in Access or a compatible database
application.
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10.7. Storing Measurements in the Database

10.7.1.

The ADAP software automatically stores raw data from all measured
plates in a database. The data from any previously measured plate can
be accessed from the Database menu.

The Database menu contains options to:

4.

Load plate data from the database (refer to Section 10.7.1, Loading
or Deleting Plate Data from the Database ).

Save plate data to the database (refer to Section 10.7.2, Saving
Plate Data to the Database).

Repair the database (refer to Section 10.7.3, Repairing and
Compressing the Database).

Compress the database (refer to Section 10.7.3, Repairing and
Compressing the Database).

Loading or Deleting Plate Data from the Database

To load or delete plate data from the database:

1.

From the Database menu, select Open Saved Plate. Selection
appears and displays a list of all the stored plates (Figure 10-21).

183 items

2M10513-11 "
nEWzave

2M10513-10

201105133

2011057 3-8

20101 008-2

2105137
2105136
20110513-5
2010513-4
20110513-3
2M10513-2 4

fram: 01/06/2010
b 13/05/2011 =

update list | Delete

|

I atchecode |
0K |
|

Cancel

Figure 10-21: Selection - stored plates
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10.7.2.

10.7.3.

2. Highlight the desired plate to load or delete.

\

= To narrow the list by date, select dates in from and to, and
choose update list.

To search for a specific plate ID by characters in the Plate ID name,
choose Matchcode (Using Matchcode to Search for Test Definitions
and Saved Plates).

3. Choose OK to load the plate.
OR

Double-click the desired plate. The plate data appears in the main
window.

OR

Choose Delete to remove the plate from the database.

Saving Plate Data to the Database

Raw data of measured plates are automatically saved to the database.
Plate data can also be saved to the database manually or to a text file
outside the database.

To save plate data to the database:

From the Database menu, choose Save Actual Data. The plate data
is saved to the database.

To save plate data as a text file separate from the database:

From the Database menu, choose Save as TXT-File. The plate data
is saved as a text file that is separate from the database and can
be opened by many applications such as text editors, word
processors, and spreadsheets.

Repairing and Compressing the Database

When a plate or test is removed from the database, only the data is
deleted from the fields. The empty data fields remain, which increases
the size of the database, which may slow down access. Periodically, it is
recommended to remove empty fields using Compress Database. Repair
Database removes unassigned entries from the database before
compressing it.

To repair or compress the database:

From the Database menu, choose Repair Database to remove
unassigned entries and empty fields. The database is repaired.

OR

ADAP
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From the Database menu, select Compress Database to remove
empty fields. The database is compressed.
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configuring, 8-24
viewing results, 10-18
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area scan, 6-15
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running, 6-23
saving results, 6-23
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viewing results
area scan, 7-6, 7-43
area scan raw data, 7-44
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viewing errors/warnings, 4-4
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copying to clipboard, 4-5
saving as text file, 4-6
viewing log file, 4-4
rejection/validation formulas
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repairing database, 10-49
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mean results data, 10-17
rejection formula examples, 8-40
Result list tab, 10-36
results

quantitative, 10-21
recalculating, 10-38
rejecting outliers, 10-41
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entering manually, 9-4
importing from text files, 9-5
selecting tests to perform, 9-6
sorting by test performed, 9-6
scan measurements
area
viewing raw data, 7-44
configuring, 8-33
linear
viewing raw data, 7-22
performing, 6-15, 8-33
searching
Matchcode, 5-23, 8-45, 8-47, 8-49, 8-52, 8-56
sensor state, 4-3
standard curves
results, 10-36
viewing, 10-34, 10-iv
stop, 4-3
system administrator, 1-8, 2-2
adding, deleting, and editing users, 2-7
System Settings
configuring, 3-11
temperature control, 3-10, 8-30
test definitions
copying, 8-48
deleting, 8-51
editing, 8-46
exporting from database, 5-20, 5-22, 10-iv
importing to database, 5-20
printing, 8-53
recalculating results, 10-38
running, 8-44
saving, 8-43
transferring, 5-8, 5-13
test measurements
results, 10-14
Test mode
overview, 8-2
test options
configuring, 8-26
tests
copying, 8-48
defining new, 8-2
deleting, 8-51
editing, 8-46
printing, 8-53
running, 8-44
status, 10-35
text files
saving measurement results as, 7-62, 10-47
transmission
viewing area scan transmission profiles, 7-45
updating firmware, 5-8

user
changing password, 2-5
logging in, 2-3

user administration
adding new users, 2-7
changing a password, 2-5
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deleting users, 2-9 measurement results, 7-6
editing existing user information, 2-10 raw data, 7-12, 7-16, 7-22
overview, 2-1 Viewing
system administrator, 2-2, 10-iv Quick Measurement Results
user history log OD measurements, 7-8
events stored in, 2-12 wells
user levels multiplications factors, 8-11
defined, 2-1 rejecting outliers, 10-41
validation restoring outliers, 10-42
blank, 8-28 wildcards, 8-56
examples, 8-41 Zenyth 340 absorbance detector
formula summaries, 10-36 ejecting plates, 4-12
rejection/validation formulas, 8-36 initializing plates, 4-13
test validation examples, 8-41 loading plates, 4-13
viewing scan measurements, 8-34
installed plates, 3-9 temperature control, 4-11, 8-30

System Administrator System Administrator PasswordPasswordPasswordUsing Microsoft
Windows®Using Microsoft Windows ®Exporting Test Definitions and Measurement ResultsUsing
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Windows®Using Microsoft Windows®Using Microsoft Windows®Using Microsoft Windows®Using
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ResultsMeasurement PositionsMeasurement PositionsMeasurement PositionsMeasurement
PositionsResultsMatchcode to Search for Saved Measurement ResultsMatchcode to Search for
Saved Measurement ResultsEndpoint Photometric Measurement ResultsPhotometric
Measurement ResultsArea Scan Measurement ResultsLinear Scan Measurement Raw DataScan
Curve InfoScan Curve InfoCurveCurve Fitting Methods to Smooth CurvesArea Scan Measurement
Raw DataSearch for Test Definitions and Saved PlatesMultiplication Factors for WellsEvaluate
ControlsScan MeasurementArea Scan MeasurementSearch for Test Definitions and Saved
PlatesSearch for Test Definitions and Saved PlatesSearch for Test Definitions and Saved
PlatesSearch for Test Definitions and Saved PlatesSearch for Test Definitions and Saved
PlatesDatabaseGraphsArea Scan Measurement Raw DataScan Curve InfoResultsStandard
CurvesTest Status InformationSearch for Test Definitions and Saved PlatesMultiplication Factors for
WellsResultsDeleting Plate Data from the DatabaseDatabaseDatabaseSearch for Test Definitions
and Saved Plates

System Administrator PasswordPasswordSearch for Test Definitions and Saved
PlatesMeasurement PositionsMeasurement PositionsMeasurement PositionsMeasurement
PositionsResultsMatchcode to Search for Saved Measurement ResultsEndpoint Photometric
Measurement ResultsArea Scan Measurement ResultsLinear Scan Measurement Raw DataScan
Curve InfoDilution Factors for WellsEvaluation ControlsSearch for Test Definitions and Saved
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